





39 Managing Oracle BPMN Service Components and Engines

This chapter describes how to manage BPMN process service components and service engines.

This chapter includes the following topics:

	
Section 39.1, "Recovering from BPMN Process Service Component Faults"


	
Section 39.2, "Managing BPMN Process Service Component Policies"


	
Section 39.3, "Recovering from BPMN Process Service Engine Faults"


	
Section 39.4, "Performing BPMN Process Service Engine Message Recovery"






39.1 Recovering from BPMN Process Service Component Faults

You can monitor and perform individual and bulk fault recoveries for BPMN process service components that are identified as recoverable. For BPMN process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its normal course as either a recoverable or nonrecoverable fault.

To recover from BPMN process service component faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











	
In the Component Metrics section, select the BPMN process service component.


	
Click Faults.
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The Faults page displays the following details:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Faults that occurred in the service component, including the fault ID, error message, whether you can recover from the fault, time at which the fault occurred, service component instance ID, activity in which the fault occurred, and a link to a log file describing the fault.




BPMN process service component faults identified as recoverable can be recovered.


	
Select faults for recovery using one of the following methods. Fault recovery selection at the BPMN process service component level equals the SOA Infrastructure level, SOA composite application level, and Oracle Mediator service component level.


	For...	Then...
	
Single fault recovery

	
There are three options from which to choose for single-fault recovery:

	
Click the row of the fault that has been identified as recoverable. With the row highlighted, select a specific action from the Recovery Action list, as described in Step 5.


	
In the Recovery column, click the Recover link to access the Faults page of the instance audit trail to perform fault recovery.


	
In the Error Message column, click the message of a fault that has been identified as recoverable. This displays complete fault details, including the fault ID, fault time, fault location, fault type, and error message text. A Recover Now option is displayed for recoverable faults. Click Recover Now to access the Faults page of the instance audit trail to perform fault recovery.





	
Bulk fault recovery

	
There are two options from which to choose for bulk-fault recovery:

	
Use Shift+Click or Control+Click to select specific faults in the rows.

or


	
From the Select menu, choose Select All Recoverable. Then use Shift+Click or Control+Click to deselect the faults to not include in the recovery operation.

Then:


	
Select an action from the Recovery Action list, as described in Step 5.

Note: Only the actions applicable to all selected faults are available.





	
Recovery of all faults

	
	
From the Select menu, choose Select All Recoverable.


	
Select an action from the Recovery Action list, as described in Step 5.

Note: Only the actions applicable to all selected faults are available.














	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.










	
Select an action from the Recovery Action list.


	Action	Description
	
Retry

	
Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.


	
Abort

	
Terminates the entire instance.


	
Replay

	
Replays the entire scope again in which the fault occurred.


	
Rethrow

	
Rethrows the current fault. BPMN fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.


	
Continue

	
Ignores the fault and continues processing (marks the faulting activity as a success).








	
Perform the following additional monitoring tasks from within the faults table:

	
Click the Show only recoverable faults checkbox to display only faults from which you can recover.


	
From the Fault Type list, select to display all faults, system faults, business faults, or Oracle Web Service Manager (OWSM) faults in the faults table. Click the Help icon for a description of these fault types.


	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Rejected messages do not have a component instance ID.


	
In the Logs column, click a link to access the Log Messages page with filtered messages specific to that instance.







For more information, see the following documentation:

	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section 8.4.2, "Examples of Fault Recovery for BPMN Processes"


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite









39.2 Managing BPMN Process Service Component Policies

You can attach and detach policies to and from BPMN process service components in currently deployed SOA composite applications. Policies apply security to the delivery of messages. Oracle Fusion Middleware uses a policy-based model to manage web services.




	
Note:

Before attaching policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use in your environment.









To manage BPMN process service component policies:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











	
Select the BPMN process service component in the Component Metrics section.


	
Click Policies.

The Policies page enables you to attach and detach policies to and from BPMN process service components. The policies table displays the attached policy name, the policy reference status (enabled or disabled) that you can toggle, the category (Management, Reliable Messaging, MTOM Attachment, Security, or WS Addressing), the violations, and the authentication, authorization, confidentiality, and integrity failures since the SOA Infrastructure was last restarted.


	
Click Attach/Detach.

If multiple components are available, you are prompted to select the service or component for which to perform the attachment or detachment.


	
Select the service or component to which to attach or detach a policy.

This invokes a dialog for attaching or detaching policies.

Policies currently attached appear in the Attached Policies section. Additional policies available for attachment appear in the Available Policies section.


	
Select to attach policies appropriate to your environment.


	
Click Attach.


	
When you are finished attaching policies, click Validate.


	
If an error message appears, make the necessary corrections until you no longer have any validation errors.


	
Click OK.

The attached policy is displayed in the policies table.




For more information, see the following documentation:

	
Section 1.4.3.2, "Introduction to Policies"


	
Section 7.6, "Managing SOA Composite Application Policies" for the dialogs that display during policy attachment.


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use for your environment.









39.3 Recovering from BPMN Process Service Engine Faults

You can monitor and perform individual and bulk recoveries of faults occurring in BPMN process service engines that are identified as recoverable. All BPMN process service component faults, regardless of the SOA composite application instance of which they are a part, can be viewed in the BPMN process service engine. For BPMN process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its normal course as either a recoverable or nonrecoverable fault.

To recover from BPMN process service engine faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPMN.




	
	
Right-click soa-infra.


	
Select Service Engines > BPMN.











	
Select the Faults tab.
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The Faults page displays the following details:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Faults that occurred in the service engine, including the fault ID, error message, whether you can recover from the fault, the time at which the fault occurred, the SOA composite application and service component in which the fault occurred, and the service component instance ID.




BPMN process service engine faults identified as recoverable can be recovered.


	
As with fault recovery at the SOA Infrastructure level, SOA composite application level, and Oracle Mediator service component level, you can perform single fault recovery, bulk fault recovery, and recovery of all faults. See Step 4 of Section 39.1, "Recovering from BPMN Process Service Component Faults" for instructions on selecting faults to perform these types of recovery.




	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.










	
Select an action from the Recovery Action list.


	Action	Description
	
Retry

	
Retries the instance with an option to provide a retry success action. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.


	
Abort

	
Terminates the entire instance.


	
Replay

	
Replays the entire scope again in which the fault occurred.


	
Rethrow

	
Rethrows the current fault. BPMN fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.


	
Continue

	
Ignores the fault and continues processing (marks the faulting activity as a success).








	
Perform the following additional monitoring tasks from within the faults table:

	
Click the Show only recoverable faults checkbox to only display faults from which you can recover.


	
From the Fault Type list, select to display all faults, system faults, business faults, or OWSM faults in the faults table. Click the Help icon for a description of these fault types.


	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Component column, click a specific service component to access its home page.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Rejected messages do not have a component instance ID.







For more information, see the following sections:

	
Section 1.4.3.1, "Introduction to Fault Recovery" for conceptual details about faults.


	
Section 8.4.2, "Examples of Fault Recovery for BPMN Processes"









39.4 Performing BPMN Process Service Engine Message Recovery

You can perform a manual recovery of undelivered invoke or callback messages due to a transaction rollback in the process instance. Recovery of invoke messages applies to asynchronous BPMN processes only. Synchronous BPMN processes return an error to the calling client and are not recoverable from this page. Recoverable activities are activities that failed and can be recovered. For example, if you are using the file adapter to initiate an asynchronous BPMN process and your system crashes while the instance is processing, you can manually perform recovery when the server restarts to ensure that all message records are recovered.




	
Note:

If you encounter the error message ORA-01000: maximum open cursors exceeded, then do the following:

	
Shut down the Oracle database.


	
Increase the value of OPEN_CURSORS to 1500.


	
Restart the Oracle database.












To perform BPMN process service engine message recovery:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPMN.




	
	
Right-click soa-infra.


	
Select Service Engines > BPMN.











	
Click Recovery.

The Recovery page displays the following details:

	
A utility for searching for a specific message failure by specifying criteria and clicking Search. Click the Help icon for details.


	
Message failure in the service engine, including the conversation ID, whether you can recover from the message failure, the service component and composite application in which the failure occurred, and the time at which the fault occurred.





	
Select a fault in the table.


	
Select one of the following options:


	Action	Description
	
Recover

	
Retries the message in which the fault occurred.

If an asynchronous BPMN process encounters a transaction rollback scenario because of any underlying exception error, it rolls back to the last dehydration activity. If this is a new instance, and a receive activity was the first dehydration activity, the BPMN process service engine creates a recoverable invoke. When you click Recover to recover the invoke, the service engine creates a new instance. This instance may run to completion with no exception error. However, you continue to see the older instance identified as faulted.


	
Mark Cancelled

	
Marks the message so it is never delivered.










Once a message is submitted for recovery, the BPMN process service engine may take time to complete the action. This typically takes less than several seconds. During this time, the message remains visible in the Recovery page. Duplicate attempts to recover the same message in that period are ignored. Refresh the page every few seconds to receive the latest recovery status.









Part VIII


 Administering Human Task Service Components and Human Workflow Service Engines

This part describes how to administer human task service components and human workflow service engines.

This part includes the following chapters:

	
Chapter 20, "Configuring Human Workflow Service Components and Engines"


	
Chapter 21, "Monitoring Human Workflow Service Components and Engines"


	
Chapter 22, "Managing Human Workflow Service Components and Engines"










38 Monitoring BPMN Process Service Components and Engines

This chapter describes how to monitor BPMN process service components and service engines.

This chapter includes the following topics:

	
Section 38.1, "Viewing the Audit Trail and Process Flow of a BPMN Process Service Component"


	
Section 38.2, "Monitoring BPMN Process Service Component Instances and Faults"


	
Section 38.3, "Monitoring BPMN Process Service Component Instances"


	
Section 38.4, "Monitoring BPMN Process Service Engine Instances and Faults"


	
Section 38.5, "Monitoring BPMN Process Service Engine Request and Thread Statistics"


	
Section 38.6, "Monitoring BPMN Process Service Engine Instances"


	
Section 38.7, "Monitoring Deployed BPMN Processes in the Service Engine"




For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.2.6, "Introduction to Service Engines"






38.1 Viewing the Audit Trail and Process Flow of a BPMN Process Service Component

This section describes how to view the audit trail and process flow of a BPMN process service component in a SOA composite application instance.




	
Note:

	
This section assumes a SOA composite application instance has been initiated. If not, see Section 8.1, "Initiating a SOA Composite Application Test Instance" for instructions.


	
When several messages are thrown in a short interval, they are not processed in the same order as they were sent. This can be apparent when you are examining the audit trail of a process instance.












To view the audit trail and process flow of a BPMN process service component:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











The Dashboard page for the selected composite application appears.


	
Use one of the following methods to select an instance of the application:

	
For recent instances of this application, click the instance number of an instance in the Instance ID column of the Recent Instances section.


	
For all instances of this application, click the Instances tab, then click a specific instance in the Instance ID list.




The Flow Trace page displays the following details:

	
The Faults section shows the faults occurring in the services, service components, and references that comprise the SOA composite application. Sensors enable you to monitor BPMN process activities, variables, and faults during runtime. Selecting a fault highlights the row in the Trace section in which the fault occurred. Closing the fault clears the selection in the Trace section.


	
The Sensors section displays details about composite sensors included in the service and reference binding components of the SOA composite application. The total number of sensors is shown in the section header. Composite sensors can be added to service and reference binding components during design time in Oracle JDeveloper. You cannot add composite sensors to service components. Selecting a composite sensor in this section highlights the service or reference in the Trace section in which composite sensor data was collected. Closing the sensor clears the selection in the Trace section.




	
Note:

Expand the Faults or Sensors sections one at a time. The fault or sensor information is displayed only for viewing in this way.










	
The Trace section shows the sequence of the message flow through the services, service components, and references that comprise the SOA composite application.




The flow trace is a runtime trail of a message flow identified by an execution context ID (ECID) that is displayed in the upper right corner of the page. An ECID enables you to track a message flow that crosses instances of different composites. The flow trace lists all services, references, components across composites participating in the flow. 
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For the flow example in the Trace section, the service binding component and reference binding component involved in the flow have successfully received and processed messages.

Note the following restrictions with ECIDs:

	
A separate ECID is displayed for each instance of a composite application and not for the composite level ECID that can track the complete flow of any instances for the composite application.


	
To get complete flow information, you must find the composite level ECID in the log files. Use that value to get all information for a particular composite and therefore all its executed instances.


	
ECIDs are not propagated through business events. This can limit the amount of logging information that is collected. For example, if you publish an event that is subscribed to in the same composite application, limited logging information is available.





	
Select a fault in the Faults section.

This highlights the row in the Trace section in which the fault occurred.


	
Close the fault to clear the selection in the Trace section.


	
Expand the Sensors section to display composite sensors.


	
Select a sensor in the Sensors section.

This highlights the row in the Trace section in which the composite sensor data was collected.


	
In the Instance column of the Trace section, click a specific BPMN process service component instance. Service component instances can be accessed from this section; services and references cannot be accessed.

The Instance page appears, as shown in Figure 38-1.


Figure 38-1 Instance Page
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Use these pages to view the audit trail, flow and faults of a BPMN process service component instance. The following links provide additional details about the instance:

	
Flow Trace link: Click the breadcrumbs in the upper left corner of the page to access the flow trace for the ECID (composite instance) that contains this BPMN component instance.


	
Information icon: Click the information icon to the right of the name of the BPMN component (in the page title) to see biographical information about this BPMN instance. This information includes a summary of the instance, including instance ID, ECID, instance startup time or last modification time, instance state (for example, running), and number of faults.

This icon is displayed only on the Audit Trail pages of BPMN processes and Oracle Mediators, and not on the pages of human tasks and business rules.


	
Current Audit Level: Click to display information details, such as the audit level used by this instance.




When you first open the Instance page, the Audit Trail page is displayed by default. It provides execution details about the activities in the BPMN process.


	Column	Description
	
Activity

	
Lists all the BPM constructs available in a process in the order they are executed. These include:

	
Events: start, end, signal, throw, catch message.


	
Activities: user task, business rules task, service task, call activity, subprocess.


	
Gateways: inclusive, exclusive, parallel, event based, and complex.





	
Loop Count Event

	
If the activity referred to in a row of the audit trail table is a subprocess with the loop characteristic set to either Loop or Multi-instance, this column shows the value of the loopCounter variable.


	
Event

	
When any BPMN construct executes, audit is logged twice: once when it enters that activity, and once when it leaves that activity to move to next activity. If the node is collapsed, it shows you whether the activity is completed, processing, or canceled.


	
Date

	
Time stamp showing when the item was posted.


	
Copy

	
If some activities are executed simultaneously—for example, on different paths in a parallel gateway—the copy keeps the number of threads used for this purpose.








	
Scroll through the audit trail to check for errors and expand the payload links to view their contents at a given point in the flow.

When you click a payload link, the Payload XML page appears. This page shows the value of data objects which had out data association at that particular point in the process.
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Click the Flow tab.

A flow diagram of the BPMN process activities appears. This flow diagram shows a fault highlighted in a BPMN process activity.


	
Click an activity to view the flow of the payload through the process.




	
Note:

If using Microsoft Internet Explorer, you can click Copy details to clipboard to copy the activity details to the clipboard. If using Mozilla Firefox, this link does not appear. Instead, you must manually select the text and copy and paste it to a file.










	
Scroll through the flow diagram to check for errors and click the highlighted activity to view error messages.


	
Close the window.


	
Click the Faults tab.

This page shows the error message, whether you can recover from the fault, the time at which the fault occurred, and the activity in which the fault occurred. This page displays the faults in the BPMN component instance (but not the faults that occurred in a service or reference binding component).

You can recover from instance faults identified as recoverable. This page lists all instance faults, recoverable or not. The component instance faults that occurred in a service or reference are not listed here.

This page enables you to target individual faults from which to recover, and provides a degree of fault recovery granularity not available on other pages.

However, you cannot perform bulk fault recoveries on this page. To perform bulk fault recovery, use one of the following pages:

	
Faults and Rejected Messages page of a specific SOA composite application or of the SOA Infrastructure.


	
Faults page of the BPMN process service engine or of a specific BPMN process service component.





	
Select a fault for recovery that has been identified as recoverable through one of the following methods. The page refreshes to display a fault recovery section at the bottom of the page.

	
If you click a fault in the Error Message column, a popup message displays details about the fault, including the fault ID, fault time, fault location, fault type, and complete error message text. If the fault is identified as recoverable, a Recover Now button is displayed that you can click.


	
You click a fault identified as recoverable in the Recovery column.





	
Select an action from the Recovery Action list.


	Action	Description
	
Retry

	
Retries the instance with an option to provide a retry success action. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.


	
Abort

	
Terminates the entire instance.


	
Replay

	
Replays the entire scope again in which the fault occurred.


	
Rethrow

	
Rethrows the current fault. BPMN fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.


	
Continue

	
Ignores the fault and continues processing (marks the faulting activity as a success).








Your selection causes additional fields to appear. For example, the following fields display if you select Rethrow.


	
Use the After Successful Retry list to select defined actions to invoke after a successful retry. If you select a variable in the Variable list, you can edit the value in the Value text box.


	
Click the Back button of your browser to exit the flow diagram.









38.2 Monitoring BPMN Process Service Component Instances and Faults

You can monitor BPMN process service component recent instances and faults. Each service component in a SOA composite application has its own instance ID. These IDs are different from the overall instance ID of the SOA composite application of which each service component is a part.

To monitor BPMN process service component instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











	
In the Component Metrics section, select the BPMN process service component.


	
Click Dashboard.
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The upper part of the Dashboard page displays the following details:

	
Recent instances of the BPMN process service component, including the instance ID, the state of the instance (for example, completed successfully or faulted), the start time, the last modification time, and logs describing the instance.


	
Recent faults in the BPMN process service component, including the error message, whether you can recover from the fault, the time at which the fault occurred, the instance ID of the BPMN service component, the BPMN activity in which the fault occurred, and logs describing the fault.


	
The average processing time for each activity in the BPMN process service component.





	
In the Recent Instances section, you can perform the following tasks:

	
View the audit trail, process flow and faults of a service component. To do this task, in the Instance ID column, click the instance ID of that service component.


	
Access the Log Messages page with filtered messages specific to that instance. To do this task, in the Logs column, click a specific log.


	
Access the Instances page of the service component. To do this: Click Show All below the section.





	
In the Recent Instances and Faults section, you can perform the following tasks:

	
Display complete information about a fault. To do this task, in the Error Message column, click an error message. If the fault is identified as recoverable, you can perform fault recovery by clicking the Recover Now link.


	
Perform fault recovery at the component instance level. To do this task, in the Recovery column, click a fault identified as Recoverable.


	
Access the Log Messages page with filtered messages specific to that instance. To do this task, in the Logs column, click a specific log.


	
Access the Faults page of the service component. To do this task, click Show All below the section.




The lower part of the Dashboard page displays the following details:

	
A graphical representation of the number of successful, faulted, and incoming (pending) instances of the BPMN process service component over a specific time range.


	
The number of faults and message processed by any reference binding component with which this BPMN process service component communicated.







For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances."






38.3 Monitoring BPMN Process Service Component Instances

You can monitor BPMN process service component instances. Each service component has its own unique instance ID. This ID is in addition to the instance ID of the overall SOA composite application of which this service component is a part.

To monitor BPMN process service component instances:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











	
In the Component Metrics section, select the BPMN process service component.


	
Click the Instances tab.
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The Instances page displays the following details:

	
A utility for searching for a specific BPMN service component instance by specifying criteria and clicking Search.


	
BPMN process service component instances, including the instance ID, instance state (for example, completed or faulted), instance start time, last instance modification time, and log files describing the instance.




In this page, you can perform the following tasks:

	
View the audit trail, process flow, and faults of a service component. To do this task, in the Instance ID column, click the instance ID for a service component.


	
Access the Log Messages page with filtered messages specific to that instance. To do this task, in the Logs column, click a specific log.







For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances."






38.4 Monitoring BPMN Process Service Engine Instances and Faults

You can monitor instances and faults of all BPMN process service components running in the BPMN process service engine. These BPMN process service components can be part of separate SOA composite applications.

To monitor BPMN process service engine instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPMN.




	
	
Right-click soa-infra.


	
Select Service Engines > BPMN.











	
Click Dashboard.
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The upper part of the Dashboard page displays recent instances of all BPMN process service components running in the BPMN process service engine, including the instance ID of the service component, the service component name, the SOA composite application of which the service component is a part, the state of the instance (for example, completed successfully or faulted), the instance start time, the last modification time, and logs describing the instance.

[image: Description of bpmn_dashboard_low.gif follows]
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The lower part of the Dashboard page displays the following details:

	
The service components running in the service engine, the SOA composite applications of the service components, the state of the applications (for example, running), and the total, running, and faulted instances in the service engine.


	
The recent faults in the service engine, including the error message, whether you can recover from the fault, the time at which the fault occurred, the SOA composite application in which the fault occurred, the service component, the instance ID of the service component, the activity in which the fault occurred, and log files describing the fault.





	
In the Recent Instances section, you can perform the following monitoring tasks:

	
View the audit trail, process flow and faults of a service component. To do this task, in the Instance ID column, click an instance ID for the service component.


	
Access the home page of a service component. To do this task, in the Component column, click a specific service component.


	
Access its home page of a SOA composite application. To do this task, in the Composite column, click the specific SOA composite application.


	
Access the Log Messages page with filtered messages specific to an instance. To do this task, in the Logs column, click the specific log.


	
Access the Instances page of the service engine. To do this task, click Show All below the section.





	
In the Components section, you can perform the following tasks:

	
Access the home page of a specific service component. To do this task, in the Name column, click the specific service component.


	
Access the home page of a specific SOA composite application. To do this task, in the Composite column, click the specific SOA composite application.


	
Access the Deployed Components page of the service engine. To do this task, click Show All below the section.





	
In the Recent Faults section, you can perform the following tasks:

	
Display complete information about a fault. To do this task, in the Error Message column, click an error message. If the fault is identified as recoverable, click the Recover Now link to perform fault recovery.


	
Perform fault recovery at the component instance level. To do this task, in the Recovery column, click a fault identified as Recoverable.


	
Access the home page of a specific SOA composite application. To do this task, in the Composite column, click the specific SOA composite application.


	
Access the home page of a specific service component. To do this task, in the Component column, click a specific service component.


	
View the audit trail, process flow and faults of a service component. To do this task, in the Component Instance ID column, click an instance ID for a service component.


	
Access the Log Messages page with filtered messages specific to a fault. To do this task, in the Logs column, click the specific log.







For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






38.5 Monitoring BPMN Process Service Engine Request and Thread Statistics

You can monitor request and thread statistics for all BPMN process service components running in the service engine.

To monitor BPMN process service engine request and thread statistics:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPMN.




	
	
Right-click soa-infra.


	
Select Service Engines > BPMN.











	
Click Statistics.

The upper part of the Statistics page displays the following details. Click the Help icon for additional details.

	
Pending requests in the service engine


	
Active requests in the service engine


	
Thread statistics for the service engine




The lower part of the Statistics page displays details about the count and minimum, maximum, and average request processing times.









38.6 Monitoring BPMN Process Service Engine Instances

You can monitor all BPMN process service component instances running in the service engine. These BPMN process service components can be part of separate SOA composite applications.

To monitor BPMN process service engine instances:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPMN.




	
	
Right-click soa-infra.


	
Select Service Engines > BPMN.











	
Click Instances.

[image: Description of bpmn_instances.gif follows]
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The Instances page displays the following details:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
Instances, including the instance ID of the service component, the service component name, the SOA composite application name, the state of the instance (for example, completed successfully, running, or faulted), the instance start time, the last modification time, and log files describing the instance.





	
In the Instances section, you can perform the following monitoring tasks:

	
View the audit trail, process flow, sensor values, and faults of a service component. To do this task, in the Instance ID column, click an instance ID for a service component.


	
Access the home page of a specific service component. To do this task, in the Component column, click the specific service component.


	
Access the home page of a specific SOA composite application. To do this task, in the Composite column, click the specific SOA composite application.


	
Access the Log Messages page with filtered messages specific to an instance. To do this task, in the Logs column, click the specific log.







For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






38.7 Monitoring Deployed BPMN Processes in the Service Engine

You can monitor all deployed SOA composite applications with BPMN process service components running in the service engine.

To monitor deployed BPMN processes in service engines:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPMN.




	
	
Right-click soa-infra.


	
Select Service Engines > BPMN.











	
Click Deployed Components.

[image: Description of bpmn_se_deployedcomps.gif follows]
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The Deployed Components page displays the following details:

	
A utility for searching for a specific deployed SOA composite application by specifying criteria and clicking Search.


	
Details about deployed SOA composite applications with BPMN process service components running in this service engine, including the service component name, the SOA composite application, the current status, and the total, running, and faulted instances in the service engine.




To access the home page of a specific service component, in the Name column, click the specific service component.

To access the home page of a specific SOA composite application, in the Composite column, click the specific SOA composite application.












2 Getting Started with Administering Oracle SOA Suite and Oracle BPM Suite

This chapter describes how to log in to and navigate the menus of Oracle Enterprise Manager Fusion Middleware Control to perform Oracle SOA Suite and Oracle BPM Suite configuration, monitoring, and management tasks. It also describes how to access Oracle WebLogic Server Administration Console from Oracle Enterprise Manager Fusion Middleware Control.

This chapter includes the following topics:

	
Section 2.1, "Logging In to Oracle Enterprise Manager Fusion Middleware Control"


	
Section 2.2, "Navigating to Oracle SOA Suite and Oracle BPM Suite Administration Tasks"


	
Section 2.3, "Logging Out of Oracle Enterprise Manager Fusion Middleware Control"




For more information about service engines, service components, binding components, and the SOA Infrastructure, see Chapter 1, "Introduction and Concepts."



2.1 Logging In to Oracle Enterprise Manager Fusion Middleware Control

This section describes how to log in to Oracle Enterprise Manager Fusion Middleware Control.

To log in to Oracle Enterprise Manager Fusion Middleware Control:

	
Use Microsoft Internet Explorer 7, Mozilla Firefox 2.0.0.2, Apple Safari 4.0, or Mozilla Firefox 3.0.x to access the following URL:


http://host_name:port/em


Where host_name is the name of the host on which Oracle Enterprise Manager Fusion Middleware Control is installed and port is a number that is dynamically set during installation. This port is typically 7001, but is the HTTP port associated with Oracle HTTP Server. For environments in which the SSL port was enabled during configuration, the default port is 7002.


	
Enter weblogic/password and click Login.

where:

	
weblogic is the default administrator user name for Oracle Enterprise Manager Fusion Middleware Control (you can change this during installation).


	
password is the password you entered during Oracle SOA Suite installation.




The Accessibility Preference dialog appears the first time you log in. If you want, you can select to not display this dialog again.


	
Select an appropriate action and click Continue.

The farm home page is displayed. From there, you can navigate to Oracle SOA Suite and Oracle BPM Suite in several different ways, as described in the following sections.




For more information about installation, see Oracle Fusion Middleware Installation Guide for Oracle SOA Suite and Oracle Business Process Management Suite.






2.2 Navigating to Oracle SOA Suite and Oracle BPM Suite Administration Tasks

This section describes methods for navigating to Oracle SOA Suite and Oracle BPM Suite administration tasks in Oracle Enterprise Manager Fusion Middleware Control:

	
Section 2.2.1, "Navigating Through the SOA Infrastructure Home Page and Menu"


	
Section 2.2.2, "Navigating Through the SOA Composite Application Home Page and Menu"


	
Section 2.2.3, "Navigating Through the Partition Home Page and Menu"


	
Section 2.2.4, "Navigating to Deployed Java EE Applications"


	
Section 2.2.5, "Navigating to the Oracle WebLogic Server Administration Console and Other Pages"


	
Section 2.2.6, "Navigating to the SOA Infrastructure or SOA Composite Application Home Page from the Farm Home Page"







	
Note:

The Farm menu is always displayed at the top of the navigator. As you expand the SOA folder in the navigator and click the links displayed beneath it, the SOA Infrastructure menu becomes available at the top of the page.











2.2.1 Navigating Through the SOA Infrastructure Home Page and Menu

You can navigate to Oracle SOA Suite and Oracle BPM Suite administration tasks through the SOA Infrastructure home page and menu. The SOA Infrastructure provides you with access to all deployed SOA composite applications, service engines, service components, business events, and other elements.

To navigate through the SOA Infrastructure home page and menu:

	
Expand SOA > soa-infra in the navigator.


	
Expand the specific partition (for example, default).

This displays all SOA composite applications running in the selected partition of the SOA Infrastructure for that managed server. Composites are grouped into the partition in which they are deployed.

[image: Description of sca_soamenu2.gif follows]

Description of the illustration sca_soamenu2.gif



	
Click soa-infra.

This displays the Dashboard page of the SOA Infrastructure. Click the help icon at the top of this page to access the Resource Center for the entire Oracle SOA Suite. The upper part of the page displays details about recently deployed SOA composite application instances, deployed composites, recent faults, and rejected messages. You can click a specific SOA composite application name or instance ID to access additional details. You can also click Show All at the bottom of each section to see more information about all items.

[image: Description of gs_soahomepage.gif follows]

Description of the illustration gs_soahomepage.gif



The lower part of the page displays details about the service engines provided by the SOA Infrastructure and a graphical representation of the number of instances and faults for all SOA composite applications hosted in the SOA Infrastructure. You must expand these sections to see this information. Click a service engine name to access more specific details.


	
Note that the SOA Infrastructure menu appears below the soa-infra name at the top of the page.




	
Note:

Depending upon your current location, the context of this menu changes to provide you with the administrative options most relevant to your current location. For example, when you are within the pages of a SOA composite application, the SOA Composite menu is displayed, or on the home page of a specific partition, the SOA Partition menu is displayed.










	
Select the SOA Infrastructure menu.

[image: Description of sca_menu2.gif follows]
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These administrative options enable you to perform the following tasks:


	Option	Description
	
Home

	
This option displays the following details for the SOA Infrastructure Dashboard page:

	
Recent SOA composite application instances.


	
Deployed SOA composite details (status, instance, and fault counts).


	
Recent faults and rejected messages in all SOA composite application instances, including whether the instance is recoverable.


	
Number of components hosted by service engines and the faults in those components.


	
Graphical representation of the number of instances and faults for all SOA composite applications hosted in the SOA Infrastructure.




For more information, see Section 4.1, "Monitoring SOA Infrastructure Recent Instances and Faults and Deployed Composites."


	
Monitoring

	
This option displays the following details:

	
A summary of performance statistics in the SOA infrastructure.


	
Request processing details that show the breakup of time spent in handshaking requests between the binding components, service infrastructure, and service engines.




For more information, see Section 4.2, "Monitoring Message Delivery Processing Requests."


	
Logs

	
This option enables you to view and configure the logging levels for runtime loggers.

For more information, see Section 3.4, "Configuring Log Files" and Section B.1, "Setting Logging Levels for Troubleshooting."


	
SOA Deployment

	
This option enables you to deploy, undeploy, or redeploy SOA composite applications.

For more information, see Chapter 7, "Deploying and Managing SOA Composite Applications."


	
Manage Partitions

	
This option enables you to logically group your SOA Infrastructure into separate sections known as partitions in which you deploy your SOA composite applications. This helps you to logically group composites so that you can perform bulk lifecycle management tasks on large numbers of composites.

For more information, see Section 1.4.3.5, "Introduction to Partitioning of the SOA Infrastructure" and Section 7.8, "Grouping SOA Composite Applications into Partitions."


	
Service Engines

	
This option provides access to monitoring and management tasks for the BPEL process, Oracle BPMN, Oracle Mediator, human workflow, and business rules service engines.


	
Bindings

	
This option displays details about recently active document types and trading partners, and inbound and outbound end points for Oracle B2B.

For more information, see Section 32.1, "Monitoring the Oracle B2B Infrastructure."


	
Services and References

	
This option displays message processing metrics for service and reference binding components in all SOA composite applications.

For more information, see Section 4.3, "Monitoring Service and Reference Binding Components in the SOA Infrastructure."


	
Business Events

	
This option displays available business events, current event subscribers, and fault details.

For more information, see Chapter 33, "Managing Business Events."


	
SOA Administration

	
This option provides access to the following configuration tasks for the SOA Infrastructure and each service engine:

	
Common Properties: For setting properties that impact the entire SOA Infrastructure, such as viewing and setting the SOA Infrastructure audit level, capturing the state of the SOA composite application instance, enabling the payload validation of incoming messages, specifying the callback server and server URLs, setting Universal Description, Discovery and Integration (UDDI) registry properties, viewing the data source JNDI locations, setting the nonfatal connection retry count, setting web service binding properties, and optimizing the loading performance of pages.

For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."


	
BPEL Properties: For setting the audit trail size, maximum document size for a variable, payload validation for incoming and outgoing messages, audit trail level, BPEL monitor and sensor disabling status, and dispatcher thread level for invoke message threads, system threads, and service engine threads.

For more information, see Section 12.1, "Configuring BPEL Process Service Engine Properties."


	
BPMN Properties: For setting the audit trail size, maximum document size for a variable, payload validation for incoming and outgoing messages, audit trail level, and dispatcher thread level for invoke message threads, system threads, and service engine threads.

For more information, see Section 37.1, "Configuring BPMN Process Service Engine Properties"


	
Mediator Properties: For setting the audit level, metrics level, number of parallel worker threads, number of maximum rows retrieved for parallel processing, parallel thread sleep values, error thread sleep values, container ID refresh time, and container ID lease timeout values.

For more information, see Section 15.1, "Configuring Oracle Mediator Service Engine Properties."


	
Workflow Config: Displays the following tabs:

Mailer tab: For setting the workflow service notification mode and actionable email address value. For more information, see Section 20.1, "Configuring Human Workflow Notification Properties."

Task tab: For setting the actionable email account, adding the worklist application URL, selecting the pushback assignee, adding portal realm mapping, and adding the task auto release configuration priority. For more information, see Section 20.2, "Configuring Human Workflow Task Service Properties."


	
B2B Server Properties: For enabling Dynamic Monitoring Service (DMS) metrics.


	
Cross References: For selecting cross-reference values. For more information, see Section 18, "Managing Cross-References."





	
Security

	
This option displays the following selections:

	
Application Policies: For creating application policies that an application relies upon for controlling access to resources.


	
Application Roles: For creating application roles for applications.

For more information about application roles, see Oracle Fusion Middleware Application Security Guide.




This option is available for all deployed Java EE applications, including the SOA Infrastructure (soa-infra) application. These options do not configure security policies for SOA composites.

For more information about attaching policies to composite applications, see Section 7.6, "Managing SOA Composite Application Policies."


	
Administration

	
This option displays the following selections:

	
MDS Connections: For managing metadata service (MDS) connections.


	
TopLink Sessions: For managing cache for the Oracle TopLink persistence framework.


	
System MBean Browser: For advanced configuration of properties across applications and components.

For more information, see Oracle Fusion Middleware Administrator's Guide for instructions on using the System Mean Browser.

In addition to configuring the System MBean Browser from Oracle Enterprise Manager Fusion Middleware Control, you also can invoke SOA configuration MBean operations with the WebLogic Scripting Tool (WLST). For information, see Oracle Fusion Middleware Oracle WebLogic Scripting Tool. 

Note: The System MBean Browser includes an MBean for Oracle BPMN, even if Oracle BPM Suite is not installed. If Oracle BPM Suite is not installed, this MBean cannot be used, and should be ignored. The presence of this MBean does not impact the runtime behavior of other Oracle SOA Suite components.





	
General Information

	
This option displays general details about the SOA Infrastructure, such as the Oracle Enterprise Manager Fusion Middleware Control version, Oracle home, and Oracle instance.











	
Note:

Starting with 11g Release 1 (11.1.1.4.0), you can no longer stop and start the SOA Infrastructure from the SOA Infrastructure menu.










	
Select a specific SOA composite application from the soa-infra list shown in Step 2.

The SOA Infrastructure menu is now displayed above the navigator, providing you with access to the same high-level administrative options, even when you are within the pages of a SOA composite application. This menu changes positions when you select a composite application.

[image: Description of soainfra_menu2.gif follows]

Description of the illustration soainfra_menu2.gif



	
Right-click soa-infra in the navigator. The menu that is displayed provides you with access to the same administrative options that appear in the SOA Infrastructure menu.









2.2.2 Navigating Through the SOA Composite Application Home Page and Menu

You can navigate directly to Oracle SOA Suite and Oracle BPM Suite administration tasks for a specific SOA composite application.

To navigate through the SOA composite application home page and menu:

	
Expand SOA > soa-infra in the navigator.


	
Expand the partitions.

This displays all SOA composite applications running in the partitions of the SOA Infrastructure.

[image: Description of sca_soamenu2.gif follows]
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Select a specific SOA composite application.

This displays the home page for the selected SOA composite application. The upper part of the page displays details about recent instances and faults and rejected messages. This part of the page also provides you with access to important administrative and configuration tasks at the composite level.

[image: Description of soaapp_upper_helloworld.gif follows]
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Click Show All at the bottom of each section to see more of these items. You can also click links to access more details about a specific composite instance or fault.

The lower part of the page displays details about the service components (in this example, Oracle Mediator, BPEL process, and human workflow) and binding components (services and references) included in the SOA composite application. You can click a specific service component or service or reference binding component in the Name column to access more specific details.

[image: Description of soaapp_lower_helloworld.gif follows]
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When you are within the pages of a SOA composite application, the SOA Composite menu appears below the application name at the top of the page. This menu provides you with administrative tasks specific to the current composite application.


	
Select the SOA Composite menu.

[image: Description of sca_compositelist.gif follows]
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These administrative options enable you to perform the following tasks.


	Option	Description
	
Home

	
This option displays the following details for the SOA composite application home page.

	
Recent instances.


	
Recent faults and rejected messages, including whether the instance is recoverable.


	
Service components included in the SOA composite application.


	
Services and references included in the SOA composite application.




For more information, see Chapter 7, "Deploying and Managing SOA Composite Applications."


	
Monitoring

	
This option displays the performance summary statistics for the selected SOA composite application.


	
SOA Deployment

	
This option enables you to undeploy or redeploy this SOA composite application, or deploy another SOA composite application.

For more information, see Section 7.1, "Deploying SOA Composite Applications."


	
Export

	
This option enables you to export a deployed SOA composite application to a JAR file.

For more information, see Section 7.7, "Exporting a Deployed SOA Composite Application."


	
Test Service

	
This option enables you to manually initiate an instance of this deployed SOA composite application through the Test Web Service page.

For more information, see Section 8.1, "Initiating a SOA Composite Application Test Instance."


	
Unit Tests

	
This option enables you to run test cases that simulate the interaction between the current SOA composite application and its web service partners before deployment to a production environment. This generates test instances of the composite.

For more information, see Section 1.4.3.4, "Introduction to SOA Composite Application Automated Testing" and Section 7.5, "Automating the Testing of SOA Composite Applications."


	
Policies

	
This option enables you to view and attach or detach policies to or from the SOA composite application.

For more information, see Section 1.4.3.2, "Introduction to Policies" and Section 7.6, "Managing SOA Composite Application Policies."


	
SOA Infrastructure

	
This option takes you to the SOA Infrastructure home page.


	
SOA Infrastructure Common Properties

	
This option enables you to view and set the audit level, capture the state of the SOA composite application instance, enable the payload validation of incoming messages, set UDDI registry properties, specify the callback server and server URLs, view the data source JNDI locations, set the nonfatal connection retry counts, set web service binding properties, and optimize the loading performance of pages. The SOA composite application typically inherits the settings defined at the SOA Infrastructure level.

For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."


	
Service/ Reference Properties

	
This option enables you to configure WSDL file properties for the service and reference binding components included in the SOA composite application.

For more information, see Section 34.1, "Configuring Service and Reference Binding Component Properties."


	
General Information

	
This option displays general details about this SOA composite application, such as Oracle Enterprise Manager Fusion Middleware Control version, Oracle home, Oracle instance, and partition in which the composite is deployed.








	
Right-click the name of a SOA composite application in the navigator. A menu is displayed that provides you with access to the same administrative options that appear in the SOA Composite menu.









2.2.3 Navigating Through the Partition Home Page and Menu

You can navigate to administrative tasks for a specific partition in the SOA Infrastructure.

To navigate through the partition home page and menu:

	
Expand SOA > soa-infra in the navigator.


	
Click a specific partition.

[image: Description of sca_partitionmenu2.gif follows]
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At the top of the page, select the SOA Partition menu.

[image: Description of sca_partitionmenu.gif follows]
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These administrative options enable you to perform the following tasks:


	Option	Description
	
Home

	
This option displays the following details for the partition home page:

	
SOA composite applications in this partition.


	
Status of the SOA composite applications in this partition (either Up (on) or Down (off)).


	
Mode of the SOA composite applications in this partition (active or retired).


	
Total number of instances and faulted instances of the SOA composite applications in this partition.


	
Time at which the SOA composite applications in this partition were last deployed, redeployed, or reconfigured.





	
Composites Control

	
This option displays the following bulk lifecycle management tasks:

	
Start Up All: Invokes a dialog for starting all composites in this partition.


	
Shut Down All: Invokes a dialog for shutting down all composites in this partition.


	
Activate All: Invokes a dialog for activating all composites in this partition.


	
Retire All: Invokes a dialog for retiring all composites in this partition.




For information about these composite states, see Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level."


	
SOA Deployment

	
This option displays the following management tasks.

	
Deploy To This Partition: Invokes the Deploy SOA Composite wizard for selecting a composite to deploy in this partition.


	
Undeploy All From This Partition: Invokes a dialog for undeploying all composites in this partition.


	
Redeploy: Invokes the Redeploy SOA Composite wizard to select composites to redeploy in this partition.




For more information, see Chapter 7, "Deploying and Managing SOA Composite Applications."


	
Delete This Partition

	
This option invokes a dialog to delete this partition. All composites in the partition are automatically undeployed before the partition is deleted.


	
General Information

	
This option displays general details about the partition, such as the partition (target) name, Oracle Fusion Middleware version, Oracle Fusion Middleware home directory, domain home directory, hostname, and deployed server.








	
Right-click the name of a partition in the navigator. A menu is displayed that provides you with access to the same administrative options that appear in the SOA Partition menu.







	
Note:

You can also access the partition home page from the Related Topics menu on the home page of a SOA composite application.









For information about partitions, see Section 1.4.3.5, "Introduction to Partitioning of the SOA Infrastructure" and Section 7.8, "Grouping SOA Composite Applications into Partitions."






2.2.4 Navigating to Deployed Java EE Applications

You can navigate to deployed Java EE applications related to Oracle SOA Suite and (if installed) Oracle BPM Suite components. These applications are Java EE applications that represent the SOA system components, such as the technology adapters, Oracle B2B, Oracle BPM Worklist, and so on. You can deploy a web service and see it listed here. You can also click individual applications (for example, the deployed web service), and manage and test that you can deploy WAR and EAR files from here. If you have deployed your own Java EE applications, they also display here.

To navigate to deployed Java EE applications:

	
Expand Application Deployments in the navigator.


	
Expand Internal Applications.


	
Expand Resource Adapters.

A list of deployed Java EE applications related to Oracle SOA Suite and Oracle BPM Suite components appears.

[image: Description of sca_deployapp.gif follows]
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Oracle B2B (b2bui) appears in the Internal Applications folder, while Oracle BPM Worklist (worklistapp) appears in the top level Application Deployments folder.


	
Click a specific application (for this example, worklistapp is selected).

The page displays details about application performance.

[image: Description of sca_deployapp2.gif follows]
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While Oracle Enterprise Manager Fusion Middleware Control displays the URLs for all deployed modules, you cannot directly invoke them from this page.









2.2.5 Navigating to the Oracle WebLogic Server Administration Console and Other Pages

Most pages in Oracle Enterprise Manager Fusion Middleware Control include a Related Links menu in the upper right-hand corner. Depending upon your current location, the context of the menu changes to provide links to relevant pages. For example, when you are on the BPEL process service engine page, the Related Links menu provides links to the SOA Infrastructure home page, the BPEL process configuration properties page, the Oracle WebLogic Server Administration Console, and a page for service engine log files. Figure 2-1 provides details. You can also click soa-infra at the top of the BPEL service engine page to go directly to the SOA Infrastructure home page.


Figure 2-1 Related Links Menu for a SOA Composite Application

[image: Description of Figure 2-1 follows]

Description of "Figure 2-1 Related Links Menu for a SOA Composite Application"





When you are on the page of a service component of a SOA composite application, several navigational menus and links are available:

	
The Related Links menu provides links to the SOA Infrastructure home page and the applicable service engine home page. Figure 2-2 provides details.


	
Breadcrumbs are displayed in the upper left-hand corner as you traverse further into a SOA composite application.


	
Within any SOA composite application page (including the service component pages), links to the SOA Infrastructure pages also remain available through the SOA Infrastructure menu that is displayed next to the Farm menu above the navigator. For example, this enables you to go from the home page of a specific BPEL service component directly to the BPEL service engine configuration properties page.


	
Names at the top of the page can be clicked to navigate to parent pages. For example, clicking the name of a composite at the very top of a service component page enables you to go to the composite that includes that component.





Figure 2-2 Related Links Menu for a Service Component of a SOA Composite Application

[image: Description of Figure 2-2 follows]
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The service engines, SOA administration (such as the SOA Infrastructure Common Properties page), and business event pages all provide access to Oracle WebLogic Server Administration Console from the Related Topics list. Selecting WebLogic Server Console opens a new browser page and takes you to the login prompt for the Oracle WebLogic Server Administration Console. Your current page in Oracle Enterprise Manager Fusion Middleware Control is not lost. After logging in, the home page is displayed. Figure 2-3 provides details.


Figure 2-3 Oracle WebLogic Server Administration Console

[image: Description of Figure 2-3 follows]
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You can perform the following Oracle SOA Suite tasks from Oracle WebLogic Server Administration Console:

	
Configure adapter connections for composite references.


	
Create and manage data sources utilized by adapters.


	
Create and manage JMS resources utilized by adapters.


	
Manage SOA Infrastructure data sources (for example, modifying connection pool settings).


	
Administer security of human workflow users.


	
Manage Oracle WebLogic Server transaction (JTA) settings (for example, the transaction timeout value).


	
Deploy human task user interfaces.









2.2.6 Navigating to the SOA Infrastructure or SOA Composite Application Home Page from the Farm Home Page

You can access the home page of the SOA Infrastructure, a specific SOA partition, or a specific SOA composite application from the Farm home page.

To navigate to the SOA Infrastructure or SOA composite application home page:

	
In the Deployments section of the Farm home page, click soa-infra or a specific SOA composite application (for example, SimpleApproval).

[image: Description of sca_menu3.gif follows]
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The home page for your selection is displayed.











2.3 Logging Out of Oracle Enterprise Manager Fusion Middleware Control

This section describes how to log out of Oracle Enterprise Manager Fusion Middleware Control.

To log out of Oracle Enterprise Manager Fusion Middleware Control:

	
Note the following details about logging out.

	
If multiple pages are open (for example, the help dialog, topology viewer, and flow trace), logging out of any page logs you out of the entire application in all open pages.


	
If you log out with any unsaved configuration changes, you receive no warning message and your changes are lost.





	
In the upper right-hand corner of any page, click the Log Out link.
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Part XIV


Administering Binding Components

This part describes how to administer binding components.

This part includes the following chapters:

	
Chapter 34, "Configuring Service and Reference Binding Components"


	
Chapter 35, "Monitoring Service and Reference Binding Components"


	
Chapter 36, "Managing Service and Reference Binding Components"
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5 Securing SOA Composite Applications

This chapter describes security configuration procedures unique to SOA composite applications. Most SOA composite application security procedures do not require SOA-unique configuration steps. References are provided to additional documentation for performing those tasks.

This chapter includes the following topics:

	
Section 5.1, "Introduction to Securing SOA Composite Applications"


	
Section 5.2, "Configuring Oracle HTTP Server with Oracle BPM Worklist"


	
Section 5.3, "Setting up SAML Message-Protected Policy Configuration for the SOA Infrastructure"


	
Section 5.4, "Automatically Authenticating Oracle BPM Worklist and Oracle Business Process Management Users"


	
Section 5.5, "Listing the Authentication Provider"


	
Section 5.6, "Configuring SSL"


	
Section 5.7, "Configuring Security for Human Workflow WSDL Files"







	
Note:

See the following sections for information on attaching and detaching policies:

	
Section 7.6, "Managing SOA Composite Application Policies"


	
Section 14.2, "Managing BPEL Process Service Component Policies"


	
Section 17.2, "Managing Oracle Mediator Policies"


	
Section 22.1, "Managing Human Task Service Component Policies"


	
Section 36.1, "Managing Binding Component Policies"














5.1 Introduction to Securing SOA Composite Applications

This chapter describes security procedures unique to SOA composite applications. Most SOA composite application security procedures do not require SOA-unique steps and can be performed by following the documentation listed in Table 5-1.


Table 5-1 Security Documentation

	For Information On...	See The Following Guide...
	
Securing Oracle Fusion Middleware, including Oracle Single Sign-On (OSSO) configuration

	
Oracle Fusion Middleware Application Security Guide



	
Securing and administering web services

	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services



	
Understanding Oracle WebLogic Server security

	
Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server



	
Securing an Oracle WebLogic Server production environment

	
Oracle Fusion Middleware Securing a Production Environment for Oracle WebLogic Server



	
Securing Oracle WebLogic Server

	
Oracle Fusion Middleware Securing Oracle WebLogic Server



	
Developing new security providers for use with Oracle WebLogic Server

	
Oracle Fusion Middleware Developing Security Providers for Oracle WebLogic Server



	
Securing web services for Oracle WebLogic Server

	
Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server



	
Programming security for Oracle WebLogic Server

	
Oracle Fusion Middleware Programming Security for Oracle WebLogic Server



	
Oracle Business Activity Monitoring

	
Section 23.9, "Configuring Security"



	
Securing Oracle User Messaging Service

	
Section 26.6, "Securing the Oracle User Messaging Service"













5.2 Configuring Oracle HTTP Server with Oracle BPM Worklist

You must add the /integration location in the mod_wl_ohs.conf file of Oracle HTTP Server for Oracle BPM Worklist to work through Oracle HTTP Server.


  <Location /integration>
       SetHandler weblogic-handler
   #   PathTrim /weblogic
       ErrorPage  http:/WEBLOGIC_HOME:WEBLOGIC_PORT/
  </Location>






5.3 Setting up SAML Message-Protected Policy Configuration for the SOA Infrastructure

This section describes how to set up and validate Security Assertion Markup Language (SAML) message-protected policy configuration for the SOA Infrastructure with the Oracle WebLogic Scripting Tool (WLST). The example in this section describes task query service configuration. However, these instructions are relevant to all human workflow services that support SAML-token ports:

	
Activity guide query service


	
Activity guide metadata service


	
Activity guide admin service


	
Task query service


	
Task service


	
Task metadata service


	
Runtime config service


	
Task evidence service


	
User metadata service




If you want to change the policy for another service, you must apply the same WLST commands to that service's SAML-token port.

To set up an SAML message-protected policy configuration:

	
Log in to the SOA domain (for example, named base_domain) using WLST.


	
Detach the existing out-of-the-box service policy named wss10_saml_token_service_policy.


wls:/base_domain/domainRuntime> detachWebServicePolicy('/base_domain/soa
_server1/soa-infra','integration/services/TaskQueryService','web',
'WorkflowProvider','TaskQueryServicePortSAML','oracle/
wss10_saml_token_service_policy')


	
Restart the application to activate any policy or configuration change.


	
Attach the new policy. In this case, the policy is named oracle/wss10_saml_token_with_message_protection_service_policy.


wls:/base_domain/domainRuntime> attachWebServicePolicy('/base_domain/soa
_server1/soa-infra','integration/services/TaskQueryService',
'web','WorkflowProvider','TaskQueryServicePortSAML','ora
cle/wss10_saml_token_with_message_protection_service_policy')


	
Restart the application to activate any policy or configuration change.


	
List the policy to validate.


wls:/base_domain/domainRuntime> listWebServicePolicies('/base_domain/soa
_server1/soa-infra','integration/services/TaskQueryService',
'web','WorkflowProvider','TaskQueryServicePortSAML')
    TaskQueryServicePortSAML :
    security :
oracle/wss10_saml_token_with_message_protection_service_policy,
    enabled=true 
Attached policy or policies are valid; endpoint is secure.


	
Create a keystore, add the orakey alias, and run the Oracle Web Service Manager (OWSM) configuration to activate the SAML message-protected policy. For example:


keytool -genkeypair
        -keystore  domain_home/config/fmwconfig/default-keystore.jks
        -keyalg RSA
        -dname "cn=consumer,dc=example,dc=com"
        -alias clientalias
        -keypass  password 
        -storepass password
        -validity 3600

keytool -exportcert 
        -keystore domain_home/config/fmwconfig/default-keystore.jks
        -v 
        -alias clientalias
        -storepass password 
        -rfc 
        -file domain_home/config/fmwconfig/certificate.cer

keytool -importcert 
        -keystore domain_home/config/fmwconfig/default-keystore.jks
        -alias orakey
        -file domain_home/config/fmwconfig/certificate.cer
        -storepass password
         createCred(map="oracle.wsm.security", key="keystore-csf-key",
         user="owsm", password="welcome1", desc="Keystore key")
         createCred(map="oracle.wsm.security", key="enc-csf-key",
         user="clientalias", password="welcome1", desc="Encryption key")
         createCred(map="oracle.wsm.security", key="sign-csf-key",
         user="clientalias", password="welcome1", desc="Signing key") 


	
Restart the servers.









5.4 Automatically Authenticating Oracle BPM Worklist and Oracle Business Process Management Users

This section describes how to authenticate Oracle BPM Worklist and Oracle Business Process Management users in different environments.



5.4.1 Automatically Authenticating Oracle BPM Worklist Users in SAML SSO Environments

To be automatically authenticated when accessing a second Oracle BPM Worklist from a first Oracle BPM Worklist in SAML SSO environments, you must perform the following steps. Otherwise, you are prompted to log in again when you access the second Oracle BPM Worklist. In these environments, the first Oracle BPM Worklist is configured as the SAML identity provider and the second Oracle BPM Worklist that you access is configured as the SAML service provider.

To automatically authenticate Oracle BPM Worklist users in SAML SSO environments:

	
Add /integration/worklistapp/* as the redirect URL for worklistapp to the SAML service provider site's SAML2IdentityAsserter configuration as follows.

	
In the Oracle WebLogic Server Administration Console, select Security Realms.


	
Click the realms for the service providers.


	
Select the Providers tab, and then the Authentication subtab.


	
From the provider list, select the provider with the description SAML 2.0 Identity Assertion Provider.

If you do not see the SAML identity assertion provider configuration, follow the instructions in Oracle Fusion Middleware Securing Oracle WebLogic Server.


	
Select the Management tab.

Under the Management tab, you see a list of identity provider partners. These are hosts that have been configured as the SAML identity provider partners for this SAML identity service provider site. Remember that this configuration step is performed on the identity service provider site on which Oracle BPM Worklist is hosted.


	
Select the identity provider site where you want the user to perform the initial login.


	
Scroll down the page until you see the field Redirect URIs.


	
Add /integration/worklistapp/* to the list.




After performing this step, you can log in to Oracle BPM Worklist at the SAML identity provider site though the regular URL of/integration/worklistapp. If necessary, you can then navigate to the URL /integration/worklistapp/ssologin at the SAML service provider site, where you gain access to Oracle BPM Worklist and are automatically authenticated.

For more information about SAML2IdentityAsserter and configuring SSO with web browsers and HTTP clients, see Oracle Fusion Middleware Securing Oracle WebLogic Server.









5.4.2 Automatically Authenticating Oracle BPM Worklist Users in Windows Native Authentication Environments

For Windows native authentication through Kerberos to work with Oracle BPM Worklist, you must use the /integration/worklistapp/ssologin protected URL. For example, after configuring Windows native authentication, you access Oracle BPM Worklist as follows:


http://host_name.domain_name:8001/integration/worklistapp/ssologin 


For information on configuring SSO with Microsoft clients, see Oracle Fusion Middleware Securing Oracle WebLogic Server.






5.4.3 Automatically Authenticating Oracle Business Process Management Process Composer Users in Windows Native Authentication Environments

For Windows native authentication through Kerberos to work with Oracle Business Process Management Process Composer, you must use the bpm/composer/ssologin protected URL. For example, after configuring Windows native authentication, you access Process Composer as follows:


http://host_name.domain_name:8001/bpm/composer/ssologin 


For information on configuring SSO with Microsoft clients, see Oracle Fusion Middleware Securing Oracle WebLogic Server.








5.5 Listing the Authentication Provider

This section describes how to set the first authentication provider.



5.5.1 Listing Oracle Internet Directory as the First Authentication Provider

The Oracle BPM Worklist and workflow services use Java Platform Security (JPS) and the User and Role API. For this reason, the Oracle Internet Directory authenticator must be the first provider listed when workflow is used with Oracle Internet Directory. If Oracle Internet Directory is not listed first (for example, it is listed below DefaultAuthenticator), login authentication fails.

For information about changing the order of authentication providers, see Oracle Fusion Middleware Securing Oracle WebLogic Server.






5.5.2 Accessing Web-based Applications with the Default Authentication Provider

Logging in to web-based applications may fail when using Oracle Internet Directory authentication. This is caused when the Oracle WebLogic Server configuration is set to use the Oracle Internet Directory authentication before default authentication.

This may produce the following error:


"@ User "weblogic" is not found in configuration "jazn.com" Check if the user
 exists in the repository specified by the configurations. Check the error stack
 and fix the cause of the error. Contact oracle support if error is not fixable."


The order of the security providers should be:

	
Default authentication


	
Oracle Internet Directory/LDAP authentication











5.6 Configuring SSL

This section describes configuring secure socket layer (SSL) in Oracle SOA Suite and Oracle Business Process Management environments.


5.6.1 Using SSL Certificates When the SOA/BPM Server Is Configured with an HTTPS Port

If the SOA/BPM server is configured with an HTTPS port, ensure that your SSL certificate adheres to the following standards:

	
The certificate that the server presents to SSL clients (the browser or other internal clients such as the notification senders) is a trusted certificate by its own trust store (the CA store).


	
If the certificate for the server is self-signed, ensure that you add it to the trust store. That is, the certificate that the server presents must validate itself against the server trust store.




Not doing so can cause problems when task notifications are sent. For example, you can receive the error message shown in Example 5-1 in the server out log (for example, soa_server1.out).


Example 5-1 Task Notification Error


<Sep 13, 2011 12:59:41 AM PDT> <Error> <oracle.soa.services.workflow.common>
<BEA-000000> <<.>
ORABPEL-0
        at
oracle.bpel.services.workflow.task.notification.
TaskNotifications.getEmailPaylOad
(TaskNotifications.java:1354)
        at
oracle.bpel.services.workflow.task.notification.
TaskNotifications.getEmailNotificationContent
(TaskNotifications.java:987)
        at
weblogic.jms.client.JMSSession$UseForRunnable.run
(JMSSession.java:5170)
        at
weblogic.work.SelfTuningWorkManagerImpl$WorkAdapterImpl.run(SelfTuningWorkManagerI
mpl.java:528)
        at weblogic.work.ExecuteThread.execute(ExecuteThread.java:209)
        at weblogic.work.ExecuteThread.run(ExecuteThread.java:178)
Caused By: javax.net.ssl.SSLKeyException: [Security:090477]Certificate chain
received from adcgen15.us.oracle.com - 10.232.152.78 was not trusted causing
SSL handshake failure.
        at
com.certicom.tls.interfaceimpl.TLSConnectionImpl.
fireException(UnknownSource)
        at
com.certicom.tls.interfaceimpl.TLSConnectionImpl.
fireAlertSent(UnknownSource)
        at
com.certicom.tls.record.handshake.HandshakeHandler.
fireAlert(Unknown Source).
ficationContent(TaskNotifications.java:987)
        at
weblogic.jms.client.JMSSession$UseForRunnable.run(JMSSession.java:5170)
        at
weblogic.work.SelfTuningWorkManagerImpl$WorkAdapterImpl.run(SelfTuningWorkManagerI
mpl.java:528)
        at weblogic.work.ExecuteThread.execute(ExecuteThread.java:209)
        at weblogic.work.ExecuteThread.run(ExecuteThread.java:178)
Caused By: javax.net.ssl.SSLKeyException: [Security:090477]Certificate chain
received from adcgen15.us.oracle.com - 10.232.152.78 was not trusted causing
SSL handshake failure.
        at
com.certicom.tls.interfaceimpl.TLSConnectionImpl.
fireException(UnknownSource)
        at
com.certicom.tls.interfaceimpl.TLSConnectionImpl.
fireAlertSent(UnknownSource)
        at
com.certicom.tls.record.handshake.HandshakeHandler.
fireAlert(Unknown Source




For more information about concepts and configuration details, see Oracle Fusion Middleware Securing Oracle WebLogic Server.






5.6.2 Recommendation to Configure Either All or No Managed Servers with SSL

As a best practice, Oracle recommends that you configure either all managed servers or no managed servers with SSL (SOA, BAM, and so on). Configuring some managed servers with SSL, while not configuring others, may lead to undesirable results in Oracle BPM Worklist and Oracle Web Services Manager (OWSM). For example, if there is an SSL-configured, managed server (bam_server), servers not configured with SSL are not used by OWSM. In cases in which an SSL-configured server is down, it causes OWSM to be in a down state, which in turn causes Oracle BPM Worklist to be in a down state.






5.6.3 Switching from Non-SSL to SSL Configurations with Oracle BPM Worklist

Switching from non-SSL to SSL configurations with Oracle BPM Worklist requires the Frontend Host and Frontend HTTPS Port fields to be set in Oracle WebLogic Server Administration Console. Not doing so results in exception errors when you attempt to create to-do tasks.

To switch from non-SSL to SSL configurations with Oracle BPM Worklist:

	
Log in to Oracle WebLogic Server Administration Console.


	
In the Environment section, select Servers.


	
Select the name of the managed server (for example, soa_server1).


	
Select Protocols, then select HTTP.


	
In the Frontend Host field, enter the hostname on which Oracle BPM Worklist is located.


	
In the Frontend HTTPS Port field, enter the SSL listener port.


	
Click Save.









5.6.4 Configuring SOA Composite Applications for Two-Way SSL Communication

Oracle SOA Suite uses both Oracle WebLogic Server and Sun Secure Socket Layer (SSL) stacks for two-way SSL configurations.

	
For the inbound web service bindings, Oracle SOA Suite uses the Oracle WebLogic Server infrastructure and, therefore, the Oracle WebLogic Server libraries for SSL.


	
For the outbound web service bindings, Oracle SOA Suite uses JRF HttpClient and, therefore, the Sun JDK libraries for SSL.




Due to this difference, start Oracle WebLogic Server with the following JVM option.

To configure SOA composite applications for two-way SSL communication:

	
Open the following file:

	
On UNIX operating systems, open $MIDDLEWARE_HOME/user_projects/domains/domain_name/bin/setDomainEnv.sh.


	
On Window operating systems, open MIDDLEWARE_HOME\user_projects\domains\domain_name\bin\setDomainEnv.bat.





	
Add the following lines in the JAVA_OPTIONS section, if the server is enabled for one-way SSL (server authorization only):


-Djavax.net.ssl.trustStore=your_truststore_location


For two-way SSL, the keystore information (location and password) is not required.




In addition, perform the following steps to enable two-way SSL for a SOA composite application to invoke another SOA composite application or another non-SOA application.




	
Note:

Both the server and client are assumed to have been configured for SSL with mutual authentication.









To enable two-way SSL for a SOA composite application to invoke another application:

	
On the client side, provide the keystore location.

	
From the SOA Infrastructure menu, select SOA Administration > Common Properties.


	
At the bottom of the page, click More SOA Infra Advanced Configuration Properties.


	
Click KeystoreLocation.


	
In the Value column, enter the keystore location.


	
Click Apply.


	
Click Return.





	
During design time in Oracle JDeveloper, update the reference section in the composite.xml file with the oracle.soa.two.way.ssl.enabled property.


<reference name="Service1" 
   ui:wsdlLocation=". . ."> 
   <interface.wsdl interface=". . ."/> 
     <binding.ws port=". . ."> 
      <property name="oracle.soa.two.way.ssl.enabled">true</property> 
  </binding.ws> 
 </reference> 


	
In Oracle Enterprise Manager Fusion Middleware Control, select WebLogic Domain > domain_name.


	
Right-click domain_name and select Security > Credentials.


	
Click Create Map.


	
In the Map Name field, enter a name (for example, SOA), and click OK.


	
Click Create Key.


	
Enter the following details.


	Field	Description
	
Select Map

	
Select the map created in Step 6 (for this example, SOA).


	
Key

	
Enter the key name (KeystorePassword is the default).


	
Type

	
Select Password.


	
User Name

	
Enter the keystore user name (KeystorePassword is the default).


	
Password

	
Enter the password that you created for the keystore.











	
Note:

When you set up SSL in Oracle WebLogic Server, a key alias is required. You must enter mykey as the alias value. This value is required.










	
Set the keystore location in Oracle Enterprise Manager Fusion Middleware Control. See Step 1 for instructions.


	
Modify composite.xml to use https and sslport to invoke a SOA composite application. For example, change the syntax shown in bold:


<?xml version="1.0" encoding="UTF-8" ?> 
<!-- Generated by Oracle SOA Modeler version 1.0 at [4/1/09 11:01 PM]. --> 
<composite name="InvokeEchoBPELSync" 
revision="1.0" 
label="2009-04-01_23-01-53_994" 
mode="active" 
state="on" 
xmlns="http://xmlns.oracle.com/sca/1.0" 
xmlns:xs="http://www.w3.org/2001/XMLSchema" 
xmlns:wsp="http://schemas.xmlsoap.org/ws/2004/09/policy" 
xmlns:orawsp="http://schemas.oracle.com/ws/2006/01/policy" 
xmlns:ui="http://xmlns.oracle.com/soa/designer/"> 
<import 
namespace="http://xmlns.oracle.com/CustomApps/InvokeEchoBPELSync/BPELProcess1"
  location="BPELProcess1.wsdl" importType="wsdl"/>
<import namespace="http://xmlns.oracle.com/CustomApps/EchoBPELSync/
BPELProcess1"location="http://hostname:port/soa-infra/services/default/EchoBPEL
Sync/BPELProcess1.wsdl"
importType="wsdl"/>


to use https and sslport:


location="https://hostname:sslport/soa-infra/services/default/EchoBPELSync
/BPELProcess1.wsdl"









5.6.5 Invoking References in One-Way SSL Environments in Oracle JDeveloper

When invoking a web service as an external reference from a SOA composite application in one-way SSL environments, ensure that the certificate name (CN) and the hostname of the server exactly match. This ensures a correct SSL handshake.

For example, if a web service is named adfbc and the certificate has a server name of myhost05, the following syntax results in an SSL handshake exception.


  <import namespace="/adfbc1/common/" 
           
 location="https://myhost05.us.oracle.com:8002/CustomApps-adfbc1-context-root/Ap 
pModuleService?WSDL" 
          importType="wsdl"/> 
 <import namespace="/adfbc1/common/" location="Service1.wsdl" 
          importType="wsdl"/> 


If you switch the order of import, the SSL handshake passes.


<import namespace="/adfbc1/common/" location="Service1.wsdl" 
          importType="wsdl"/> 
<import namespace="/adfbc1/common/" 
           location="https://myhost05.us.oracle.com:8002/CustomApps-adfbc1-context-root/Ap 
pModuleService?WSDL" 
          importType="wsdl"/> 


Note the following restrictions around this issue:

	
There are no options for ignoring hostname verification in Oracle JDeveloper as exist with the Oracle WebLogic Server Administration Console. This is because the SSL kit used by Oracle JDeveloper is different. Only the trust store can be configured from the command line. All other certificate arguments are not passed.


	
In the WSDL file, https://hostname must match with that in the certificate, as described above. You cannot perform the same procedures as you can with a browser. For example, if the hostname is myhost05.us.oracle.com in the certificate's CN, then you can use myhost05, myhost05.us.oracle.com, or the IP address from a browser. In Oracle JDeveloper, always use the same name as in the certificate (that is, myhost05.us.oracle.com).









5.6.6 Configuring Oracle SOA Suite and Oracle HTTP Server for SSL Communication

Follow these steps to configure SSL communication between Oracle SOA Suite and Oracle HTTP Server.



5.6.6.1 Configuring Oracle HTTP Server for SSL Communication

To configure Oracle HTTP server for SSL communication:

	
Update mod_ssl.conf with the <Location /integration/services> location directive.


LoadModule weblogic_module   ${ORACLE_HOME}/ohs/modules/mod_wl_ohs.so

<IfModule mod_weblogic.c>
      WebLogicHost host.domain.com
      WLLogFile <logdir>/ohs_ssl.log
      Debug ALL
      DebugConfigInfo ON
      SecureProxy ON
      MatchExpression *.jsp
      WlSSLWallet <OHS_
HOME>/instances/instance1/config/OHS/ohs1/keystores/default
</IfModule>

<Location /soa-infra>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /b2bconsole>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /b2b> 
      WebLogicPort 8002 
      SetHandler weblogic-handler 
       ErrorPage http://host.domain.com:port/error.html 
</Location> 

<Location /integration/worklistapp>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /integration/services>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /DefaultToDoTaskFlow>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /OracleBAM>
      WebLogicPort 9002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>

<Location /OracleBAMWS>
      WebLogicPort 9002
      SetHandler weblogic-handler
      ErrorPage  http://host.domain.com:port/error.html
</Location>

<Location /sdpmessaging/userprefs-ui/>
      WebLogicPort 8002
      SetHandler weblogic-handler
      ErrorPage http://host.domain.com:port/error.html
</Location>


	
Start the Oracle WebLogic Servers as described in Section 5.6.4, "Configuring SOA Composite Applications for Two-Way SSL Communication."









5.6.6.2 Configuring Certificates for Oracle Client, Oracle HTTP Server, and Oracle WebLogic Server

To configure certificates for Oracle Client, Oracle HTTP Server, and Oracle WebLogic Server:

	
Export the user certificate from the Oracle HTTP Server wallet.


orapki wallet export -wallet . -cert cert.txt  -dn 'CN=\"Self-Signed
 Certificate for ohs1 \",OU=OAS,O=ORACLE,L=REDWOODSHORES,ST=CA,C=US'


	
Import the above certificate into the Oracle WebLogic Server trust store as a trusted certificate.


keytool -file cert.txt -importcert -trustcacerts -keystore DemoTrust.jks


	
Export the certificate from the Oracle WebLogic Server trust store.


keytool -keystore DemoTrust.jks -exportcert -alias wlscertgencab -rfc -file
certgencab.crt


	
Import the above certificate to the Oracle HTTP Server wallet as a trusted certificate.


orapki wallet add -wallet . -trusted_cert -cert certgencab.crt -auto_login_only


	
Restart Oracle HTTP Server.


	
Restart the Oracle WebLogic Servers as described in Section 5.6.4, "Configuring SOA Composite Applications for Two-Way SSL Communication."











5.6.7 Configuring SSL Between SOA Composite Application Instances and Oracle WebCache

The Test Web Service page in an Oracle WebCache and Oracle HTTP Server environment may require communication back through Oracle WebCache. Therefore, SSL must be configured between the SOA composite application instance and Oracle WebCache (that is, export the user certificate from the Oracle WebCache wallet and import it as a trusted certificate in the Oracle WebLogic Server trust store).






5.6.8 Using a Custom Trust Store for One-Way SSL During Design Time

To invoke a SOA composite application from another composite over HTTPS when using a custom trust store created with a tool such as keytool or orapki, perform the following actions in Oracle JDeveloper.

To use a custom trust store for one-way SSL during design time:

	
To fetch a WSDL file in the reference section, set the trust store information in Tools > Preferences > Http Analyzer > HTTPS Setup > Client Trusted Certificate Keystore.


	
During deployment to an SSL-enabled server, use the JSSE property at the command line:


jdev -J-Djavax.net.ssl.trustStore=your_trusted_location









5.6.9 Enabling an Asynchronous Process Deployed to an SSL-Enabled, Managed Server to Invoke Another Asynchronous Process Over HTTP

Assume you create the following environment:

	
Asynchronous BPEL process A invokes asynchronous BPEL process B


	
Asynchronous BPEL process A is deployed to a one-way SSL enabled, managed server


	
All WSDL reference and bindings use plain HTTP




At runtime, the WSDL is looked for over HTTPS, and the callback message from asynchronous BPEL process B fails.

To resolve this issue, the callbackServerURL property must be passed at the reference binding level in the composite.xml file. This explicitly indicates the value of the callback URL for the given reference invocation. If the client composite is running in an SSL-managed server, then the callback defaults to SSL.


<reference name="Service1" 
ui:wsdlLocation="http://localhost:8000/soa-infra/services/default/AsyncSecondB 
PELMTOM/BPELProcess1.wsdl"> 
    <interface.wsdl
 interface="http://xmlns.oracle.com/Async/AsyncSecondBPELMTOM/BPELProcess1#wsdl 
.interface(BPELProcess1)" 
callbackInterface="http://xmlns.oracle.com/Async/AsyncSecondBPELMTOM/BPELProce
ss1#wsdl.interface(BPELProcess1Callback)"/> 
    <binding.ws 
port="http://xmlns.oracle.com/Async/AsyncSecondBPELMTOM/BPELProcess1#wsdl.endp 
oint(bpelprocess1_client_ep/BPELProcess1_pt)" 
                
location="http://localhost:8000/soa-infra/services/default/AsyncSecondBPELMTOM 
/bpelprocess1_client_ep?WSDL"> 
         <wsp:PolicyReference URI="oracle/wss_username_token_client_policy" 
                           orawsp:category="security" 
orawsp:status="enabled"/> 
      <wsp:PolicyReference URI="oracle/wsaddr_policy" 
                           orawsp:category="addressing" 
orawsp:status="enabled"/> 
. 
 <property name="callbackServerURL">http://localhost:8000/</property> 
. 
    </binding.ws> 
. 
  <callback> 
      <binding.ws 
port="http://xmlns.oracle.com/Async/AsyncSecondBPELMTOM/BPELProcess1#wsdl.endp 
oint(bpelprocess1_client_ep/BPELProcess1Callback_pt)"> 
            <wsp:PolicyReference 
URI="oracle/wss_username_token_service_policy" 
                           orawsp:category="security" 
orawsp:status="enabled"/> 
 </binding.ws> 
    </callback> 
    
. 
  </reference> 








5.7 Configuring Security for Human Workflow WSDL Files

If the WSDL files for human workflow services are not exposed to external consumers, then set the flag that exposes the WSDL to false for each of the services:


<expose-wsdl>false</expose-wsdl>


For more information, see Oracle Fusion Middleware Developer's Guide for Oracle Web Services.









Part IX



  Administering Oracle Business Activity Monitoring

This part describes how to administer Oracle Business Activity Monitoring.

This part includes the following chapters:

	
Chapter 23, "Configuring Oracle Business Activity Monitoring"


	
Chapter 24, "Monitoring Oracle Business Activity Monitoring"


	
Chapter 25, "Managing Oracle Business Activity Monitoring"










Part X


Administering Oracle User Messaging Service

This part describes how to administer Oracle Messaging Service.

This part includes the following chapters:

	
Chapter 26, "Configuring Oracle User Messaging Service"


	
Chapter 27, "Monitoring Oracle User Messaging Service"


	
Chapter 28, "Managing Oracle User Messaging Service"










17 Managing Oracle Mediator Service Components and Engines

This chapter describes how to manage Oracle Mediator service components and engines using Oracle Enterprise Manager Fusion Middleware Control. It provides instructions for viewing recovering faults, and attaching and detaching Mediator policies.

This chapter includes the following topics:

	
Section 17.1, "Recovering From Oracle Mediator Service Component Faults"


	
Section 17.2, "Managing Oracle Mediator Policies"


	
Section 17.3, "Recovering From Oracle Mediator Service Engine Faults"






17.1 Recovering From Oracle Mediator Service Component Faults

You can monitor Mediator service component faults and perform individual and bulk recoveries for faults that are identified as recoverable.

To manage Mediator service component faults:

	
Access the SOA Component home page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Expand soa-infra, and then select a specific SOA composite application.











	
Select the Mediator service component in the Component Metrics section.


	
Click Faults.

The Faults page displays the following information:

	
A utility that you can use to search for a specific fault by specifying criteria and clicking Search. Click the Help icon for more information.


	
Faults that occurred in the service component, including the error message, whether you can recover from the fault, the time at which the fault occurred, service component instance ID, activity in which the fault occurred, and a link to a log file describing the fault.




[image: Description of med_srveng_fault.gif follows]
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Mediator service component faults that are marked as recoverable can be recovered.


	
Select faults for recovery using one of the following methods.


	For...	Then...
	
Single fault recovery

	
There are three options from which to choose for single-fault recovery. Perform any of the following actions to recover a single fault.

	
Click the row of the fault that has been identified as recoverable. With the row highlighted, select a specific action from the Recovery Action list, as described in Step 5.


	
In the Recovery column, click the Recover link to access the Faults page of the instance audit trail to perform fault recovery. Figure 17-1 illustrates the fault page.


	
In the Error Message column, click the message of a fault that has been identified as recoverable. This displays complete fault details, including the fault ID, fault time, fault location, fault type, and error message text. Click Recover Now to access the Faults page of the instance audit trail to perform fault recovery. If there is no Recover Now option, the fault is not recoverable.





	
Bulk fault recovery

	
There are two options from which to choose for bulk-fault recovery. Perform the following steps to recover multiple faults.

	
Do one of the following:

Use Shift+Click or Control+Click to select specific faults in the rows.

From the Select menu, choose Select All Recoverable. Then use Shift+Click or Control+Click to deselect the faults to not include in the recovery operation.


	
Select an action from the Recovery Action list, as described in Step 5.

Note: Only the actions applicable to all selected faults are available.





	
Recovery of all faults

	
Perform the following steps to recover all faults.

	
From the Select menu, choose Select All Recoverable.


	
Select an action from the Recovery Action list, as described in Step 5.

Note: Only the actions applicable to all selected faults are available.












Figure 17-1 Fault Tab on the Mediator Instance Detail Dialog

[image: Description of Figure 17-1 follows]
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If you did not already select a recovery method in the above step, select one of the following actions from the Recovery Action list.


	Action	Description
	
Retry

	
Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.


	
Abort

	
Terminates the entire instance.


	
Replay

	
Replays the entire scope activity again in which the fault occurred.


	
Rethrow

	
Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.


	
Continue

	
Ignores the fault and continues processing (marks the faulted activity as a success).










For more information, see the following documentation:

	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite


	
Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files









17.2 Managing Oracle Mediator Policies

Oracle Fusion Middleware uses a policy-based model to manage web services. Policies apply behavioral requirements and security to the delivery of messages. You can view, attach, and detach policies for Mediator service components in currently deployed SOA composite applications.

The Policies page of the Mediator Component Home page provides the following information about a Mediator component instance:

	
Policy Name: The name of the policy.


	
Policy Reference Status: A toggle button that allows you to enable or disable a policy. Disabling a policy temporarily turns it off without detaching it. If the button says Disable, the policy is enabled; if it says Enable, the policy is disabled.


	
Category: The category of the policy. It has the following values: Management, Reliable Messaging, MTOM Attachments, Security, and WS-Addressing.


	
Total Violations: The total number of violations since the SOA Infrastructure was restarted.


	
Security Violation: The number of violations in each category. Category can have the following values: Authentication, Authorization, Confidentiality, and Integrity.







	
Note:

Before attaching policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use in your environment.









To manage Mediator policies:

	
Access the SOA Composite home page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, select a specific SOA composite application.











	
Click the Policies tab.


	
View the policies attached to a Mediator component.

[image: Description of med_comphome_pol1.gif follows]
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Click Attach/Detach to attach or detach a policy.


	
If multiple components are available, select the service or component to which you want to attach the policy.

The Attach/Detach Policies page appears with all attached policies displayed in the upper pane and all available policies displayed in the lower pane.

[image: Description of med_comphome_pol2.gif follows]
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To attach a policy, select the policy in the lower pane and then click Attach.


	
To detach a policy, select the policy in the upper pane and then click Detach.


	
When you finish attaching or detaching policies, click Validate.


	
If any validation errors occur, make the necessary corrections and run the validation until no more errors occur.


	
Click OK.

The dialog closes and the attached policies appear in the policies table.




For more information, see the following documentation:

	
Section 1.4.3.2, "Introduction to Policies"


	
Section 7.6, "Managing SOA Composite Application Policies" for the dialogs that are displayed during policy attachment


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use for your environment









17.3 Recovering From Oracle Mediator Service Engine Faults

You can monitor and perform individual and bulk fault recoveries for Mediator service engines that are identified as recoverable. All Mediator service component faults, regardless of the SOA composite application instance of which they are a part, can be viewed in the Mediator service engine.

To manage Mediator service engine faults:

	
Access the SOA Composite home page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > Mediator.




	
	
Right-click soa-infra.


	
Select Service Engines > Mediator.











The Mediator Engine home page appears.


	
Click Faults.

The Faults page displays the following:

	
A utility so you can search for a specific fault by specifying criteria and clicking Search. Click the Help icon for more information.


	
Faults that occurred in the service component, including the error message, whether you can recover from the fault, the time at which the fault occurred, service component instance ID, activity in which the fault occurred, and a link to a log file describing the fault.




[image: Description of med_srveng_fault.gif follows]
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Mediator service engine faults that are marked as recoverable can be recovered.


	
Select a fault or faults.

As with fault recovery at the SOA Infrastructure level, SOA composite application level, and Mediator service component level, you can perform single fault recovery, bulk fault recovery, and recovery of all faults. See Step 4 of Section 17.1, "Recovering From Oracle Mediator Service Component Faults" for instructions on selecting faults to perform these types of recovery.


	
If you did not select a recovery action in the previous step, select an action from the Recovery Action list.


	Action	Description
	
Retry

	
Retries the instance with an option to provide a retry success action. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.


	
Abort

	
Terminates the entire instance.


	
Replay

	
Replays the entire scope activity again in which the fault occurred.


	
Rethrow

	
Rethrows the current fault.


	
Continue

	
Ignores the fault and continues processing (marks the faulted activity as a success).








	
Perform the following additional monitoring tasks from within the faults table:

	
Click the Show only recoverable faults check box to only display faults from which you can recover.


	
From the Fault Type list, select to display all faults, system faults, business faults, or OWSM faults in the faults table. Click Help for a description of these fault types.


	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Component column, click a specific service component to access its home page.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Note that rejected messages do not have a component instance ID.







For more information, see the following documentation:

	
Section 1.4.3.1, "Introduction to Fault Recovery" for conceptual details about faults


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite












Part XII


Administering Oracle B2B

This part describes how to administer Oracle B2B.

This part includes the following chapters:

	
Chapter 31, "Configuring Oracle B2B"


	
Chapter 32, "Monitoring Oracle B2B"










19 Monitoring Decision Service Components and Engines

This chapter describes how to monitor decision service components, including service engine instances, faults, statistics, and deployed composites; deployed decision service component instances; business rule tracing; and log files. Decision service components are also called business rules service components in the Oracle Fusion Middleware documentation.

This chapter includes the following topics:

	
Section 19.1, "Monitoring Business Rules Service Engine Recent Instances and Faults"


	
Section 19.2, "Monitoring Business Rules Service Engine Statistics"


	
Section 19.3, "Monitoring Business Rules Service Engine Instances"


	
Section 19.4, "Monitoring Business Rules Service Engine Faults"


	
Section 19.5, "Monitoring Business Rules Service Engine Deployed Components"


	
Section 19.6, "Monitoring Decision Service Component Instances of a Composite Application"


	
Section 19.7, "Monitoring Business Rule Tracing"


	
Section 19.8, "Monitoring Decision Service Component Logs"







	
Note:

The business rules service engine does not support any user level configuration.











19.1 Monitoring Business Rules Service Engine Recent Instances and Faults

Using the business rules service engine home page Dashboard page, you can monitor recent instances and faults of decision service components running in the SOA Infrastructure. These decision service components can be part of separate SOA composite applications. Decision service components are also called business rules components in the Oracle Fusion Middleware documentation.

To monitor business rules service engine instances and faults:

	
Access the business rules service engine home page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > Business Rules.




	
	
Select soa-infra.


	
Right-click and select Service Engines > Business Rules.











	
Click Dashboard.

The Recent Instances section of the Dashboard page displays recent instances of all decision service components, including the instance ID of the decision service component, the decision service component name, the SOA composite application of which the decision service component is a part, the state of the instance (for example, completed successfully or faulted, the instance start time, the last modification time, and a Logs icon (clicking the Logs icon shows the Log Messages page with filtered messages specific to that instance)).




	
Note:

To see the state with the correct information, you must set the Capture Composite Instance State property. You can change this setting on the SOA Administration Common Properties page. Turning this feature on allows for separate tracking for running instances. However, this may impact performance. For information on setting this property, see Section 3.1, "Configuring SOA Infrastructure Properties."
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In the Instance ID column, click an instance ID for a decision service component to view its audit trail.




	
Note:

The contents of the audit trail page depends on the Audit Level settings. When the Audit Level property is set to Production, the audit trail shows only the activity names. When the Audit Level is set to Development mode, the audit trail shows the decision service instance payload details. In other modes, for example Off, the audit trail does not show decision service details. You can change the Audit Level on the SOA Infrastructure Common Properties page. Additionally, this option can be set for a specific composite from the home page for the composite.










	
In the Component column, click a specific decision service component to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.


	
Click Show All to access the Instances page of the service engine.




The lower section of the Dashboard page displays the following:

	
The Components section shows the decision service components deployed on the business rules service engine across SOA composites. It also shows the status of the SOA composites and the instance count information in the respective instance state columns.


	
The Recent Faults section lists the recent faults in the service engine, including the error message, the time at which the fault occurred, the SOA composite application in which the fault occurred, the decision service component, the instance ID of the decision service component, and a Logs icon (clicking the Logs icon shows the Log Messages page with filtered messages specific to that instance).




For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






19.2 Monitoring Business Rules Service Engine Statistics

Using the business rules service engine Statistics page, you can monitor business rules service engine performance and metrics. This page shows service engine-level, not component-level, details. Business rules service components are also called decision service components in the Oracle Fusion Middleware documentation.

To monitor business rules service engine statistics:

	
Access the business rules service engine statistics page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
Select Service Engines > Business Rules.

	
	
Select soa-infra.


	
Right-click and select Service Engines > Business Rules.











	
Click Statistics.

The Statistics page displays the following:

	
Average Request Processing Time: This chart displays the average request processing time of the business rules service engine since server startup. That is, how many requests were processed by the service engine per unit of time.


	
Business Rules Cache Statistics: This section provides details about the service engine cache. This section lists the types of caches used by the service engine and the object count in each of the caches. All these metrics are based on the object count since server startup.


	
Business Rules Operation Statistics: This section shows the operation statistics. Using the operation statistics, you can determine the number of calls to Oracle Business Rules decision functions since server startup, and determine the total time spent in Decision Functions since server startup.




	
Note:

When you view business rules operation statistics for composite applications created with Oracle Fusion Middleware 11g Release 1 (11.1.1), the only operation shown is the callFunction operation. In this release, the decision service only calls Oracle Business Rules using decision functions, and this operation is indicated with values for the operation named callFunction (with Count and Average(ms) fields). With composite applications that were migrated from older releases, the decision service performs callFunction operations and the other operations listed in the Business Rules Operation Statistics section. For these migrated projects, you can debug the flow of the request through various important operations within the service engine. Also, you can find any long-running operations and take the necessary actions. These metrics also are since server startup.
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19.3 Monitoring Business Rules Service Engine Instances

Using the business rules service engine Instances page, you can monitor all decision service component instances. These decision service components can be part of separate SOA composite applications. Decision service components are also called business rules service components in the Oracle Fusion Middleware documentation.

To monitor business rule service engine instances:

	
Access the business rules service engine Instances page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
Select Service Engines > Business Rules.

	
	
Select soa-infra.


	
Right-click and select Service Engines > Business Rules.











	
Click Instances.

The Instances page displays the following:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
A list of instances, including the instance ID of the decision service component, the decision service component name, the SOA composite application name, the state of the instance (for example, completed successfully, running, or faulted), the instance start time, the last modification time, and a Logs icon (clicking the Logs icon shows the instance log messages).
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In the Instance ID column, click an instance ID for a decision service component to view its audit trail details.




	
Note:

The contents of the audit trail page depends on the Audit Level settings. When the Audit Level property is set to Production, the audit trail shows only the activity names. When the Audit Level is set to Development mode, the audit trail shows the decision service instance payload details. You can change the Audit Level on the SOA Infrastructure Common Properties page. Additionally, this option can be set for a specific composite from the home page for the composite.










	
In the Component column, click a specific decision service component to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.




For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






19.4 Monitoring Business Rules Service Engine Faults

Using the business rules service engine Faults page, you can monitor all decision service component faults. The Faults page shows this information for decision service components that can be part of separate SOA composite applications. Decision service components are also called business rules components in the Oracle Fusion Middleware documentation.

To monitor business rules service engine faults:




	
Note:

Decision service component faults are always nonrecoverable.









	
Access the business rules service engine Faults page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
Select Service Engines > Business Rules.

	
	
Right-click soa-infra.


	
Select Service Engines > Business Rules.











	
Click Faults.

The Faults page displays the following:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
A list of faults that occurred in the decision service component, including the error message, the time at which the fault occurred, the SOA composite application and decision service component in which the fault occurred, the decision service component instance ID, and a Logs icon (clicking the Logs icon shows the instance log messages).




Decision service component instance faults cannot be recovered.
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You can perform the following monitoring tasks from within the Faults page:

	
From the Fault Type list, select to display all Faults, system faults, business faults, or Oracle Web Services Manager faults in the Faults page.


	
From the View list, select Columns > Fault ID to display the fault IDs for each fault. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Component column, click a specific decision service component to access its home page.


	
In the Component Instance ID column, click a specific decision service component instance ID to view the audit trail.




	
Note:

The contents of the audit trail page depend on the Audit Level settings. When the Audit Level property is set to Production, the audit trail shows only the activity names. When the Audit Level is set to Development mode, the audit trail shows the decision service instance payload details. You can change the Audit Level on the SOA Infrastructure Common Properties page. Additionally, this option can be set for a specific composite from the home page for the composite.










	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to the instance. Clicking the Log link shows the faults and error messages related to that faulted instance.





	
In the Error Message column, click to view the fault details.




For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






19.5 Monitoring Business Rules Service Engine Deployed Components

Using the business rules service engine home page Deployed Components page, you can monitor all decision service components deployed across SOA composite applications. Decision service components are also called business rules components in the Oracle Fusion Middleware documentation.

To monitor business rule service engine deployed components:

	
Access the business rules service engine Deployed Components page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
Select Service Engines > Business Rules.

	
	
Right-click soa-infra.


	
Select Service Engines > Business Rules.











	
Click Deployed Components.

The Deployed Components page displays the following:

	
A utility for searching for a specific component by specifying criteria and clicking Search.


	
A list of components, including the name, the SOA composite application name, the status (up or down), and the instances count (total, running, and faulted).
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In the Name column, click a name to navigate to the Component home page and view component details.


	
In the Composite column, click a specific SOA composite application to access its home page.




For more information, see Section 1.2.4, "Introduction to Service Components and Service Component Instances."






19.6 Monitoring Decision Service Component Instances of a Composite Application

You can monitor decision service component instances of a composite application. Each decision service component instance has its own unique instance ID. This ID is in addition to the instance ID of the overall SOA composite application of which this decision service component is a part. Decision service components are also called business rules components in the Oracle Fusion Middleware documentation.




	
Note:

To see the state with the correct information, you must set the Capture Composite Instance State option. You can change this setting on the SOA Infrastructure Common Properties page. Turning this feature on allows for separate tracking for running instances. However, this may impact performance. For information on setting the option, see Section 3.1, "Configuring SOA Infrastructure Properties."









To monitor decision service component instances from a composite application:

	
Access a decision service component from a composite application through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
In the navigator, select soa-infra.


	
From the SOA Infrastructure menu, Select Home.


	
Click Deployed Composites tab.


	
In the Composite table, select a specific SOA composite application that includes a decision service component.




	
	
Expand soa-infra.


	
Select a specific SOA composite application that includes a decision service component.
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The Component Metrics section on the composite dashboard provides a high-level overview of each decision service component. This table includes columns showing the Component Type, the Total Instances, the Running Instances, and the Faulted Instances (recoverable and nonrecoverable).


	
Select a decision service component in the Component Metrics section to display the corresponding decision service component page.
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For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances."






19.7 Monitoring Business Rule Tracing

You can use Oracle Enterprise Manager Fusion Middleware Control to perform rule execution tracing. For more information about accessing and using Fusion Middleware Control, see Chapter 2, "Getting Started with Administering Oracle SOA Suite and Oracle BPM Suite."

A rule execution trace is a mechanism of tracing business rules service engine events that occur during the evaluation of rules. The types of events traced are:

	
Fact operations (assert, retract, and modify)


	
Rules execution


	
Rule activation


	
Ruleset stack changes


	
Rule compilation


	
Reset (required for maintaining state during analysis)




Each trace contains information about the event that it traces. For example, a rule trace entry for an executed rule consists of:

	
Rule name (RL name)


	
Execution sequence number


	
List of fact IDs for the facts that matched this rule


	
Timestamp in milliseconds




Rule execution trace audit levels are the same as the audit levels supported in the SOA Infrastructure:

	
Off: Rule execution tracing is disabled. The decision component instance is not created at all.


	
Development: Full rule execution tracing that contains all the details about facts (listing, operations such as modify and assert), rule activation, pop or push rulesets, and so on. It also provides a list of fact IDs on which the executed rules are matched. See Section 19.7.1, "Tracing Rule Execution at the Development Audit Level" for an example.


	
Production: The executed rules are traced. All the details about facts, rule activation, pop or push ruleset are not available. The trace do not contain a list of the matching facts IDs. See Section 19.7.2, "Tracing Rule Execution at the Production Audit Level" for an example.




You can set audit levels either at the SOA Infrastructure level or at the composite level. See Section 3.1, "Configuring SOA Infrastructure Properties" for SOA Infrastructure audit level configuration information. See Section 1.4.1.1, "Introduction to the Order of Precedence for Audit Level Settings" for a discussion about audit level precedence when set at the SOA Infrastructure level and the composite level. The following sections discuss setting audit levels at the composite level for the purposes of rule execution tracing.



19.7.1 Tracing Rule Execution at the Development Audit Level

Setting the audit level to Development enables you to view all the details pertaining to a rule that has been executed.

To perform a development-level rule execution trace:

	
Open the composite application in Oracle Enterprise Manager Fusion Middleware Control.

A list of the recent composite instances is shown on the composite Dashboard page.


	
Click the Settings list, select Composite Audit Level, > Development to set the trace level as Development at the composite level.

[image: Description of em_audit_level3.gif follows]

Description of the illustration em_audit_level3.gif



	
Click Yes in the Confirmation dialog.

[image: Description of em_confirm.gif follows]

Description of the illustration em_confirm.gif



	
Click Test and then client to invoke a test instance of the composite to view the decision traces corresponding to different input parameters, such as the Order ID.

[image: Description of em_test.gif follows]

Description of the illustration em_test.gif



	
Enter an Order ID, for example 1001, in the Value field in the Input Arguments section on the Test Web Service page and click the Test Web Service button.

[image: Description of em_test_input.gif follows]

Description of the illustration em_test_input.gif



Based on the input Order ID, the service invokes a BPEL process instance containing the details of the Order ID, and the rule that is relevant to the order details is executed.


	
Click Launch Message Flow Trace under the Response tab to open the Flow Trace page.

[image: Description of em_test_msg_flow_trace.gif follows]

Description of the illustration em_test_msg_flow_trace.gif



	
Click the decision service component instance called DiscountDictionary in the Trace section to view the actual rule execution trace.

[image: Description of em_test_trace_dec_comp.gif follows]

Description of the illustration em_test_trace_dec_comp.gif






	
Note:

You can also view the values of composite variables before and after invocation of business rule component. You must click the BPEL process component instance in the Flow Trace page, and then click the relevant payload. In this case, the BPEL component name is FODOrderProcessingProcess.









The following graphic shows the execution trace for the decision service component called DiscountDictionary.

[image: Description of em_test_trace_dev.gif follows]

Description of the illustration em_test_trace_dev.gif



	
Click the Show rule set stack states in audit trail checkbox to view further details of the rule execution.

[image: Description of em_test_trace_dev_show_rule.gif follows]

Description of the illustration em_test_trace_dev_show_rule.gif



The development-level trace report displays the fact name, activated rule, and the pushed and popped ruleset names.

The following table lists the entries of the trace report:


	Element	Description
	
Invoked Decision Service Name

	
Displays the name of the decision service component that is invoked.


	
Asserted Fact

	
Displays the name of the fact that is passed by the BPEL service to the decision service component. This is based on the input parameter provided by the user, which according to the example is the Order ID 1001.


	
Activated Rule

	
Displays the name of the rule that is activated, along with the name of the fact that activated the rule.


	
Pushed ruleset

	
Displays the name of the ruleset that has been invoked when the fact is asserted.


	
Fired rules in Ruleset

	
Displays the name of the ruleset whose rule is executed.


	
Fired rule

	
Displays the name of the rule that is executed.


	
Modified fact

	
Displays the name of the fact that has been modified because of the rule execution. This modified fact is then passed by the decision service component to the BPEL service.


	
Popped ruleset

	
Displays the name of the ruleset for which execution is complete and so, the ruleset is taken out of the execution queue.











	
Notes:

The entry Invoked Decision Service Name appears differently in different scenarios:

	
For AS10.1.3.x to AS11 upgraded rules dictionaries with AssertExecuteWatch patterns, the entry appears in the trace report as Invoked Decision Service.


	
For AS10.1.3.x to AS11 upgraded rules dictionaries with CallFunction patterns, the entry appears in the trace report as Invoked Decision Function.


	
For AS11 created dictionaries, the entry is displayed as Invoked Decision Function.




















19.7.2 Tracing Rule Execution at the Production Audit Level

Setting the audit level to Production provides a truncated report on the rule execution trace. It only displays the ruleset and the rules that have been fired and does not display details about facts, rule activation, and so on.

The process of production-level tracing is similar to the development-level tracing. However, for Production-level tracing, you must do the following:

In Fusion Middleware Control, after opening the composite, select Production from the Composite Audit Level of the Settings menu.

The following graphic shows the Flow Trace page that displays the trace report.

[image: Description of em_test_trace_prod.gif follows]

Description of the illustration em_test_trace_prod.gif



The Production-level trace report contains only the name of the ruleset and the rules that were fired. In addition, the Show rule set stack states in audit trail checkbox that provides a drill-down detailed trace report is unavailable in the Production-level trace report.








19.8 Monitoring Decision Service Component Logs

You can monitor decision service component logs. Decision service components are also called business rules service components in the Oracle Fusion Middleware documentation.



19.8.1 Viewing Decision Service Component Logs

To view decision service component logs:

	
In the navigation tree, select and right-click soa-infra.


	
Select Logs > View Log Messages. This displays the Log Messages page.

[image: Description of rules1_logs1.gif follows]

Description of the illustration rules1_logs1.gif



The Log Messages page opens. Use this page to select target log files.

[image: Description of rules1_logs2.gif follows]

Description of the illustration rules1_logs2.gif



	
To access a prefiltered list of log files for each instance or fault, click in the Logs column from any specific page (for example, in the decision service engine or component's faults or instances tables).

For example, from the Faults table, click the Logs column.

[image: Description of rules1_engine_faults.gif follows]

Description of the illustration rules1_engine_faults.gif










19.8.2 Setting the Diagnostic Logging Level with a Log Configuration

Use the Log Configuration page to configure the logging level.

To set the diagnostic logging level with a log configuration:

	
Right-click soa-infra, and select Logs > Log Configuration.

[image: Description of rules1_logs3.gif follows]

Description of the illustration rules1_logs3.gif



	
To configure the decision service component logging level, expand the oracle.soa.service.rules and the oracle.soa.services.rules.obrtrace loggers and set the notification level.

[image: Description of rules1_logs4.gif follows]
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37 Configuring Oracle BPMN Process Service Components and Engines

This chapter describes for administrators how to configure the BPMN process service engine, including configuring properties used by the engine during processing of BPMN service components.

This chapter includes the following topics:

	
Section 37.1, "Configuring BPMN Process Service Engine Properties"


	
Section 37.2, "Integrating Oracle BPM with Oracle Business Activity Monitoring"






37.1 Configuring BPMN Process Service Engine Properties

To configure BPMN process service engine properties:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select SOA Administration > BPMN Properties.




	
	
Right-click soa-infra.


	
Select SOA Administration > BPMN Properties.











The BPMN Service Engine Properties page displays properties for setting audit trail and large document thresholds, setting dispatcher thread properties, validating payload schema, and setting the audit trail level.

[image: Description of soaadmin_bpmn_props.gif follows]

Description of the illustration soaadmin_bpmn_props.gif



	
Make changes to the service engine properties that are appropriate to your environment.


	Property	Description
	
Audit Level

	
Select one of the following options:

	
Off: No logging is performed. Composite instance tracking and payload tracking information are not collected. If measurement is enabled, then this level is overridden to Minimal.


	
Inherit (default): Logging equals the SOA Infrastructure audit level. This allows the BPMN audit level to automatically change when the global setting is changed. Setting a different audit level tracking in this page overrides the tracking set at the SOA Infrastructure level.


	
Minimal: Instance tracking information is collected, but not payload details; no payload details are available in the flow audit trails.


	
Production: Instance tracking information is collected, payload details are collected only for out data associations for asynchronous activities. This level is optimal for most normal operations and testing.


	
Development: Allows both the composite instance tracking and payload tracking. However it may impact the performance. This level is useful mostly for debugging purposes.




Note: If you do not want audit entries to be displayed, then you must turn off both the audit level and the metrics. If metrics are enabled, then audit entries are displayed even if the audit level is set to Off.


	
Audit Trail Threshold

	
Enter the maximum size in bytes of an instance audit trail before it is chunked and saved in a dehydration store table separate from the audit trail. If the threshold is exceeded, the View XML link is shown in the audit trail instead of the payload.


	
Large Document Threshold

	
Enter the maximum size of a generated document within a BPMN process component instance before it is stored in a separate table in the dehydration store.


	
Dispatcher System Threads

	
Specify the total number of threads allocated to process system dispatcher messages. System dispatcher messages are general clean-up tasks that are typically processed quickly by the server (for example, releasing stateful message beans back to the pool). Typically, only a small number of threads are required to handle the number of system dispatch messages generated during runtime.

The default value is 2 threads. Any value less than 1 thread is changed to the default.


	
Dispatcher Invoke Threads

	
Specify the total number of threads allocated to process invocation dispatcher messages. Invocation dispatcher messages are generated for each payload received and are meant to instantiate a new instance. If the majority of requests processed by the service engine are instance invocations (as opposed to instance callbacks), greater performance may be achieved by increasing the number of invocation threads. Higher thread counts may cause greater CPU utilization due to higher context switching costs.

The default value is 20 threads. Any value less than 1 thread is changed to the default.


	
Dispatcher Engine Threads

	
Specify the total number of threads allocated to process service engine dispatcher messages. Service engine dispatcher messages are generated whenever an activity must be processed asynchronously. If the majority of processes deployed are durable with a large number of dehydration points (midprocess receive, onMessage, onAlarm, and wait activities), greater performance may be achieved by increasing the number of service engine threads. Higher thread counts can cause greater CPU utilization due to higher context switching costs.

The default value is 30 threads. Any value less than 1 thread is changed to the default.


	
Payload Validation

	
Select to enable validation of inbound and outbound messages. Nonschema-compliant payload data is intercepted and displayed as a fault.

Note: This setting is independent of the SOA composite application and SOA Infrastructure payload validation level settings. If payload validation is enabled at both the service engine and SOA Infrastructure levels, data is checked twice: once when it enters the SOA Infrastructure, and again when it enters the service engine.


	
Disable BPMN Monitors and Sensors

	
Select this checkbox to disable all BPMN monitors and sensors defined for all BPMN components across all deployed SOA composite applications.








	
Click Apply.


	
If you want to configure advanced BPMN properties in the System MBean Browser, click More BPMN Configuration Properties. Properties that display include the following. Descriptions are provided for each property.

	
AuditDetailThreshold: The maximum size (in bytes) an audit trail details string can be before it is stored separately from the audit trail.


	
AuditLevel: Controls the amount of audit events logged by a process; currently supported logging levels are: off: absolutely no logging performed whatsoever; may result in a slight performance boost for processing instances.


	
BpelcClasspath: The extra class path must be included when compiling BPMN generated java sources.


	
ConfigMBean: If true, it indicates that this MBean is a Config MBean.


	
CubeInstanceExpiration: The expiration time in hours of performance data. This parameter is disabled by default. You can enable it.


	
CubeTimerMaxErrorCount: Maximum allowed number of consecutive errors during cube timer processing. Once number of errors reaches CubeTimerMaxErrorCount, the cube timer skips processing.


	
CubeTimerMaxSkipOnErrorCount: Specifies the number of times the timer skips processing once the number of errors reaches CubeTimerMaxErrorCount.




	
Note:

Once the cube timer errors out consecutively for CubeTimerMaxErrorCout times, the cube timer skips the timeout processing for CubeTimerMaxSkipOnErrorCount times. It then resumes the normal timeout processing. The time for which the cube timer skips processing can be calculated as CubeTimerMaxErrorCount * CubeUpdateFrequency.

If the lockout time must be less, you must either reduce the time to a lesser value or change the number of times to skip timeout processing.










	
CubeUpdateFrequency: Frequency in seconds at which cube action calculates the workload.


	
CubeWorkloadExpiration: The expiration time for workload records. It is set to 48 hours by default, which means that if a workload record's age is more than 48 hours, it is purged.


	
DisableActions: Comma-delimited list of disabled measurement actions (such as CubeCommand, BAMCommand). Also see PublishMaxTrackBackCount.


	
DisableProcessTracking: If set to true, the audit disables process tracking. The default value is false.


	
DisableSensors: If set to true, the service engine disables all calls to sensors. The default value is false.


	
DispatcherEngineThreads: The total number of threads that are allocated to process engine dispatcher messages.


	
DispatcherInvokeThreads: The total number of threads that are allocated to process invocation dispatcher messages.


	
DispatcherMaxRequestDepth: Maximum number of internal messages the service engine processes. If this number is exceeded, new messages are not dispatched. The default value is 600.


	
DispatcherSystemThreads: The total number of threads that are allocated to process system dispatcher messages.


	
eventProvider: If set to true, indicates that this MBean is an event provider as defined by JSR-77.


	
eventTypes: All the event's types emitted by this MBean.


	
ExpirationMaxRetry: The maximum number of times a failed expiration call (wait/onAlarm) is retried before failing.


	
ExpirationRetryDelay: The delay between the expiration retries. The default value is 120 seconds.


	
InstanceKeyBlockSize: The size of the block of instance IDs to allocate from the dehydration store during each fetch.


	
LargeDocumentThreshold: The maximum size (in bytes) a BPMN variable can be before it is stored in a separate location from the rest of the instance scope data.


	
MaximumNumberOfInvokeMessagesInCache: Specify the number of invoke messages that can be kept in the in-memory cache, once the service engine reaches this limit, it pushes the message to dispatcher in-memory cache, instead it saves the message in the database, and these saved messages can be recovered using recovery job. Use value -1 to disable this property.


	
objectName: The MBean's unique JMX name.


	
OneWayDeliveryPolicy: Changes whether the one-way invocation messages are delivered.


	
PeopleQueryTimeout: Specify quartz cron expression People Query. People Query in Logical People Group is reevaluated based on this cron expression.


	
PublishMaxTrackBackCount: Maximum number of records traversed from last audit record, checked for measurement and action enabled and published if so.


	
QualityOfService: Flag to enable or disable Oracle Coherence cache for BPMN service engine. Use CacheEnabled for enabling Oracle Coherence.


	
ReadOnly: If set to true, indicates that this MBean is a read only MBean.


	
RestartNeeded: Indicates whether a restart is needed.


	
StatsLastN: The size of the most recently processed request list.


	
SystemMBean: If set to true, indicates that this MBean is a System MBean.


	
ValidateXML: If set to true, the service engine applies schema validation for incoming and outgoing XML documents. The default value false.


	
Version: Version of the configuration file.


	
WFOracleUcmUrl: Specify a URL for Oracle WebCenter Content repository administration server.












37.2 Integrating Oracle BPM with Oracle Business Activity Monitoring

When a BPMN composite application is deployed, the following Oracle BAM data objects are generated automatically:

	
Data object for the following business indicator:

TEMPLATE_BI_Partition_Composite_Process

Once this is imported, you should rename it to:

BI_DEFAULT_Compositename_ProcessName

This is created in the target folder. If the data object already exists, new columns are added to it, assuming the old columns match data types. Otherwise, an error is thrown.


	
COMPONENT, INTERVAL, COUNTER data objects if they are not present in the target folder.




The target Oracle BAM Server is specified by JNDI name parameter.




	
Note:

Data objects can be created only automatically at deployment. You cannot create them manually.









To configure Oracle BPM for use with Oracle Business Activity Monitoring, you perform these tasks:

	
Task 1: Configure the Oracle BAM Adapter on Oracle BPM Server


	
Task 2: Enable Oracle BAM on the Oracle BPM Server






37.2.1 Task 1: Configure the Oracle BAM Adapter on Oracle BPM Server

You must configure the Oracle BAM Adapter to use either SOAP or RMI for communicating with Oracle BAM.


To configure the Oracle BAM adapter on Oracle BPM server:

	
In the Oracle WebLogic Server Administration Console, under Domain Structure, click Deployments.


	
Click OracleBAMAdapter > Configuration > Outbound Connection Pools.


	
Expand oracle.bam.adapter.adc.soap.SOAPConnectionFactory.


	
Click either eis/bam/soap or eis/bam/rmi.

The JNDI name used to configure the Oracle BAM adapter is used. For example, if you configured the Oracle BAM adapter to use SOAP, then the default JNDI name is eis/bam/soap. Similarly, if you configure the Oracle BAM adapter to use RMI, then the default JNDI name is eis/bam/rmi.


	
Modify properties to match Oracle BAM Server. (Remember to press Enter after text entry).


	
Click Save.


	
Select the location for the deployment plan—for example, bam/Plan.xml, then complete the dialogs.


	
Return to Deployments.


	
Select OracleBAMAdapter.


	
Click Update and complete the dialogs.




For more information about integrating Oracle Business Activity Monitoring with Oracle SOA Suite composite applications, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.






37.2.2 Task 2: Enable Oracle BAM on the Oracle BPM Server

To do this task, you use the Oracle Enterprise Manager Fusion Middleware Control.


To enable Oracle BAM on the Oracle BPM server:

	
In Oracle Fusion Middleware Control, under WebLogic Domain, select your domain and server.


	
Go to System MBean Browser.


	
Select oracle.as.soainfra.config > Server > BPMNConfig > bpmn.


	
Go to Disable Actions. If you find BAMAction there, then clear the field.


	
Click Apply.














23 Configuring Oracle Business Activity Monitoring

This chapter describes how to configure basic properties of Oracle Business Activity Monitoring (Oracle BAM) Server components and Oracle BAM web applications using Oracle Enterprise Manager Fusion Middleware Control, advanced properties using System MBean Browser, and Oracle BAM Adapter properties and connection factories using Oracle WebLogic Server Administration Console. It also explains how to configure logging and log levels, security, distribution lists for alerts and reports, and Oracle User Messaging Service to send email notifications to Oracle BAM users.

This chapter includes the following topics:

	
Section 23.1, "Introduction to Configuring Oracle BAM"


	
Section 23.2, "Configuring Oracle BAM Web Basic Properties"


	
Section 23.3, "Configuring Oracle BAM Server Basic Properties"


	
Section 23.4, "Configuring the Logger"


	
Section 23.5, "Configuring Oracle User Messaging Service"


	
Section 23.6, "Configuring Oracle BAM Distribution Lists"


	
Section 23.7, "Configuring Oracle BAM Adapter"


	
Section 23.8, "Configuring Oracle BAM Batching Properties"


	
Section 23.9, "Configuring Security"


	
Section 23.10, "Configuring Advanced Properties"


	
Section 23.11, "Oracle BAM Configuration Property Reference"






23.1 Introduction to Configuring Oracle BAM

Oracle BAM Server is the collection of the components Oracle BAM Active Data Cache (Oracle BAM ADC), Oracle BAM Report Cache, Oracle BAM Enterprise Message Sources (EMS), and Oracle BAM Event Engine.

The Oracle BAM web applications are a collection of thin clients (Active Studio, Architect, Administrator, and Active Viewer) and Oracle BAM Report Server.

For more information about each of the subcomponents of Oracle BAM Server and Oracle BAM web applications, see the Oracle Fusion Middleware User's Guide for Oracle Business Activity Monitoring.

At runtime, the Oracle BAM application checks the configuration property values. If they are set to DEFAULT, Oracle BAM dynamically determines the values of all the parameters by querying the JRF API, that in turn queries the MBean Server. This feature enables you to set up Oracle BAM on any port number and work out of the box without any configuration changes. By default all of the parameters are set to DEFAULT.

If the administrator provides the configuration values during initial postinstallation configuration then Oracle BAM honors them as the values going forward. If for some reason the parameters are not present, Oracle BAM first looks for host and port details in JRF. If Oracle BAM is not able to access JRF, hard-coded default values are provided from the code.

The most commonly used Oracle BAM Server and web applications properties are configured in Oracle Enterprise Manager Fusion Middleware Control. For more information, see Section 23.3, "Configuring Oracle BAM Server Basic Properties" and Section 23.2, "Configuring Oracle BAM Web Basic Properties".

Security configuration is discussed in Section 23.9, "Configuring Security", and adding and managing Oracle BAM roles (permissions) and user accounts is discussed in Section 25.3, "Managing Oracle BAM Users."

Oracle User Messaging Service (UMS) must be configured so that alerts are delivered to Oracle BAM users. For more information, see Section 23.5, "Configuring Oracle User Messaging Service".

When using Oracle BAM in a SOA composite application, the Oracle BAM Adapter configuration must be completed. For more information, see Section 23.7, "Configuring Oracle BAM Adapter".

Advanced properties are located in configuration files that must be edited using the System MBean Browser. For more information, see Section 23.10, "Configuring Advanced Properties". Also, see Section 23.11, "Oracle BAM Configuration Property Reference" for a listing of all properties available for Oracle BAM configuration.

Oracle BAM distribution lists are used to send alerts and reports to multiple Oracle BAM users, rather than having to specify several individual recipients. Distribution lists are configured in the Oracle BAM Administrator application. For more information, see Section 23.6, "Configuring Oracle BAM Distribution Lists".

For performance tuning information for Oracle BAM, see the Oracle Fusion Middleware Performance and Tuning Guide.

For Oracle BAM high availability configuration information, see the Oracle Fusion Middleware High Availability Guide.






23.2 Configuring Oracle BAM Web Basic Properties

Some basic Oracle BAM web applications properties are configured using Oracle Enterprise Manager Fusion Middleware Control.

Oracle BAM web applications must be restarted when changes are made to any Oracle BAM properties. For information about restarting Oracle BAM, see Section 25.2, "Managing Oracle BAM Availability".

The following topics describe how to configure each property:

	
Section 23.2.1, "Configuring Oracle BAM Web Applications Properties"


	
Section 23.2.2, "Configuring the Application URL"


	
Section 23.2.3, "Configuring the Report Loading Indicator"


	
Section 23.2.4, "Configuring the Server Name"




For information about configuring advanced properties, see Section 23.10, "Configuring Advanced Properties" and Section 23.11, "Oracle BAM Configuration Property Reference."



23.2.1 Configuring Oracle BAM Web Applications Properties

The Oracle BAM web applications properties are configured in the BAM Web Properties page in Fusion Middleware Control.

To configure Oracle BAM web applications properties:

	
Go to the BAM Web Properties page in Fusion Middleware Control by selecting the OracleBamWeb node in the BAM folder.

[image: Description of bam_em_nav.gif follows]
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Choose BAM Web Properties from the BAM Web menu.

[image: Description of bam_config_web_menu.gif follows]

Description of the illustration bam_config_web_menu.gif



The BAM Web Properties page opens.

[image: Description of bam_config_web.gif follows]
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Enter the appropriate values in each of the fields provided.

See the following sections for information about configuring each of the properties:

	
Section 23.2.2, "Configuring the Application URL"


	
Section 23.2.3, "Configuring the Report Loading Indicator"


	
Section 23.2.4, "Configuring the Server Name"





	
Click Apply.

You must restart Oracle BAM after any property changes.









23.2.2 Configuring the Application URL

The Application URL property value must be updated from localhost to the actual hostname to generate the correct URLs for reports and alerts.

The Application URL property is configured in both the Oracle BAM web applications properties page and the Oracle BAM Server properties page. In Oracle BAM web applications page, the URL is used to generate the full URL for reports and alerts.

This property is common to both Oracle BAM web applications and Oracle BAM Server. If it is configured on one page, the same value appears on the other configuration page.






23.2.3 Configuring the Report Loading Indicator

The Report Loading Indicator property specifies whether the report loading indicator is enabled or disabled by default when viewing reports in Oracle BAM Active Studio and Oracle BAM Active Viewer.

With this property enabled, the report loading indicator is shown by default when a report is viewed; however, individual users can choose to disable the report loading indicator in their user preferences configuration. For more information, see the Oracle Fusion Middleware User's Guide for Oracle Business Activity Monitoring.






23.2.4 Configuring the Server Name

The Server Name property provides the hostname of Oracle BAM Server. Oracle BAM web applications are separate applications that require the location of Oracle BAM Server to get data from the Active Data Cache and Report Cache for the Oracle BAM Report Server.








23.3 Configuring Oracle BAM Server Basic Properties

Some basic Oracle BAM Server properties are configured using Oracle Enterprise Manager Fusion Middleware Control.

Oracle BAM Server must be restarted after any changes to Oracle BAM properties. For information about restarting Oracle BAM, see Section 25.2, "Managing Oracle BAM Availability".

The following topics describe how to configure each property:

	
Section 23.3.1, "Configuring Oracle BAM Server Properties"


	
Section 23.3.2, "Configuring the Data Source JNDI"


	
Section 23.3.3, "Configuring the Application URL"


	
Section 23.3.4, "Configuring Viewset Sharing"


	
Section 23.3.5, "Configuring the Report Cache Persistence Manager"


	
Section 23.3.6, "Configuring Oracle Data Integrator Integration Properties"


	
Section 23.3.7, "Configuring the Outbound Email Account"




For information about configuring advanced properties, see Section 23.10, "Configuring Advanced Properties" and Section 23.11, "Oracle BAM Configuration Property Reference."



23.3.1 Configuring Oracle BAM Server Properties

Oracle BAM Server properties are configured in the BAM Server Properties page in Oracle Enterprise Manager Fusion Middleware Control.

To configure Oracle BAM Server properties:

	
Go to the BAM Server Properties page by selecting the OracleBamServer node in Fusion Middleware Control BAM folder.

[image: Description of bam_em_nav_server.gif follows]
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Choose BAM Server Properties from the BAM Server menu.

[image: Description of bam_config_server_menu.gif follows]
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The BAM Server Properties page opens.

[image: Description of bam_config_server.gif follows]
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Enter the appropriate values in each of the fields provided.

See the following sections for information about configuring each of the properties:

	
Section 23.3.2, "Configuring the Data Source JNDI"


	
Section 23.3.3, "Configuring the Application URL"


	
Section 23.3.4, "Configuring Viewset Sharing"


	
Section 23.3.5, "Configuring the Report Cache Persistence Manager"


	
Section 23.3.6, "Configuring Oracle Data Integrator Integration Properties"


	
Section 23.3.7, "Configuring the Outbound Email Account"





	
Click Apply.

You must restart the Oracle BAM application after any property changes.









23.3.2 Configuring the Data Source JNDI

The Data Source JNDI property specifies the database used by Oracle BAM ADC. Enter the data source JNDI name created for Oracle BAM ADC. For general information about configuring data sources see Oracle Fusion Middleware Configuring and Managing JDBC Data Sources for Oracle WebLogic Server






23.3.3 Configuring the Application URL

The Application URL property is used only by Oracle BAM web applications. This configuration property is no longer used by Oracle BAM Server. For information about configuring this property for Oracle BAM web applications, see Section 23.2.2, "Configuring the Application URL".






23.3.4 Configuring Viewset Sharing

The Viewset Sharing property enables view set sharing when possible. A view set is an object that represents a query to a given Oracle BAM data object. A view set can include fields (which can be columns from the data object or lookups from other data objects), aggregates, groups, or calculated fields. A view set can also be sorted, filtered, and row-level security is applied implicitly to it.

Typically, a particular view set can be shared with other users if they are trying to access the same Oracle BAM dashboard, if the view sets are not dissimilar due to factors such as row-level security, prompts or parameters used in filters, and so on.

A snapshot is a query result set that can be created by the view set. Snapshots can be produced from a view set after it is opened. Because snapshot generation is so performance-intensive, view set sharing allows Oracle BAM Server to take only one snapshot of a given view to share across multiple users of the same dashboard.

Sharing view sets between users of the same views improves performance, but requires that new users wait for view sets to be synchronized as each new user begins sharing the view set.

The first user who opens an Oracle BAM dashboard receives a new snapshot (which is cached) and immediately receives active data in real time. Changes for active data, called change lists, are cached.

When additional users open the same dashboard, they receive the cached snapshot that was generated for the first user, and they receive cached change lists (more rapidly than the first user) while the Synchronizing Active Data message is displayed.

By default, up to 50 change lists are cached, so if multiple users open a dashboard, secondary users must wait for up to 50 change lists to be sent to the dashboard before they begin receiving real-time active data.

The ElementsCountLimit property can be set to allow fewer change lists to be cached. For information about configuring advanced properties, see Section 23.11, "Oracle BAM Configuration Property Reference".






23.3.5 Configuring the Report Cache Persistence Manager

The Report Cache Persistence Manager property specifies the persistence location (file based or memory based). Select the appropriate persistence location for your Oracle BAM Report Cache.






23.3.6 Configuring Oracle Data Integrator Integration Properties

The Oracle Data Integrator integration properties specify values for integrating Oracle Data Integrator with Oracle BAM Server.

Enter the appropriate values for the following properties:

ODI User: The user that executes the scenarios in Oracle Data Integrator.

ODI Password: The encoded Oracle Data Integrator password.

ODI Work Repository Name: The name of the Oracle Data Integrator work repository database.

ODI Agent Host: The IP address or hostname of the server where the Oracle Data Integrator agent is running.

ODI Agent Port: The Transmission Control Protocol (TCP) port on which the Oracle Data Integrator agent is listening.






23.3.7 Configuring the Outbound Email Account

This section explains how to configure the email address that appears in the From header of email notifications sent by the Oracle BAM Event Engine.

The Outbound Email Account property on Oracle BAM Server must point to a dedicated email account for delivering Oracle BAM alert notification email messages and Oracle BAM report link email messages.

If an Oracle BAM alert configured with a secondary action to send an email notification fails on the primary action, this property must be configured with an email address that Oracle UMS can access at runtime. Creating a dedicated email account for this purpose is recommended.




	
Note:

Administrators should not use personal email accounts to test alerts, because Oracle UMS may delete email notifications in the mail box and continue deleting messages as they arrive.









To complete the configuration, you must configure the Oracle UMS usermessagingdriver-email driver. For details, see Section 23.5, "Configuring Oracle User Messaging Service".

Oracle BAM Event Engine has another configuration property, TimeoutPeriodToGetFailedStatusesInMins, which is the time interval for which the Event Engine waits after delivering an email notification, to see if it receives any failure notification from Oracle UMS. The default value for this property is 10 minutes. If a failure notification does not arrive within this time, the Event Engine assumes that email delivery was successful, and the failover action is discarded. Failure notifications arriving after this time are ignored by the Event Engine. For information about configuring TimeoutPeriodToGetFailedStatusesInMins, see Section 23.11, "Oracle BAM Configuration Property Reference".








23.4 Configuring the Logger

Use the Log Configuration page to configure logging levels. For information about viewing the logs, see Section 24.6, "Monitoring Oracle BAM Logs." Also, see Section 3.4, "Configuring Log Files" and the Oracle Fusion Middleware Administrator's Guide for general information about logging and log levels.

To open the Log Configuration page, right-click the OracleBamServer node or OracleBamWeb node in the navigation tree and choose Logs > Log Configuration.

[image: Description of bam_log_menu_config.gif follows]
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For each logger, select the desired notification level.

[image: Description of bam_log_config.gif follows]
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23.5 Configuring Oracle User Messaging Service

Oracle User Messaging Service (UMS) must be configured properly in Fusion Middleware Control to send email notifications when alerts are issued.

The UMS email driver monitors the outbound email account configured for Oracle BAM Server for any delivery failures, including rejected emails. Email delivery failure notifications are asynchronous, that is, there is no definite time within which email rejection notification is received.

To configure the outbound email account see Section 23.3.7, "Configuring the Outbound Email Account."

To configure the service:

	
In Fusion Middleware Control, go to the usermessagingdriver-email (User Messaging Email Driver) page by expanding the User Messaging Service folder, then selecting the usermessagingdriver-email (bam_server1) node.

[image: Description of bam_ums_nav.gif follows]
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From the User Messaging Email Driver shortcut menu, choose Email Driver Properties.

[image: Description of bam_ums_menu.gif follows]
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In the Driver-Specific Configuration section, the properties IncomingMailServer, IncomingUserIDs, and IncomingUserPasswords must be provided with the Internet Message Access Protocol (IMAP) server name (Oracle UMS also supports POP3), email account name, and password to access this email account.

[image: Description of bam_ums_driver.gif follows]
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For more information, see Section 26.4, "Configuring User Messaging Service Drivers". Table 26-7, "Custom Email Properties" contains specific information about the properties you must configure.


	
Click Apply to save the changes.


	
Enter the email account in the Outbound Email Account property in the Oracle BAM Server configuration. For details, see Section 23.3.7, "Configuring the Outbound Email Account".









23.6 Configuring Oracle BAM Distribution Lists

Oracle BAM distribution lists are used to send alerts and reports to multiple Oracle BAM users, rather than having to specify several individual recipients. Oracle BAM distribution lists are configured using the Oracle BAM Administrator application.

To configure distribution lists:

	
Go to the Oracle BAM start page, log in, and select Administrator.

[image: Description of bam_start_page.gif follows]
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The Oracle BAM start page is located at:


http://host_name:port_number/OracleBAM/


	
Select Distribution List management from the list.

[image: Description of bam_admin_menu_distlist.gif follows]
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Click Create.


	
Enter a unique Distribution List Name and click Create.

[image: Description of bam_dist_list.gif follows]
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Click Continue to save the distribution list name.

[image: Description of bam_dist_list_cont.gif follows]
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Select the new distribution list that is displayed in the Distribution Lists list on the left side of the page, and click Edit.

[image: Description of bam_dist_list_edit.gif follows]
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Select user accounts to add to the distribution list from the Select Members list.

You can select multiple users by clicking on several user names. The highlighted user names are added to the distribution list.

[image: Description of bam_dist_list_add_mem.gif follows]

Description of the illustration bam_dist_list_add_mem.gif



	
Click Save.

The users are added to the distribution list.









23.7 Configuring Oracle BAM Adapter

Oracle BAM Adapter properties, including the adapter batching properties, are configured in Oracle WebLogic Server Administration Console. For details, see Section 23.7.1, "Configuring Oracle BAM Adapter Properties".

Some issues that must be considered when Oracle BAM Adapter (including Oracle BAM sensor actions in a BPEL process) is used in a SOA composite application are configuring connection factories, trusted domains, and credential mapping.

Before deploying applications that use Oracle BAM Adapter, a connection factory to Oracle BAM Server must be configured. You can configure both Remote Method Invocation (RMI) and Simple Object Access Protocol (SOAP) connection factories. For details, see Section 23.7.2, "Configuring Oracle BAM Connection Factories".

When using the RMI connection between a SOA composite application and Oracle BAM Server, that is when they are deployed in different domains, trusted domain configuration must be done in Oracle WebLogic Server Administration Console. For more information, see Section 23.7.3, "Configuring Trusted Domains".

If the Oracle BAM Adapter is using credentials rather than a plain text user name and password, in order for Oracle BAM Adapter (including Oracle BAM sensor actions in a BPEL process) to connect to Oracle BAM Server, the credentials must also be established and mapped. For more information, see Section 23.7.4, "Configuring Credential Mapping".

The oracle.bam.adapter logger should be configured to troubleshoot issues with Oracle BAM Adapter. For information about logger configuration, see Section 23.4, "Configuring the Logger".




	
Notes:

Use plain text user names and passwords only in nonproduction mode. Do not mix using credential mapping and plain text user information; apply one at a time to avoid confusion.

Because Oracle BAM and Oracle SOA Infrastructure use different identity stores, an Oracle BAM user must be configured in the service infrastructure identity store if there is not a common service infrastructure user and Oracle BAM user.

Oracle BAM Adapter does not support transactional behavior. Even though there is a section in Oracle WebLogic Server Administration Console for configuring transaction support, Oracle BAM Adapter must remain at the No Transaction level.











23.7.1 Configuring Oracle BAM Adapter Properties

Oracle BAM Adapter properties are configured in Oracle WebLogic Server Administration Console.


To configure Oracle BAM Adapter properties:

	
Go to the Oracle WebLogic Server Administration Console

(http://host_name:port_number/console), and log on.


	
In the Domain Structure menu, select Deployments.

[image: Description of bam_wls_domstructmenu.gif follows]
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In the Deployments summary table, search for OracleBamAdapter and click it.

[image: Description of bam_wls_adapterdeploy.gif follows]
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In the Settings for OracleBamAdapter page, click the Configuration tab, and then the Properties tab in the second row.

[image: Description of bam_wls_adapprop1.gif follows]
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Enter the new values, select the checkboxes for each updated value, and click Save.

For information about each property, see Table 23-1, "Oracle BAM Adapter Configuration Properties".

Also, see Section 23.8, "Configuring Oracle BAM Batching Properties" for general information about configuring batching properties.




	
Note:

To commit these changes to the deployment plan you must click Activate Changes in the Change Center. If the Activate Changes button does not appear, see the "Oracle BAM Issues With Oracle WebLogic Server Administrative Console" section in the Oracle Fusion Middleware User's Guide for Oracle Business Activity Monitoring for a workaround.










	
Restart the SOA domain server.

It must be restarted because that is where the Oracle BAM Adapter is deployed.




Table 23-1 lists the Oracle BAM Adapter configuration properties.


Table 23-1 Oracle BAM Adapter Configuration Properties

	RMI Property	SOAP Property	Default	Description
	
Batch_Lower_Limit

	
SOAP_Batch_Lower_Limit

	
1000

	
The minimum amount of elements in a batch before it is sent out.


	
Batch_Upper_Limit

	
SOAP_Batch_Upper_Limit

	
5000

	
The maximum amount of elements in a batch before it is sent out.


	
Batch_Timeout

	
SOAP_Batch_Timeout

	
5000

	
The timeout in milliseconds after which the batch is sent out even if it is not full.


	
Block_On_Batch_Full

	
SOAP_Block_On_Batch_Full

	
false

	
The default setting for block on batch full, which indicates whether batching operations should block when the batch is full. If true then batching calls block until room is freed up in the batch for the operation. If false then BatchIsFullException exception is thrown.


	
Number_Batches

	
SOAP_Number_Batches

	
10

	
The limit of the number of pending calls allowed.










23.7.1.1 Configuring the Adapter to Retry Sending Messages

If messages from BPEL process monitors are published when Oracle BAM Server is unavailable, the messages are not persisted and therefore are not published to the Oracle BAM data objects when Oracle BAM Server comes back online.

You can change this behavior by setting the Oracle BAM Adapter property

Block_On_Batch_Full to true in Oracle BAM Adapter configuration as described in Section 23.7.1, "Configuring Oracle BAM Adapter Properties."

For more information about BPEL process monitors see the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.








23.7.2 Configuring Oracle BAM Connection Factories

Some configuration in the Oracle WebLogic Server Administration Console is necessary before using Oracle BAM Adapter.

Use the Oracle WebLogic Server Administration Console to configure the Oracle BAM connection factories for connections with Oracle BAM Server.

To configure Oracle BAM connection factories:

	
Go to the Oracle WebLogic Server Administration Console

(http://host_name:port_number/console), and log on.


	
In the Domain Structure menu, select Deployments.

[image: Description of bam_wls_domstructmenu.gif follows]
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In the Deployments summary table, search for OracleBamAdapter and click it.

[image: Description of bam_wls_adapterdeploy.gif follows]
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In the Settings for oracle-bam-adapter page, click the Configuration tab, and then the Outbound Connection Pools tab in the second row.

[image: Description of bam_wls_connpooltabs.gif follows]
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Configure the connection factory interface that you intend to use in Oracle JDeveloper, by expanding the appropriate Group and Instance target and clicking the Java Naming and Directory Interface (JNDI) name.

[image: Description of bam_wls_connpoolexpand.gif follows]
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To configure the connection factory for RMI-based calls, click to expand the oracle.bam.adapter.adc.RMIConnectionFactory group and select the JNDI name that the user uses in Oracle JDeveloper. The eis/bam/rmi connection factory is provided out of the box.

To configure the connection factory for SOAP-based calls, click to expand the oracle.bam.adapter.adc.SOAPConnectionFactory group and select the JNDI name that the user uses in Oracle JDeveloper. The eis/bam/soap connection factory is provided out of the box.

[image: Description of bam_wls_connpool.gif follows]
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Configure each of the properties by clicking in the table cells and entering the values.

[image: Description of bam_wls_connpoolprop.gif follows]
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Note:

Press Enter after entering a value in the table.












	
Note:

The UserName field should contain an Oracle BAM user who is a member of application-level role Administrator or Report Architect. For information about assigning users to Oracle BAM application roles, see Section 25.3.3, "Adding Members to Application Roles" and Section 25.3.4, "Introduction to Oracle BAM Application Roles".









This configuration creates the connection factory with HTTP. To configure an HTTPS connection factory, see Section 23.7.2.1, "Configuring HTTPS for Oracle BAM Adapter".

The RMI protocol has different configuration properties. You must provide InstanceName and IsClustered in addition to the standard connection properties.

[image: Description of bam_wls_connpoolprop_rmi.gif follows]
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Select the checkboxes next to the values you have updated and click Save.




	
Note:

To commit these changes to the deployment plan you must click Activate Changes in the Change Center. If the Activate Changes button does not appear, see the "Oracle BAM Issues With Oracle WebLogic Server Administrative Console" section in the Oracle Fusion Middleware User's Guide for Oracle Business Activity Monitoring for a workaround.














23.7.2.1 Configuring HTTPS for Oracle BAM Adapter

To configure HTTPS:

	
Locate the oracle.bam.adapter.adc.soap.SOAPConnectionFactory connection factory in the Oracle WebLogic Server Administration Console as described in Section 23.7, "Configuring Oracle BAM Adapter".

[image: Description of bam_wls_connpooltabs.gif follows]
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Click to expand the oracle.bam.adapter.adc.soap.SOAPConnectionFactory node, select the eis/bam/soap option, and click New.

[image: Description of bam_wls_connpoolnew_start.gif follows]
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Select the oracle.bam.adapter.adc.soap.SOAPConnectionFactory option and click Next.

[image: Description of bam_wls_connpoolnew.gif follows]
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Enter a JNDI name for this connection factory and click Finish.

[image: Description of bam_wls_connpoolnewjndi.gif follows]
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Select the eis/bam/https connection pool instance in the Groups and Instances list.

[image: Description of bam_wls_connpoolnew_https.gif follows]
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Complete the configuration properties as shown in Section 23.7, "Configuring Oracle BAM Adapter," and change the IsHTTPSEnabledWebService value to true.

[image: Description of bam_wls_connpoolprop_https.gif follows]
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23.7.3 Configuring Trusted Domains

When using the RMI connection between a SOA composite application and Oracle BAM Server, that is when they are deployed in different domains, trusted domain configuration must be done in Oracle WebLogic Server Administration Console.

To configure trusted domains:

	
Using the Oracle WebLogic Server Administration Console, in both SOA and Oracle BAM Server domains, go to base_domain > Security > General, and expand the Advanced settings.

[image: Description of bam_wls_trust.gif follows]
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Enter the credential for the Oracle WebLogic Server domain in the Credential and Confirm Credential fields.

Enter the same credential in both the SOA and Oracle BAM Server domains to establish trust between the domains.


	
Save and activate the changes, then restart Oracle WebLogic Server.




For more information about trusted domains see "Enabling Global Trust" in Oracle Fusion Middleware Securing Oracle WebLogic Server.






23.7.4 Configuring Credential Mapping

Configure Oracle BAM Adapter to securely store user name and password properties using Oracle WebLogic Server credential mapping functionality.




	
Note:

Use plain text user names and passwords only in nonproduction mode. Do not mix using credential mapping and plain text user information; apply one at a time to avoid confusion.










To configure credential mapping:

	
Using the Oracle WebLogic Server Administration Console, go to Deployment > OracleBamAdapter > Security > Credential Mappings.

[image: Description of bam_wls_credmap_locate.gif follows]
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Click New and select an outbound connection pool instance for which to create a credential mapping entry, then click Next (By default, Oracle BAM is installed with two connection pools, eis/bam/rmi and eis/bam/soap).

[image: Description of bam_wls_credmap_select.gif follows]
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Note:

Ensure that a separate credential mapping entry for each outbound connection pool is created. If there are any additional outbound connection pools other than the defaults, you must create corresponding credential mappings for them as well.










	
Select Unauthenticated WLS User, and click Next (Unauthenticated WLS User is similar to an anonymous user).

[image: Description of bam_wls_credmap_user.gif follows]
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Specify a corresponding user name and password for connecting to Oracle BAM Server, then click Finish to complete the credential mapping.

[image: Description of bam_wls_credmap_eis.gif follows]
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Repeat these steps to create the credential mapping for the other Oracle BAM connection pool entries.

After you configure the credential mappings for each of the outbound connection pool entries, the mappings appear in the Credential Mappings table.

[image: Description of bam_wls_credmap_list.gif follows]
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For these changes to take effect, Oracle WebLogic Server must be restarted.











23.8 Configuring Oracle BAM Batching Properties

The batch processor batches operations (for example, insert, update, upsert, and delete) between the client and the Active Data Cache server to improve performance by limiting the number of remote calls. For example, 10 update operations could be processed in a single remote call with batching enabled, rather than making 10 remote calls.




	
Note:

Batching is used only on incoming data, not on internal Oracle BAM processes.









For Oracle BAM Adapter, the batching properties are configured using the Oracle BAM Adapter configuration page in the Oracle WebLogic Server Administration Console.

Oracle BAM batching properties are located in the BAMWebConfig.xml file for configuring batching to send data from Oracle BAM web applications (that is, to send data using Oracle BAM Architect), and to send data from the Oracle BAM DataObjectOperation web service using the batch method.

Oracle BAM configuration files are located in the following directory:


WL_HOME/user_projects/domains/base_domain/config/fmwconfig/servers/bam_server
1/applications/oracle-bam_11.1.1/config/ 


Oracle BAM must be restarted after any changes to Oracle BAM properties. For information about restarting Oracle BAM, see Section 25.2, "Managing Oracle BAM Availability".




	
Note:

The Oracle BAM ADC API properties are the properties used by all Oracle BAM clients (such as ICommand and Oracle Data Integrator), and the SOAP properties are only used by Oracle BAM Adapter when configured to use SOAP.









Table 23-2 lists the batching properties for Oracle BAM ADC API and SOAP.


Table 23-2 Active Data Cache API and SOAP (Oracle BAM Adapter) Batching Properties

	Oracle BAM ADC API Property	SOAP Property	Default	Description
	
ActiveDataCache_Datasets_Batching_Limit_PendingCalls

	
Adapter_SOAP_Batching_Limit_PendingCalls

	
10

	
The limit of the number of pending calls allowed.


	
ActiveDataCache_Datasets_Batching_Limit_Lower

	
Adapter_SOAP_Batching_Limit_Lower

	
1000

	
The minimum number of elements in a batch before it is sent out.


	
ActiveDataCache_Datasets_Batching_Limit_Upper

	
Adapter_SOAP_Batching_Limit_Upper

	
5000

	
The maximum number of elements in a batch before it is sent out.


	
ActiveDataCache_Datasets_Batching_Timeout

	
Adapter_SOAP_Batching_Timeout

	
5000

	
The timeout interval in milliseconds after which the batch is sent out even if it is not full.


	
ActiveDataCache_Datasets_Batching_BlockOnBatchFull

	
Adapter_SOAP_Batching_BlockOnBatchFull

	
false

	
The block on batch full properties indicate whether batching operations should block when the batch is full. If set to true, then batching calls block until room is freed up in the batch for the operation. If set to false, a BatchIsFullException exception is thrown.


	
ActiveDataCache_Datasets_Batching_RetryInterval

	
Adapter_SOAP_Batching_RetryInterval

	
30000

	
The interval in milliseconds at which batch processing should attempt to retry failed flush attempts.


	
ActiveDataCache_Datasets_Batching_MaxRetryInterval

	
Adapter_SOAP_Batching_MaxRetryInterval

	
3600000

	
The maximum interval in milliseconds at which batch processing should attempt to retry failed flush attempts.


	
ActiveDataCache_Datasets_Batching_MaximumRetries

	
Adapter_SOAP_Batching_MaximumRetries

	
Integer.MAX_VALUE

	
The maximum number of times batch processing should attempt to retry failed flush attempts. Zero indicates no retry.


	
ActiveDataCache_Datasets_Batching_SuspendOnDisconnect

	
Adapter_SOAP_Batching_SuspendOnDisconnect

	
false

	
Suspend on disconnect, which indicates whether batching operations should be permanently suspended if and when the connection to Oracle BAM Server is lost.









Batching Retry Mechanism

The batching retry mechanism is designed to retry remote calls to the server in the event communication with the server is lost due to, for example, network problems or Oracle BAM Server going offline. The operation of this retry mechanism is governed by the configuration properties detailed in this section. The term flush refers to the attempt to send the batch calls to the Oracle BAM Server for processing.

The RetryInterval property specifies the interval between retry attempts in milliseconds. If the MaxRetryInterval value is unspecified (0), then the code continues retrying at the RetryInterval value until the batch flush is successful or the MaximumRetries value is exceeded.

If the MaxRetryInterval value is specified, then the retry interval value is doubled on each retry up to the MaxRetryInterval value. It stays at the MaxRetryInterval rate until the batch flush is successful, or the MaximumRetries value is exceeded. This allows the retry rate to decline over time to a more reasonable long-term rate. If the server does not recover quickly, do not continue to retry at a rapid rate.

If the MaximumRetries value is 0, then no retries are attempted and failed batches are discarded.

If the SuspendOnDisconnect value is true, then all batching is permanently suspended until the client application is restarted, regardless of whether communication with Oracle BAM Server is reestablished.

If the pending batch limit is reached and the current batch is full (maximum size reached), then batch calls are blocked. There is no place to queue the operation from the current call, so Oracle BAM blocks the client until the condition resolves itself.

Table 23-2 describes the configuration properties that can be specified for the Active Data Cache API batching (which is used by the RMI connection factory, configured in Section 23.7.2, "Configuring Oracle BAM Connection Factories").

The Oracle BAM Adapter batching mechanism (used by the SOAP connection factory) has an identical set of configuration properties and default values.






23.9 Configuring Security

Security is configured in Oracle WebLogic Server. For information about the topics listed in this section, see Oracle Fusion Middleware Securing Oracle WebLogic Server. General information about Oracle WebLogic Server security is available in Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server.

This section address the following security topics as they relate to Oracle BAM:

	
Section 23.9.1, "Configuring Credential Mapping"


	
Section 23.9.2, "Configuring Oracle BAM User Permissions"


	
Section 23.9.3, "Configuring Secure Socket Layer"


	
Section 23.9.4, "Using Oracle Internet Directory With Oracle BAM"


	
Section 23.9.5, "Securing Oracle BAM JMS Resources"


	
Section 23.9.6, "Calling Secure Web Services"






23.9.1 Configuring Credential Mapping

Credential mapping is used to securely store user name and password properties when using the Oracle BAM Adapter. For information see Section 23.7.4, "Configuring Credential Mapping."






23.9.2 Configuring Oracle BAM User Permissions

To provide secure access to the Oracle BAM applications, users are assigned to roles that provide the necessary permissions. For more information, see Section 25.3, "Managing Oracle BAM Users".






23.9.3 Configuring Secure Socket Layer

Oracle WebLogic Server provides the facilities needed to enable Secure Socket Layer (SSL) on any Oracle SOA Suite and Oracle WebCenter Portal connections into Oracle WebLogic Server.

Use the Java Development Kit (JDK) keytool utility to create and manage keystores and certificates, and use the Oracle WebLogic Server Administration Console to configure Oracle WebLogic Server listeners.

For more information, see "Configuring SSL" in Oracle Fusion Middleware Securing Oracle WebLogic Server.

Although Oracle WebLogic Server lets you configure the Oracle BAM web applications on both SSL and non-SSL ports, and Oracle BAM can also be configured to run on both SSL and non-SSL ports, it causes issues with the URL configured for Oracle BAM alerts. When Oracle BAM is running on both SSL and non-SSL ports, it cannot send two Oracle BAM report URLs to the alert email receiver. It is the responsibility of the administrator to decide which mode of access (SSL or non-SSL) to use for the Oracle BAM report URL recipients.

To start Oracle BAM in SSL mode, and enable Oracle BAM clients (like ICommand) to invoke Oracle BAM ADC, invoke EJBs, JMS resources, and JDBC resources using SSL, you must configure the following Oracle BAM properties:

	
Communication_Protocol in the BAMCommonConfig.xml, BAMServerConfig.xml, and BAMICommandConfig.xml files, as follows:

Default value: <Communication_Protocol>t3</Communication_Protocol>

For SSL using t3s: <Communication_Protocol>t3s</Communication_Protocol>


	
ListenPort in BAMCommonConfig.xml file, as follows:

Default value: <ListenPort>ListenPort</ListenPort>

For SSL: <ListenPort>SSLListenPort</ListenPort>









23.9.4 Using Oracle Internet Directory With Oracle BAM

For general information about configuring Oracle Internet Directory, see "Configuring Users and Groups in the Oracle Internet Directory and Oracle Virtual Directory Authentication Providers" in Oracle Fusion Middleware Securing Oracle WebLogic Server.

To use Oracle Internet Directory with Oracle BAM:

	
Configure Oracle Internet Directory using the Oracle WebLogic Server Administration Console.


	
Create OracleSystemUser in Oracle Internet Directory, by connecting to Oracle Internet Directory with a Lightweight Directory Access Protocol (LDAP) browser and creating a user in the same base user Distinguished Name that was provided in the Oracle WebLogic Server Administration Console while configuring Oracle Internet Directory.


	
Run the following SQL statements to nullify the user global unique identifiers (GUID) in the Oracle BAM schema:


UPDATE "SysIterUser" SET "SysIterUser"."GUID" = NULL,
"SysIterUser"."Inactive" = NULL;









23.9.5 Securing Oracle BAM JMS Resources

This is an optional procedure to restrict access to the Oracle BAM system JMS topics.

To secure Oracle BAM JMS resources:

	
Create a group with any group name using Oracle WebLogic Server Administration Console. For example, OracleSystemGroup.


	
Go to WL_HOME/AS11gR1SOA/bam/bin and invoke secure_jms_system_resource.py using Oracle WebLogic Scripting Tool (WLST).

The usage should be:


<JAVA_HOME>/bin/java -classpath <weblogic.jar_location> weblogic.WLST 
./secure_jms_system_resource.py --username admin_user_name --password 
admin_password --url admin_server_t3_url --jmsSystemResource 
JMS_system_resource_name --group security_group_to_use


	
Assign OracleSystemUser to this group.


	
Assign all those Oracle BAM users to this group.









23.9.6 Calling Secure Web Services

Currently, the Oracle BAM Alerts Call a Web Service action supports invoking web services protected by one-way SSL. In one-way SSL, the web service to be invoked presents a digital certificate to its client (the Oracle BAM Alert action client in this case), and the client verifies whether certificate presented to it can be trusted. If the client trusts the server certificate, then further communication between client and server continues over a secure SSL channel.

To accomplish one-way SSL, the Alert web service client must be pointed to a trust store in which it can perform a lookup, to determine if the certificate presented to it exists in it or not. This can be done by adding the following properties in BAMCommonConfig.xml.


<SSL.TrustStore.Location>wls.home/lib/DemoTrust.jks</SSL.TrustStore.Location>
<SSL.TrustStore.Type>JKS</SSL.TrustStore.Type>
<SSL.TrustStore.Password>password</SSL.TrustStore.Password>
<SSL.TrustStore.Provider>SUN</SSL.TrustStore.Provider>


By default, if these properties are not specified in the configuration file, the values mentioned above are used (except for password, in which no value is used). You can provide different values to these properties to override the default trust store configuration. Currently you must edit the configuration files to set these properties, as they are not exposed in Oracle Enterprise Manager Fusion Middleware Control.

The default trust store is Java Key Store (JKS), which is file based. Certificates can be added and deleted using the Java keytool command-line utility.

For information about configuring the Call a Web Service alert action, see "Call a Web Service" in the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.



23.9.6.1 Example: Protecting Oracle BAM Web Services

The following is an example illustrating how to invoke SSL protected Oracle BAM web services. It is specific to the Call a Web Service alert action calling the Oracle BAM ManualRuleFire web service. The steps in this section do not need to be done if you are invoking external one-way SSL-protected non-BAM web services.




	
Note:

After this configuration the entire Oracle BAM application is behind the SSL layer and must be accessed using the SSL port number and HTTPS protocol.









To configure properties for calling secure web services:

	
Open Oracle WebLogic Server Administration Console and go to Domain Structure > Environment > Servers > BAM_Server > General.


	
Check SSL Listen Port checkbox and specify the SSL Listen Port number to use.


	
Modify the Oracle BAM configuration properties.

	
These properties must be modified in BAMCommonConfig.xml:


<Communication_Protocol>t3s</Communication_Protocol>
<ListenPort>SSLListenPort</ListenPort>
<ApplicationURL>http://SSL_HOST:SSL_PORT</ApplicationURL>


	
This property must be modified in BAMWebConfig.xml:


<ServerPort>SSL_PORT</ServerPort>





	
Restart Oracle WebLogic Server.


	
Open Oracle BAM Active Studio or Oracle BAM Architect, and go to Alerts.


	
Create an alert with the Call a Web Service action using a secure web service, such as


https://host_name:SSL_port_number/OracleBAMWS/WebServices/ManualRuleFire?wsdl


as the WSDL URL for the action.


	
Map the parameters and save the alert.













23.10 Configuring Advanced Properties

Oracle BAM provides many advanced properties not available for configuration using the BAM Web Properties and BAM Server Properties pages in Fusion Middleware Control. These advanced properties are configured using the System MBean Browser.

For a listing of all properties available for Oracle BAM configuration, see Section 23.11, "Oracle BAM Configuration Property Reference".

To configure the advanced properties using the System MBean Browser:

	
Choose System MBean Browser from the menu on the OracleBAMWeb or OracleBAMServer page.

[image: Description of bam_admin_menu_mbean.gif follows]
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Select the path to the appropriate Application Defined MBeans page:

	
For properties common to all Oracle BAM components select Application Defined MBeans > oracle.bam.common > Server: bam_server1 > Application: oracle-bam > Config > BAMCommonConfig (see Figure 23-1).


	
For Oracle BAM Server-specific properties select Application Defined MBeans > oracle.bam.server > Server: bam_server1 > Application: oracle-bam > Config > BAMServerConfig.


	
For Oracle BAM web applications-specific properties select Application Defined MBeans > oracle.bam.web > Server: bam_server1 > Application: oracle-bam > Config > BAMWebConfig.





Figure 23-1 System MBean Browser Navigation Tree

[image: Description of Figure 23-1 follows]
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The associated configuration properties are displayed in the System MBean Browser.

[image: Description of bam_em_mbean.gif follows]
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Edit property values in the Values column, and click Apply.


	
Oracle BAM must be restarted after any changes to Oracle BAM properties. For information about restarting Oracle BAM, see Section 25.2, "Managing Oracle BAM Availability".





Oracle BAM Configuration Property Files

All Oracle BAM properties are located in configuration files. These files are located in the following directory on the host where the Oracle BAM components are installed:


WL_HOME/user_projects/domains/base_domain/config/fmwconfig/servers/bam_server
1/applications/oracle-bam_11.1.1/config


The configuration properties usually go into the BAMCommonConfig.xml file, which contains the properties global to all Oracle BAM components. These properties can also be specified in component-specific configuration files:

	
Oracle BAM Server-specific properties are configured in BAMServerConfig.xml


	
Oracle BAM web applications-specific properties are configured in BAMWebConfig.xml


	
Oracle BAM ICommand utility-specific properties are configured in BAMICommandConfig.xml




The properties set in the BAMCommonConfig.xml file are always loaded. Any additional configuration files must be loaded explicitly. Oracle BAM Server explicitly loads the BAMServerConfig.xml file, Oracle BAM web applications explicitly load the BAMWebConfig.xml file, and ICommand explicitly loads the BAMICommandConfig.xml file. When a configuration file is loaded, its properties override any properties previously set, that is properties specified in BAMServerConfig.xml override properties set in BAMCommonConfig.xml.






23.11 Oracle BAM Configuration Property Reference

This section provides a brief description of each Oracle BAM configuration property that may be used in the Oracle BAM configuration files.

Advanced properties are configured in the Fusion Middleware Control System MBean Browser. For information about configuring properties that do not appear in the Oracle BAM configuration pages in Fusion Middleware Control, see Section 23.10, "Configuring Advanced Properties".

Some of these properties correspond to properties you can set in the Fusion Middleware Control and Oracle WebLogic Server Administration Console, and references to specific sections about these configuration procedures are provided in Table 23-3.




	
Note:

The Oracle BAM ADC API properties are the properties used by all Oracle BAM clients (such as ICommand and Oracle Data Integrator), and the SOAP properties are only used by Oracle BAM Adapter when configured to use SOAP.










Table 23-3 Oracle BAM Configuration Properties

	Property Name	Description
	

ActiveDataCache.API.Batching.ThreadPool.
CoreSize

	
Indicates how many threads to keep in the Oracle BAM ADC API thread pools when idle.

Default: 5


	

ActiveDataCache.API.Batching.ThreadPool.
KeepAliveTimeInSecs

	
Amount of time (in seconds) to keep an idle thread in the Oracle BAM ADC API thread pools.

Default: 20


	

ActiveDataCache.API.Batching.ThreadPool.
MaxSize

	
Maximum number of threads in the Oracle BAM ADC API thread pools.

Default: 100


	

ActiveDataCache.API.Batching.ThreadPool.
QueueSize

	
Maximum number of messages that can be queued in the Oracle BAM ADC API thread pools.

Default: 30


	

ActiveDataCache.API.BufferedDataReader.
ThreadPool.CoreSize

	
Indicates how many threads to keep in the Oracle BAM ADC buffered data reader thread pools when idle.

Default: 10


	

ActiveDataCache.API.BufferedDataReader.
ThreadPool.KeepAliveTimeInSecs

	
Configured in BAMCommonConfig.xml

Amount of time (in seconds) to keep an idle thread in the Oracle BAM ADC buffered data reader thread pools.

Default: 20


	

ActiveDataCache.API.BufferedDataReader.
ThreadPool.MaxSize

	
Maximum number of threads in the Oracle BAM ADC Buffered Data Reader Thread Pools.

Default: 100


	

ActiveDataCache.API.BufferedDataReader.
ThreadPool.QueueSize

	
Maximum number of messages that can be queued in the Oracle BAM ADC Buffered Data Reader Thread Pools.

Default: 30


	

ActiveDataCache.Kernel.ActiveDataQueue.
ThreadPool.CoreSize

	
Indicates how many threads to keep in the Oracle BAM ADC Active Data Queue Thread Pools when idle.

Default: 20


	

ActiveDataCache.Kernel.ActiveDataQueue.
ThreadPool.KeepAliveTimeInSecs

	
Amount of time (in seconds) to keep an idle thread in the Oracle BAM ADC Active Data Queue Thread Pools.

Default: 20


	

ActiveDataCache.Kernel.ActiveDataQueue.
ThreadPool.MaxSize

	
Maximum number of threads in the Oracle BAM ADC Active Data Queue Thread Pools.

Default: 100


	

ActiveDataCache.Kernel.ActiveDataQueue.
ThreadPool.QueueSize

	
Maximum number of messages that can be queued in the Oracle BAM ADC Active Data Queue Thread Pools.

Default: 30


	

ActiveDataCache_Datasets_Batching_
BlockOnBatchFull

	
Block on batch full properties indicate whether batching operations should block when the batch is full. If set to true, then batching calls block until room is freed up in the batch for the operation. If set to false, a BatchIsFullException exception is thrown.

Default: false


	

ActiveDataCache_Datasets_Batching_Limit_
Lower

	
The minimum amount of elements in a batch before it is sent to the server. Depending on the load, batches may contain more than this minimum (up to the maximum), but they never contain less than this minimum (unless the timeout expires).

See ActiveDataCache_Datasets_Batching_Timeout for the exception to this rule.

See Section 23.8, "Configuring Oracle BAM Batching Properties" for more information.

Default: 1000


	

ActiveDataCache_Datasets_Batching_Limit_
PendingCalls

	
The limit of the number of pending batches that are waiting to be sent to the server. When this limit is reached and the current batch is full (at its upper limit), further batched operations become blocking calls until this condition is cleared. This limit throttles the client and keeps it from overrunning the server.

See Section 23.8, "Configuring Oracle BAM Batching Properties" for more information.

Default: 10


	

ActiveDataCache_Datasets_Batching_Limit_
Upper

	
The maximum amount of elements in a batch before it is sent out. A batch never contains more than this maximum.

See Section 23.8, "Configuring Oracle BAM Batching Properties" for more information.

Default: 5000


	

ActiveDataCache_Datasets_Batching_
MaximumRetries

	
The maximum number of times batch processing retries failed attempts to send the batch to the server. A value of 0 (zero) indicates no retry.

Default: 2147483647


	

ActiveDataCache_Datasets_Batching_
MaxRetryInterval

	
The maximum interval in milliseconds at which batch processing retries failed attempts to send the batch to the server. If this maximum retry interval is specified, the retry interval is doubled on each retry attempt until the interval reaches this maximum value. Further retries use this maximum value. This interval enables the configuration of retry attempts that taper off should the failure not resolve itself quickly. If a maximum retry interval of 0 (zero) is specified, the retry interval does not change.

Default: 3600000


	

ActiveDataCache_Datasets_Batching_
RetryInterval

	
The interval in milliseconds at which batch processing retries failed attempts to send the batch to the server. Retry is attempted when the failure is due to server connectivity problems such as the server being restarted.

Default: 30000


	

ActiveDataCache_Datasets_Batching_
SuspendOnDisconnect

	
Indicates whether batching operations are permanently suspended if and when the connection to Oracle BAM Server is lost.

Default: false


	

ActiveDataCache_Datasets_Batching_
ThreadPoolSize 

	
The constant size thread pool (that is, containing a fixed number of threads).

Default: 25


	

ActiveDataCache_Datasets_Batching_
Timeout

	
The timeout in milliseconds after which the batch is sent out even if it is not full (has less than the configured minimum in ActiveDataCache_Datasets_Batching_Limit_Lower).

The timeout ensures that operations are not waiting overlong in a batch due to inactivity. A batched operation never waits longer than this timeout to be sent to the server.

See Section 23.8, "Configuring Oracle BAM Batching Properties" for more information.

Default: 50


	

ActiveDataCache_Query_Command_Timeout

	
The configuration key for a query command timeout in seconds. If the time to execute a query command exceeds this timeout, an exception is thrown.

Default: 60


	

ActiveDataCache_Update_Command_Timeout

	
The configuration key for an update command timeout in seconds. If the time to execute an update command exceeds this timeout, an exception is thrown.

Default: 60


	

Adapter_SOAP_Batching_BlockOnBatchFull

	
Block on batch full properties indicate whether batching operations should block when the batch is full. If set to true, then batching calls block until room is freed up in the batch for the operation. If set to false, a BatchIsFullException exception is thrown.

Default: false


	

Adapter_SOAP_Batching_Limit_Lower

	
The minimum amount of elements in a batch before it is sent out.

See Section 23.8, "Configuring Oracle BAM Batching Properties" for more information.

Default: 1000


	

Adapter_SOAP_Batching_Limit_Upper

	
The maximum amount of elements in a batch before it is sent out.

See Section 23.8, "Configuring Oracle BAM Batching Properties" for more information.

Default: 5000


	

Adapter_SOAP_Batching_Timeout

	
The timeout interval in milliseconds after which the batch is sent out even if it is not full.

See Section 23.8, "Configuring Oracle BAM Batching Properties" for more information.

Default: 50


	

ADC_PassThrough_Import_BatchSize

	
The maximum number of rows that are imported from an external data object.

Default: 50


	

ADC_PassThrough_Import_
MaxRowsToImportAtOnce

	
Maximum number. of rows imported by ExternalDataManager at one time.

Default: 100


	

ADC_PassThrough_Import_MaxSize

	
Maximum size imported by ExternalDataManager.

Default: -1


	

ADCBatchSize

	
Refers to JDBC statement batching. When the Oracle BAM ADC executes SQL statements it uses JDBC batching to reduce the number of calls to the database, improving performance. Each call executes a batch of statements rather than a single statement.

Default: 100


	

ADCChannelName

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: invm:topic/oracle.bam.messaging.activedatacache.activedata


	

ADCDataSource

	
The data source for the Active Data Cache. See Section 23.3.2, "Configuring the Data Source JNDI" for more information.

Default: jdbc/oracle/bam/adc


	

ADCLogBatchInsertLocks

	
Indicates whether to log Oracle BAM ADC batch insert locks.

Default: false


	

ADCLogFolderLocks

	
Indicates whether to log Oracle BAM ADC folder locks.

Default: false


	

ADCLogSqlStatements

	
Indicates whether to log Oracle BAM ADC SQL statements.

Default: false


	

ADCLogTransactionLocks

	
Indicates whether to log Oracle BAM ADC transaction locks.

Default: false


	

ADCMaxViewsetRowCount

	
The default limit for rows of data displayed in a view with this property. The higher you set this value, the more performance is impacted.

Default: 64000


	

ADCPreloadDataObjectIDs

	
Indicates whether data objects should be loaded at Oracle BAM ADC startup rather than on-demand as they are accessed. Pre-loading the data objects increases startup time but decreases initial data object access time. Not pre-loading the data objects decreases startup time but increases initial data object access time. Also, pre-loading all data objects where many data objects are rarely referenced may needlessly increase memory requirements.


	

ADCPushInterval

	
The rate at which Oracle BAM Active Data Cache pushes events to Oracle BAM Report Server. This is one factor that affects the frequency at which active events occur on Oracle BAM dashboard pages. Increasing this interval reduces the load on Oracle BAM Server. However, larger intervals increase the likelihood of multiple updates in the dashboard being collapsed into single updates.

You can override the default ADCPushInterval within particular reports by setting the Active Data Retrieval Interval property in the Report Properties dialog for a particular Oracle BAM dashboard or report. Open a report in Active Studio, then select Edit > Change Report Properties > Advanced to set the active data retrieval interval. Nonzero values override the ADCPushInterval value for that particular report.

Default: 1000


	

ADCPushThreadPoolSize

	
Indicates the size of the threadpool for Oracle BAM ADC push functionality.

Default: 10


	

ADCRetryCount

	
Number of times to retry the Oracle BAM Active Data Cache connection.

Default: 2


	

ADCSecurityFiltersEnabled

	
Indicates whether Oracle BAM ADC security filters are to be enabled.

Default: true


	

ADCViewsetTimeoutSec

	
Specifies the timeout for retrieving a view set.

Default: 0


	

ADCWaitTime

	
Interval between Active Data Cache connection attempts.

Default: 20


	

ApplicationURL

	
URL for Oracle BAM web applications and Oracle BAM Server. See Section 23.3.3, "Configuring the Application URL" and Section 23.2.2, "Configuring the Application URL" for more information.

Default: DEFAULT


	

Architect_Content_PageSize

	
Controls how many rows are shown when viewing data object contents in Oracle BAM Architect.

Default: 100


	

AutoIncrementBlockSize

	
Indicates amount of increment for block size.

Default: 100


	

CacheDirectory

	
Designates the directory used by Report Cache to cache snapshots and active data.

Default: cache


	

ChangeListDelay

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: 1


	

ChannelName

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: OracleBAM


	

CheckViewsFallingBehindInterval

	
Indicates the interval to check whether views are falling behind.

Default: 20


	

CollaborationNILogin

	
Whether NI Login is used.

Default: false


	

ColumnarTimeout

	
Indicates the columnar timeout.

Default: 0


	

Communication_Protocol

	
Specifies the communication protocol for JNDI communication.

For SSL using t3: <Communication_Protocol>t3s</Communication_Protocol>

See Section 23.9.3, "Configuring Secure Socket Layer."

Default: DEFAULT


	

ConnectionFactoryName

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: jms/QueueConnectionFactory


	

DeletesActiveDataSize

	
InsertsActiveDataSize, UpdatesActiveDataSize, UpsertsActiveDataSize, and DeletesActiveDataSize determine how many inserts, updates, upserts, and deletes, respectively, should be executed before releasing and then requiring the lock on the data object being modified. This keeps the operation from holding the data object lock for long periods of time when there are view sets open on this data object.

Default: 50


	

DisplayUIStackTrace

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

This property enables user interface stack traces (by setting this property value to true). This property is used for temporary diagnostic purposes only because exposing a stack with internal details is a potential security threat.

Default: false


	

DistributionListGroupType

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: none


	

EDS_Query_Timeout

	
The timeout in seconds after which the execution of BAM report queries on external data objects stop because it is taking too long to retrieve the information for display. Also set Import_MaxSize, which determines the maximum number of rows that are pulled from the external data object (the larger the number, the slower the performance).

Default: 180


	

ElementsCountLimit

	
The number of change lists that are cached before rewriting the cache file.

The default value is 50. When the 51st change list is received, it is cached by replacing the 1st change list.

Default: 50


	

ElementsSizeLimit

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: 500


	

EmailIDForSender

	
Email address that appears in the From header of notifications sent by the Event Engine. See Section 23.3.7, "Configuring the Outbound Email Account" for more information.

Default: BAM-NOTIFICATION_AR@oracle.com


	

EMSConnectionRecoveryDuration

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.


	

EnableADCDatasetLockTimeout

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Indicates whether data set lock timeout is enabled.

Default: false


	

EnableDataTruncationMsg

	
Indicates whether to enable the data truncation message.

Default: false


	

EnableGetAllViewsInOneRoundTrip

	
Allows all views to be retrieved in one round trip.

Default: true


	

EvaluatorMaxExpressionDepth

	
Maximum number of nested logical expressions that can be included in one method in the class that gets compiled to evaluate a filter expression.

Default: 200

When opening a view that uses a filter with a large number of distinct values, the compiler can run out of memory and you can get the error: BAM-01317: Compilation for class ... failed with error 3. If this error continues to happen, lower the value for EvaluatorMaxExpressionDepth and restart the server.

Although this property does not significantly affect performance, you can turn it off by setting EvaluatorMaxExpressionDepth to zero, which would result in one method in the evaluator class for the entire filter expression.


	

EventEngine.Action.ThreadPool.CoreSize

	
Indicates how many threads to keep in the Event Engine Action Thread Pools when idle.

Default: 4


	

EventEngine.Action.ThreadPool.
KeepAliveTimeInSec

	
Amount of time (in seconds) to keep an idle thread in the Event Engine Action Thread Pools.

Default: 20


	

EventEngine.Action.ThreadPool.MaxSize

	
Maximum number of threads in the Event Engine Action Thread Pools.

Default: 100


	

EventEngine.Action.ThreadPool.QueueSize

	
Maximum number of messages that can be queued in the Event Engine Action Thread Pools.

Default: 4


	

EventEngine.AlertHistory.ThreadPool.
CoreSize

	
Indicates how many threads to keep in the Event Engine Alert History Thread Pools when idle.

Default: 4


	

EventEngine.AlertHistory.ThreadPool.
KeepAliveTimeInSecs

	
Amount of time (in seconds) to keep an idle thread in the Event Engine Action Thread Pools.

Default: 20


	

EventEngine.AlertHistory.ThreadPool.
MaxSize

	
Maximum number of threads in the Event Engine Alert History Thread Pools.

Default: 100


	

EventEngine.AlertHistory.ThreadPool.
QueueSize

	
Maximum number of messages that can be queued in the Event Engine Rule Fire Thread Pools.

Default: 10


	

EventEngineAlertHistoryEventLogging

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: false


	

EventEngineAlertHistoryRecordsPerWrite

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: 10


	

EventEngine.RuleFire.ThreadPool.CoreSize

	
Indicates how many threads to keep in the Event Engine Rule Fire Thread Pools when idle.

Default: 4


	

EventEngine.RuleFire.ThreadPool.
KeepAliveTimeInSecs

	
Amount of time (in seconds) to keep an idle thread in the Event Engine Rule Fire Thread Pools.

Default: 20


	

EventEngine.RuleFire.ThreadPool.MaxSize

	
Maximum number of threads in the Event Engine Rule Fire Thread Pools.

Default: 100


	

EventEngine.RuleFire.ThreadPool.
QueueSize

	
Maximum number of messages that can be queued in the Event Engine Rule Fire Thread Pools.

Default: 4


	

EventEngineCheckADCIntervalSecs

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: 5


	

EventEngineMaxConnections

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: 25


	

EventEngineMaxShutdownWaitInterval

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: 10


	

EventEngineSaveLastFireIntervalSecs

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: 10


	

FileHandleCacheSize

	
Used by Oracle BAM Report Cache to cache file handles of the files used for caching when file-based persistence is used (see Section 23.3.5, "Configuring the Report Cache Persistence Manager" for information about persistence management).

Handle caching increases the speed of reading and writing active data and snapshots. Each view set has two file handles--one for the snapshot and another for active data.

The value for this property sets the number of file handles that are cached by default.

To disable file handle caching, set this property value to zero (0).

The cost of file handle caching is that all of the cached file handles remain open, and so a) on servers configured for a very small number of concurrent open file handles, and b) on servers heavily loaded with open file handle count reaching the maximum value, this could create a problem. For these scenarios, reduce FileHandleCacheSize to an appropriate smaller value.

Default: 100


	

FractionInIntegerDivision

	
Setting this property to true shows fractions in Integer divisions in calculations.

Saved reports must be re-saved after a server restart (following configuration change) to see this behavior.

Default: false


	

GenericSatelliteChannelName

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default:


invmjms:topic/oracle.bam.messaging.
systemobjectnotification


	

GenericSatelliteSystemObjectNames

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default values:


SystemObjectName=SysIterReport,MonitorColumnName=SysIterL
astModified,MessageColumn1=SysIterID,MessageColumn2=SysIt
erLastModified;

SystemObjectName=SysIterUser,MonitorColumnName=SpecificTi
meZoneOffset,MessageColumn1=SysIterID;

SystemObjectName=SysIterUser,MonitorColumnName=AdjustTime
ZoneSetting,MessageColumn1=SysIterID;

SystemObjectName=SysIterUser,MonitorColumnName=AdjustDayl
ightSavingsSetting,MessageColumn1=SysIterID;

SystemObjectName=SysIterDataset,MonitorColumnName=SysIter
LastModified,MessageColumn1=SysIterID;


	

HelpAppLocation

	
This property is no longer used in Oracle BAM.


	

iActiveDataCloseReportsTimeout

	
Timeout to close reports.

Default: 500


	

iActiveDataMaxDiffCounter

	
The maximum difference counter for iActiveData.

Default: 10


	

iActiveDataMinIntervalsToWait

	
The minimum interval to wait for iActiveData.

Default: 5


	

iActiveDataReloadOnSecsBehindThreshold

	
The threshold value for reloading iActiveData.

Default: 10


	

iActiveDataRestartInterval

	
The restart interval for iActiveData.

Default: 3000


	

iActiveDataRestartTimeout

	
The restart timeout value for iActiveData.

Default: 10000


	

iActiveDataScriptsCleanupFactor

	
A property to address a Microsoft Internet Explorer memory leak, when active data is coming into the dashboard at a fast pace, by forcing periodic browser refreshes. This value may be further increased when active data is coming to the dashboard at a rate of 25 events per second or greater. You can monitor the Microsoft Internet Explorer memory consumption to determine an appropriate value.

Default: 1048576


	

ICommand_Default_User_Name

	
Specifies default security credentials for running ICommand operations. See Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for more information.


	

ICommand_Default_Password

	
Specifies default security credentials for running ICommand operations. See Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for more information.


	

Import_BatchSize

	
Batch size for import by ExternalDataManager.

Default: 50


	

Import_MaxRowsAtOnce

	
Maximum number of rows imported by ExternalDataManager at one time.

Default: 100


	

Import_MaxSize

	
Maximum size imported by ExternalDataManager.

Default: -1


	

InsertsActiveDataSize

	
InsertsActiveDataSize, UpdatesActiveDataSize, UpsertsActiveDataSize, and DeletesActiveDataSize determine how many inserts, updates, upserts, and deletes, respectively, should be executed before releasing and then requiring the lock on the data object being modified. This keeps the operation from holding the data object lock for long periods of time when there are view sets open on this data object.

Default: 50


	

ListenPort

	
For SSL: <ListenPort>SSLListenPort</ListenPort>

See Section 23.9.3, "Configuring Secure Socket Layer."

Default: ListenPort


	

MaxDBNodeFailoverRetries

	
Used in Oracle RAC High Availability configuration. Indicates the number of retries Oracle BAM Server attempts in an event of an Oracle RAC failover.

Default: 5


	

MTTimerThreadPoolSize

	
Oracle BAM has a timer implementation that dispatches timer events using a thread pool. This allows timer events to be processed in parallel. This property determines the thread pool size for this timer implementation.

Default: 5


	

ODIAgentHost

	
The IP address or hostname of the server where the Oracle Data Integrator agent is running. See Section 23.3.6, "Configuring Oracle Data Integrator Integration Properties" for more information.

Default: localhost


	

ODIAgentPort

	
The TCP port on which the Oracle Data Integrator agent is listening. See Section 23.3.6, "Configuring Oracle Data Integrator Integration Properties" for more information.

Default: 20910


	

ODIPassword

	
The encoded Oracle Data Integrator password. See Section 23.3.6, "Configuring Oracle Data Integrator Integration Properties" for more information.

Default: SUNOPSIS


	

ODIUser

	
The user that executes the scenarios in Oracle Data Integrator. See Section 23.3.6, "Configuring Oracle Data Integrator Integration Properties" for more information.

Default: SUPERVISOR


	

ODIWorkRepositoryName

	
The name of the Oracle Data Integrator work repository database. See Section 23.3.6, "Configuring Oracle Data Integrator Integration Properties" for more information.

Default: WORK_DEV


	

oracle.bam.common.messaging.util.
MessageConsumerRegistryQueuedPusher_
CorePoolSize

	
Indicates how many threads to keep in Message Registry Thread Pool when idle.

Default: 20


	

oracle.bam.common.messaging.util.
MessageConsumerRegistryQueuedPusher_
KeepAliveTime

	
Amount of time (in seconds) to keep an idle thread in the Message Registry Thread Pool.

Default: 60


	

oracle.bam.common.messaging.util.
MessageConsumerRegistryQueuedPusher_
MaximumPoolSize

	
Maximum number of threads in the Message Registry Thread Pool.

Default: 100


	

oracle.bam.common.messaging.util.
MessageConsumerRegistryQueuedPusher_
MaximumQueueSize

	
Maximum number of messages that can be queued in the Message Registry Thread Pool.

Default: 30


	

RecordsLimitForEmail

	
The number of rows allowed in a List view or Columnar report used in an email attachment before a limit error is displayed. Attachments containing reports can become large because they include data compared to a report link that accesses the report and data on Oracle BAM Server.

Default: 1000


	

RecordsLimitForSaveOffline

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: 0


	

RecordsLimitForValueBrowser

	
Number of values that are presented in values browser for constructing filter expressions.

Default: 50


	

ReportCache.ViewSets.ThreadPool.CoreSize

	
Number of threads to keep in Report Cache Thread Pool when idle.

Default: 5


	

ReportCache.ViewSets.ThreadPool.
KeepAliveTimeInSecs

	
Amount of time (in seconds) to keep an idle thread in the Report Cache Thread Pool.

Default: 20


	

ReportCache.ViewSets.ThreadPool.MaxSize

	
Maximum number of threads in the Report Cache Thread Pool.

Default: 100


	

ReportCache.ViewSets.ThreadPool.
QueueSize

	
Maximum no. of messages that can be queued in the Report Cache Thread Pool.

Default: 30


	

ReportCacheChannelName

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: invmjms:topic/oracle.bam.messaging.reportcache.activedata


	

ReportCacheMaxConnections

	
The maximum number of connections allowed by Report Cache to its clients.

Default: 25


	

ReportCacheMaxShutdownWaitInterval

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: 10


	

ReportCachePersistenceManager

	
See Section 23.3.5, "Configuring the Report Cache Persistence Manager" for more information.

Default: FileBasedPersistenceManager


	

ReportLoadingSetting

	
The report loading indicator to be enabled. See Section 23.2.3, "Configuring the Report Loading Indicator" for more information.

Default: on


	

SensorFactory

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: oracle.bam.common.statistics.noop.SensorFactoryImpl


	

ServerName

	
The Oracle BAM Server hostname. See Section 23.2.4, "Configuring the Server Name" for more information.

Default: DEFAULT


	

ServerPort

	
The Oracle BAM Server port number.

Default: DEFAULT


	

UpdatesActiveDataSize

	
InsertsActiveDataSize, UpdatesActiveDataSize, UpsertsActiveDataSize, and DeletesActiveDataSize determine how many inserts, updates, upserts, and deletes, respectively, should be executed before releasing and then requiring the lock on the data object being modified. This keeps the operation from holding the data object lock for long periods of time when there are view sets open on this data object.

Default: 50


	

UpsertsActiveDataSize

	
InsertsActiveDataSize, UpdatesActiveDataSize, UpsertsActiveDataSize, and DeletesActiveDataSize determine how many inserts, updates, upserts, and deletes, respectively, should be executed before releasing and then requiring the lock on the data object being modified. This keeps the operation from holding the data object lock for long periods of time when there are view sets open on this data object.

Default: 50


	

UseDBFailover

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: true


	

ViewSetExpiryTimeout

	
This property is for Oracle BAM internal use only. Do not change it unless instructed to do so by Oracle Support Services.

Default: 120


	

ViewSetSharing

	
See Section 23.3.4, "Configuring Viewset Sharing" for more information.

Default: true















4 Monitoring the SOA Infrastructure

This chapter describes how to monitor recent instances and faults, deployed SOA composite applications, message delivery processing requests, and service and reference binding components in the SOA Infrastructure. All SOA composite applications are deployed to the SOA Infrastructure. It also describes how to display details about BPEL process messages that require recovery and how to access the Recovery page of the BPEL process service engine to perform message recovery.

This chapter includes the following topics:

	
Section 4.1, "Monitoring SOA Infrastructure Recent Instances and Faults and Deployed Composites"


	
Section 4.2, "Monitoring Message Delivery Processing Requests"


	
Section 4.3, "Monitoring Service and Reference Binding Components in the SOA Infrastructure"




For more information, see Section 1.2.1, "Introduction to the SOA Infrastructure Application."



4.1 Monitoring SOA Infrastructure Recent Instances and Faults and Deployed Composites

You can monitor the SOA composite applications deployed to the SOA Infrastructure.

To monitor SOA Infrastructure recent instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.




	
	
Select soa-infra.




	
	
Select SOA Infrastructure.











The upper part of the SOA Infrastructure Dashboard page displays the following details:

	
A message indicating that the retrieval of recent instances and faults that are displayed on this page is restricted to the specified time period. This message is displayed if the Restrict display of instances and faults to the last time_period checkbox is selected on the SOA Infrastructure Common Properties page (it is selected by default). The default time period value is 24 hours, but you can change this value. If this checkbox is not selected, all instances and faults (including count metrics) in the SOA Infrastructure since the last purging are displayed.


	
Recent SOA composite application instances, instance IDs, and starting times. By default, only running instances are shown.


	
The status of deployed SOA composite applications and their revision numbers, the number of instances created for each application, and the number of faulted instances in each application. The total number of deployed composites also is displayed in parentheses next to the Show All link.


	
Recent faults and rejected messages, including the error message, whether you can recover from the fault, the time at which the fault occurred, the SOA composite application in which the fault occurred, the location of the fault (service binding component, service component, or reference binding component), the instance ID of the SOA composite application, and a link to log messages describing the fault or rejected message. You can recover from faults identified as recoverable at the SOA Infrastructure, SOA composite application, service engine, and service component levels.

If messages are awaiting recovery from the Recovery page of the BPEL process service engine, a message is displayed at the top of each SOA Infrastructure home page.




[image: Description of gs_soahomepage.gif follows]

Description of the illustration gs_soahomepage.gif






	
Note:

After the SOA Infrastructure is started, it may not be completely initialized to administer incoming requests until all deployed composites are loaded. During SOA Infrastructure initialization, a warning message is displayed at the top of the SOA Infrastructure home page. Do not perform operations such as composite deployment, composite undeployment, and others while this message is displayed. For more information, see Section 3.2.1, "Waiting for SOA Infrastructure Startup Initialization to Complete."










	
If BPEL process messages require recovery from the Recovery page of the BPEL process service engine, the BPEL Message Recovery Required message is displayed at the top of each SOA Infrastructure home page.

[image: Description of bp_bpel_message_recov.gif follows]

Description of the illustration bp_bpel_message_recov.gif



The display of this message recovery information is controlled by the bpelRecoveryStatus and excludeBpelMaxCreationTime keys of the AuditConfig property in the System MBean Browser. This property is accessible from the More SOA Infra Advanced Configuration Properties section of the SOA Infrastructure Common Properties page. By default, the bpelRecoveryStatus key is set to All and the excludeBpelMaxCreationTime key is set to exclude the display of messages requiring recovery in the last five minutes.

	
Perform the following tasks:


	Click This Link...	To...
	
Show Details

	
View a message showing the number of invoke, callback, and activity messages that require recovery from the Recovery page of the BPEL process service engine. Manual recovery is not required if automatic recovery of BPEL messages is enabled. In that case, only exhausted messages must be manually recovered. Click Refresh to recalculate the number of invoke, callback, and activity messages requiring recovery.


	
Go to BPEL Recovery Console

	
Access the Recovery page of the BPEL process service engine to perform message recovery.

You can also access the Recovery page later by selecting Service Engines > BPEL from the SOA Infrastructure menu and clicking the Recovery tab in the resulting page.


	
Set Time Threshold

	
View a message showing the time period for excluding messages that require recovery. By default, this setting excludes the last five minutes of messages. This value is controlled by the excludeBpelMaxCreationTime key of the AuditConfig property on the SOA Infrastructure Common Properties page. To change this value, click Yes to access this property in the System MBean Browser.


	
Disable Alert

	
View a message enabling you to prevent the display of this message recovery information on the Dashboard page. If you click Yes, this message recovery information is not displayed.

To display this information again on the Dashboard page, set the bpelRecoveryStatus key to All for the AuditConfig property in the More SOA Infra Advanced Configuration Properties section of the SOA Infrastructure Common Properties page. For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."











	
In the Recent Composite Instances section, perform the following tasks:

	
Click the Number of Instances link to display a message showing the numbers of running and total instances in the SOA Infrastructure. The link is not displayed by default. To enable this link to be displayed, select the Disable fetching of instance and fault count metrics. Each metric can still be retrieved on demand checkbox in the SOA Infrastructure Common Properties page.

If you selected the Restrict display of instances and faults to the last time_period checkbox on the SOA Infrastructure Common Properties page and specified a time period or accepted the default value of 24 hours, the numbers of running and total instances in the SOA Infrastructure for that time period are displayed. If you did not select this checkbox, all instances and faults in the SOA Infrastructure since the last purging are displayed. Click Recalculate to recalculate the numbers.


	
In the Instance ID column, click a specific instance ID to show the message flow through the various service components and binding components.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
Click Show All below the section to access the Instances page of the SOA Infrastructure.





	
In the Deployed Composites section, perform the following tasks:

	
In the Composite column, click a specific SOA composite application to access its home page.


	
Click Show All below the section to access the Deployed Composites page of the SOA Infrastructure.





	
In the Recent Faults and Rejected Messages section, perform the following tasks:

	
In the Error Message column, click an error message to display complete information about the fault. If the fault is identified as recoverable, click the Recover Now link to perform fault recovery.


	
In the Recovery column, if a fault is identified as recoverable, click Recover to perform fault recovery.


	
In the Composite column, click a SOA composite application to access its home page.


	
In the Fault Location column, click a specific location to access the home page of the service, component, or reference in which the fault occurred.


	
In the Composite Instance ID column, click a composite instance ID to access the flow trace of the message that contains that fault.


	
In the Logs column, click a specific log to access the Log Messages page, with the search criteria prefiltered to display any log messages related to the fault.


	
Click Show All below the section to access the Recent Faults and Rejected Messages page of the SOA Infrastructure.




The lower part of the SOA Infrastructure Dashboard page displays the following details:

	
The number of service components running in the service engines (BPEL process, BPMN process (if Oracle BPM Suite is installed), Oracle Mediator, human workflow, business rules, and spring) and the number of faulted instances for each service engine.

[image: Description of gs_soahomepage3.gif follows]
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A graphical representation of the total number of instances and faults for all SOA composite applications since the SOA Infrastructure was last restarted.




[image: Description of gs_soahomepage2.gif follows]
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In the Name column of the Service Engines section, click a specific service engine to access its home page. If you click Spring Engine, a message is displayed indicating that it cannot be managed.




For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.2.6, "Introduction to Service Engines"


	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section 8.1, "Initiating a SOA Composite Application Test Instance"


	
Section 14.4, "Performing BPEL Process Service Engine Message Recovery"


	
Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files









4.2 Monitoring Message Delivery Processing Requests

You can monitor SOA Infrastructure message delivery processing requests. These are metrics for the message delivery between the service engines, service infrastructure, and binding components. Once a message is handed over to a service engine, the amount of time it takes to process that message (instance processing time) is not captured in these metrics.

To monitor processing requests:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Monitoring > Request Processing.




	
	
Right-click soa-infra.


	
Select Monitoring > Request Processing.











The Request Processing page enables you to monitor the following details:

	
The average request processing time for both synchronous and asynchronous messages, active requests, requests processed, and faulted requests in the service engines and service infrastructure.


	
The average request processing time, requests processed, and errors occurring in service (inbound) and reference (outbound) binding components.




[image: Description of soainfra_requestproc.gif follows]
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In the Service Engines section, click a specific service engine (for example, BPEL Engine) to access details such as recent instances using this service engine, components using this service engine, and recent fault occurrences.




For more information, see the following sections:

	
Section 1.2.5, "Introduction to Binding Components"


	
Section 1.2.6, "Introduction to Service Engines"


	
Section 1.2.7, "Introduction to the Service Infrastructure"









4.3 Monitoring Service and Reference Binding Components in the SOA Infrastructure

You can monitor all service and reference binding components used in all SOA composite applications deployed to the SOA Infrastructure. Services provide the outside world with an entry point to the SOA composite application. The WSDL file of the service advertises its capabilities to external applications. References enable messages to be sent from the SOA composite application to external services in the outside world.

To monitor service and reference binding components in the SOA Infrastructure:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Services and References.




	
	
Right-click soa-infra.


	
Select Services and References.











The Services page displays details about the names and types of the services, the SOA composite applications in which the services are used, the partitions in which the SOA composite applications are deployed, the total number of messages processed, the average processing time, and the number of faults occurring in the services. 

[image: Description of sca_services.gif follows]
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In the Service column, click a specific service to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Partitions column, click a specific partition to access its home page.


	
Click the References tab.

The References page displays details about the names and types of the references, the SOA composite applications in which the references are used, the partitions in which the SOA composite applications are deployed, the total number of messages processed, the average processing time, and the number of faults occurring in the references.

[image: Description of sca_references.gif follows]
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In the Reference column, click a specific reference to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Partitions column, click a specific partition to access its home page.




For more information about services and references, Section 1.2.5, "Introduction to Binding Components."









7 Deploying and Managing SOA Composite Applications

This chapter describes how to deploy and manage SOA composite applications, including managing the states of deployed composites; deploying, redeploying, and undeploying a SOA composite application from Oracle Enterprise Manager Fusion Middleware Control; automating testing of SOA composite applications; managing policies; exporting deployed composites; grouping composites into partitions; and managing BPEL and BPMN monitors.

This chapter includes the following topics:

	
Section 7.1, "Deploying SOA Composite Applications"


	
Section 7.2, "Redeploying SOA Composite Applications"


	
Section 7.3, "Undeploying SOA Composite Applications"


	
Section 7.4, "Managing the State of Deployed SOA Composite Applications"


	
Section 7.5, "Automating the Testing of SOA Composite Applications"


	
Section 7.6, "Managing SOA Composite Application Policies"


	
Section 7.7, "Exporting a Deployed SOA Composite Application"


	
Section 7.8, "Grouping SOA Composite Applications into Partitions"


	
Section 7.9, "Disabling and Enabling BPEL and BPMN Business Monitors"




For information on the following:

	
Creating SOA composite application archives and configuration plans in which you define the URLs and property values to use for test, development, and production environments, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite


	
Deploying with ant scripts, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite


	
Deploying with Oracle WebLogic Scripting Tool (WLST), see Oracle Fusion Middleware WebLogic Scripting Tool Command Reference







	
Note:

If Oracle Enterprise Manager Fusion Middleware Control is run in a single sign-on (SSO)-enabled environment, you are again prompted to enter the user name and password credentials as part of the last step of the Deploy SOA Composite, Undeploy SOA Composite, and Redeploy SOA Composite wizards. This information is only requested once per Oracle Enterprise Manager Fusion Middleware Control session.











7.1 Deploying SOA Composite Applications

You can deploy SOA composite applications from Oracle Enterprise Manager Fusion Middleware Control with the Deploy SOA Composite wizard. You must first create a deployable archive in Oracle JDeveloper or with the ant or WLST command line tool. Use the Deploy SOA Composite wizard to deploy any of the following:

	
A new SOA composite application for the first time.


	
A new revision (for example, 2.0) alongside an older revision (for example, 1.0) without having an impact on the latter. The revision deployed last becomes the new default revision of that composite (unless you specify otherwise at a later step during deployment).


	
A SOA bundle (ZIP file) containing multiple revisions (for example, revisions 2.0, 3.0, and 4.0) of a SOA composite application that has different revisions currently deployed (for example, 1.0). This option enables you to deploy revisions 1.0, 2.0, 3.0, and 4.0 at the same time. The bundle can also contain revisions of different composites. There is no restriction that all revisions must be of the same composite application. There should not be any cross references between the composites in the same bundle. For example, composite A revision 1.0 should not reference composite B revision 1.0.




Deployment extracts and activates the composite application in the SOA Infrastructure. After an application is deployed, you can perform administration tasks, such as creating instances, configuring properties, monitoring performance, managing instances, and managing policies and faults.




	
Note:

If you want to redeploy an existing revision of an application, do not use this wizard. Instead, use the Redeploy SOA Composite wizard. 









To deploy SOA composite applications:

	
Access the Deploy SOA Composite wizard through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Infrastructure Home Page...	From the SOA Composite Menu...
	
	
Select SOA Deployment > Deploy.




	
	
Right-click soa-infra.


	
Select SOA Deployment > Deploy.




	
	
Click the Deployed Composites tab.


	
Above the Composite table, click Deploy.




	
	
Select SOA Deployment > Deploy Another Composite.














	
Note:

You can also access the Deploy SOA Composite wizard by selecting Deploy To This Partition from the Deployment dropdown list on the Manage Partitions page or home page of a specific partition, from the SOA Partition menu at the top of the home page of a specific partition, or by right-clicking a specific partition in the navigator.









The Select Archive page appears.

[image: Description of sca_deploy.gif follows]
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In the Archive or Exploded Directory section, specify the archive of the SOA composite application to deploy. The archive contains the project files of the composite to be deployed (for example, HelloWorld_rev1.0.jar for a single archive or OrderBooking_rev1.0.zip for multiple archives). This information is required.


	
In the Configuration Plan section, optionally specify the configuration plan to include with the archive. The configuration plan enables you to define the URL and property values to use in different environments. During process deployment, the configuration plan is used to search the SOA project for values that must be replaced to adapt the project to the next target environment.


	
Click Next.

The Select Target page appears.

This page lists the Oracle SOA Suite managed server or cluster to which to deploy the SOA composite application archive.


	
Select the partition into which to deploy this SOA composite application. Partitions enable you to logically group SOA composite applications into separate sections. Even if there is only one partition available, you must explicitly select it. Once deployed, a composite cannot be transferred to a different partition.

If you want to deploy a SOA composite application to a partition that does not exist, exit the wizard and create the partition before deploying the composite. You create partitions in the Manage Partitions page, accessible from the SOA Infrastructure menu.

If the server contains no partitions, you cannot deploy composite applications to that server. Also, if the server is not in a running state, you cannot deploy this archive. By default, a partition named default is automatically included with Oracle SOA Suite. You can delete the default partition.




	
Note:

Human workflow artifacts such as task mapped attributes (previously known as flex field mappings) and rules (such as vacation rules) are defined based on the namespace of the task definition. Therefore, the following issues are true when the same SOA composite application with a human workflow task is deployed into multiple partitions:

	
For the same task definition type, mapped attributes defined in one partition are visible in another partition.


	
Rules defined on a task definition in one partition can apply to the same definition in another partition.












If you invoke the Deploy SOA Composite wizard by selecting Deploy To This Partition from the Deployment dropdown list on the Manage Partitions page or home page of a specific partition, the partition to which to deploy is selected. Therefore, the Select Target page is skipped.


	
Click Next.

The Confirmation page appears.


	
Review your selections.


	
Select whether to deploy the SOA composite application as the default revision. The default revision is instantiated when a new request comes in.


	
Click Deploy.

Processing messages are displayed.

At this point, the deployment operation cannot be canceled. Deployment continues even if the browser page is closed.


	
When deployment has completed, the home page of the newly deployed composite revision is displayed automatically. A confirmation message at the top of the page tells you that the composite has been successfully deployed. In the case of a bundle deployment, the Deployed Composites page of the SOA Infrastructure is displayed.




For information about creating configuration plans and deploying applications from Oracle JDeveloper, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.



7.1.1 Deploying SOA Composite Applications with Task Flows

When you deploy a SOA composite application with a task flow Enterprise Resource Archive (EAR) file from Oracle Enterprise Manager Fusion Middleware Control or Oracle WebLogic Server Administration Console to a multiple partition environment, you cannot specify partition details. To specify a partition, modify the hwtaskflow.xml file to include the partition name in the generated EAR file (the project version of the file remains unchanged). This file is located under the TaskForm project adfmsrc directory (for example, HelpDeskRequestTaskFlow\adfmsrc\hwtaskflow.xml).


<hwTaskFlows
 xmlns="http://xmlns.oracle.com/bpel/workflow/hwTaskFlowProperties">
   <ApplicationName>worklist</ApplicationName>
   <LookupType>LOCAL</LookupType>
   <TaskFlowDeploy>false</TaskFlowDeploy>
   <PartitionName>partition2</PartitionName> 





7.1.2 Deploying SOA Composite Applications with ant Scripts and the WLST Command Line Tool

You can also deploy SOA composite applications with ant scripts and the WLST command line tool.

	
For information on deploying with ant scripts, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite


	
For information on deploying with WLST, see Oracle Fusion Middleware WebLogic Scripting Tool Command Reference











7.2 Redeploying SOA Composite Applications

You can redeploy SOA composite applications from Oracle Enterprise Manager Fusion Middleware Control with the Redeploy SOA Composite wizard. Using the Redeploy SOA Composite wizard has the following consequences:

	
A new version of a revision of a currently deployed SOA composite application is redeployed on the same deployment target (for example, old version 1.0 is redeployed as new version 1.0).


	
If the older, currently deployed version of this revision has running instances, you can select whether to change the state of those instances to stale. See Step 6 for a description of the Running Instances section of the Redeploy SOA Composite wizard and limitations on this option.

The instance state is available in the instance listing, and you can access audit and flow trace details.







	
Notes:

	
If you want to maintain multiple revisions of a deployed application (for example, revisions 1.0 and 2.0), do not use this wizard. Instead, use the Deploy SOA Composite wizard.


	
Redeploying multiple SOA composite applications at once is not supported.












To redeploy applications:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Infrastructure Home Page...	From the SOA Composite Menu...
	
	
Select SOA Deployment >Redeploy.

The Select Composite page appears.


	
In the SOA Composite Deployments section, select the SOA composite application revision you want to redeploy, and click Next.




	
	
Right-click soa-infra.


	
Select SOA Deployment > Redeploy.

The Select Composite page appears.


	
In the SOA Composite Deployments section, select the SOA composite application revision you want to redeploy, and click Next.




	
	
Click the Deployed Composites tab.


	
In the Composite table, select a specific SOA composite application. Only one application can be redeployed at a time.


	
Above the Composite table, click Redeploy.




	
	
Select SOA Deployment > Redeploy.














	
Note:

You can also access the Redeploy SOA Composite wizard by right-clicking a partition and selecting SOA Deployment > Redeploy.









The Select Archive page appears.


	
In the Archive or Exploded Directory section, select the location of the SOA composite application revision you want to redeploy.


	
In the Configuration Plan section, optionally specify the configuration plan to include with the archive.


	
Click Next.

The Confirmation page appears.


	
In the Default Revision section, select whether to redeploy the SOA composite application as the default revision.


	
In the Running Instances section, select whether to continue running the current instances of a redeployed SOA composite application.

	
Change states of running instances to stale:

	
Select to change the states of currently running instances to stale after redeployment of the SOA composite application.




	
Note:

Even if the state of a SOA composite application instance becomes stale, the instance states of BPEL process service components included in this composite remain as completed and not as stale. This is done for performance reasons, and is the expected behavior. 













	
Continue instances on redeploy (current instance states will not be changed):




	
Note:

This option is displayed if Oracle BPM Suite is installed in the SOA Infrastructure, and only supported for the deployment of BPM composites. Do not select this option if you are deploying:

	
A SOA composite application from a SOA Infrastructure environment in which Oracle BPM Suite is also installed.


	
A BPM composite that includes a durable BPEL process, regardless of whether that process has been modified. Durable BPEL processes are those that take time to complete execution. Examples of durable BPEL processes are asynchronous processes (which are always durable) and synchronous processes that include a durable activity such as a wait activity.

If you select this option and attempt to redeploy a durable BPEL process, then deployment fails. 












	
Select to continue running instances after redeployment of the BPM composite application. This prevents these instance states from being changed to stale. 

Instances of different service components behave differently after redeployment. Ensure that you understand the following details:








	For...	Description
	
Oracle Business Process Management Notation (BPMN) instances

	
You must manually migrate instances.

BPMN service component instances are displayed as running in Oracle Enterprise Manager Fusion Middleware Control after redeployment. However, to ensure that your redeployed application is running correctly, search for instances with the pending migration state in Oracle BPM WorkSpace and manually migrate these instances to the new component definition. 


	
Oracle BPEL process, decision service (business rule), Oracle Mediator, and human workflow instances

	
Instances are automatically migrated.

Oracle Enterprise Manager Fusion Middleware Control attempts to automatically migrate the instances of these components. If the migration is successful, your SOA composite application is redeployed. However, if some of the following component instances cannot be migrated, redeployment of the entire composite fails. 

	
BPEL instances: This capability is not supported if the composite includes a BPEL process service component that has changed from the previous revision.


	
Oracle Mediator: Checks the new component definition for compatibility. If it is incompatible with the existing component definition, the redeployment of the composite revision fails. However, if at the time of redeployment all Oracle Mediator processes within the running instances of this composite have completed, the definition change has no impact and redeployment is successful. Because Oracle Mediator instances take a short time to complete, their migration does not pose a high risk of redeployment failure.


	
Decision service: If the component definition has changed and is incompatible with the existing component definition, this may cause the redeployment of the composite revision to fail. However, if at the time of redeployment all decision service processes within the running instances of this composite have completed, the definition change has no impact and redeployment is successful. Because decision service instances take a short time to complete, their migration does not pose a high risk of redeployment failure.


	
Human workflow: Changes in human workflow do not impact any existing user task that has been created. Newly created human tasks after redeployment can use a new routing slip.











	
Click Redeploy.

Processing messages are displayed.

At this point, the deployment operation cannot be canceled. Deployment continues even if the browser page is closed.


	
When redeployment has completed, click Close.

When redeployment has completed, the home page of the newly redeployed composite revision is displayed. A confirmation message at the top of the page tells you that the composite has been successfully redeployed.









7.3 Undeploying SOA Composite Applications

You can undeploy SOA composite applications from Oracle Enterprise Manager Fusion Middleware Control with the Undeploy SOA Composite wizard. Using the Undeploy SOA Composite wizard has the following consequences:

	
You can no longer configure and monitor this revision of the application.


	
You can no longer process instances of this revision of the application.


	
The state of currently running instances is changed to stale and no new messages sent to this composite are processed.


	
The instance state of the undeployed composite application is set to stale. The instance state is available in the instance listing, and you can access audit trail and flow trace details.


	
If you undeploy the default revision of the SOA composite application (for example, 2.0), the next active, available revision of the application is automatically designated as the new default (for example, 1.0).


	
A warning message is displayed at the end of this wizard when you undeploy the default composite revision.

If no active revision is available and the default revision is undeployed, your composite may be unable to process new incoming requests. It is recommended that you have at least one active revision of this composite deployed before you undeploy the default revision. 

If you undeploy this revision and no active revisions of this composite are found, a retired revision is automatically designated as the new default revision. A warning message is displayed after this wizard closes. Although all currently executing instances complete normally in retired composites, they cannot process any incoming requests. To process new incoming requests for this composite after the current default revision is undeployed, you must deploy a new revision or reactivate a previously retired revision.







	
Note:

If you want to undeploy and then redeploy an existing revision of this application, do not use this wizard. Instead, use the Redeploy SOA Composite wizard. The Redeploy SOA Composite wizard enables you to redeploy an existing revision of a SOA composite application and remove (overwrite) the older, currently deployed version of the revision.









To undeploy applications:




	
Note:

You can undeploy multiple SOA composite applications together if they are located in the same partition. For information, see Section 7.8, "Grouping SOA Composite Applications into Partitions."









	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Infrastructure Home Page...	From the SOA Composite Menu...
	
	
Select SOA Deployment >Undeploy.

The Select Composite page appears.


	
In the SOA Composite Deployments section, select a specific SOA composite application to undeploy, and click Next.




	
	
Right-click soa-infra.


	
Select SOA Deployment > Undeploy.

The Select Composite page appears.


	
In the SOA Composite Deployments section, select a specific SOA composite application to undeploy, and click Next.




	
	
Click the Deployed Composites tab.


	
In the Composite table, select a specific SOA composite application. Only one application can be undeployed at a time.


	
Above the Composite table, click Undeploy.




	
	
Select SOA Deployment > Undeploy.














	
Note:

You can also access the Undeploy SOA Composite wizard through these additional partition options:

	
Right-clicking a partition and selecting SOA Deployment > Undeploy All From This Partition


	
Selecting Deployment > Undeploy All From This Partition on the partition home page


	
Selecting Deployment > Undeploy All From This Partition for the selected partition from the Manage Partitions page












The Confirmation page appears.


	
If you are satisfied, click Undeploy. You are warned if you are about to undeploy the last remaining revision of a deployed composite application.

Processing messages are displayed.

At this point, the undeploy operation cannot be canceled. Undeployment continues even if the browser page is closed.


	
When undeployment has completed, the SOA Infrastructure Deployed Composites page is displayed automatically. A confirmation message at the top of the page tells you that the composite has been successfully undeployed.







	
Note:

When a partition is deleted, all SOA composite applications in it are automatically undeployed. A message is displayed indicating that all the applications in that partition are to be undeployed.














7.4 Managing the State of Deployed SOA Composite Applications

You can manage the lifecycle state of deployed SOA composite applications from either of two pages:

	
From the Deployed Composites page of the SOA Infrastructure, which lists all SOA composite applications deployed to the SOA Infrastructure


	
From the application home page of a specific SOA composite application (all tabs)




The management tasks that you can perform are based on the page you are on. Table 7-1 provides details.


Table 7-1 Application State Actions

	Action	Perform on the Deployed Composites Page of the SOA Infrastructure?	Perform on the Application Home Page (All Tabs)?
	
Shut Down and Start Up

	
Yes

	
Yes


	
Retire and Activate

	
Yes

	
Yes


	
Set as Default

	
Yes

	
	
No: If only one version of the composite application is set as the default.


	
Yes: If there are multiple versions of the same composite application, this option is visible for all other versions of the same composite expect the one that is the default.





	
Deploy

	
Yes

	
Yes (through the Composite menu by selecting SOA Deployment > Deploy Another Composite)


	
Undeploy

	
Yes

	
Yes (through the Composite menu by selecting SOA Deployment > Undeploy)


	
Redeploy

	
Yes

	
Yes (through the Composite menu by selecting SOA Deployment > Redeploy)


	
Test

	
No

	
Yes


	
Composite Audit Level

	
No

	
Yes


	
Payload Validation

	
No

	
Yes


	
Enable/Disable Business Monitoring

	
No

	
Yes


	
Show WSDL and Endpoint URI (icon)

	
No

	
Yes


	
Show XML Definition (icon)

	
No

	
Yes








See the following section based on the action you want to perform:

	
Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level"


	
Section 7.4.2, "Managing the State of an Application from the SOA Composite Application Home Page"




For more information, see Section 1.2.2, "Introduction to SOA Composite Applications."



7.4.1 Managing the State of All Applications at the SOA Infrastructure Level

You can manage the state of all SOA composite applications from the Deployed Composites page at the SOA Infrastructure level.

To manage the state of all applications at the SOA Infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.




	
	
Click soa-infra.




	
	
Select SOA Infrastructure.











	
Click the Deployed Composites tab.

The Deployed Composites page displays the following details:

	
A utility for searching for a specific SOA composite application by specifying a full or partial composite name and clicking Search. You can also search for SOA composite applications by partition.


	
A list of all SOA composite applications deployed in the SOA Infrastructure, including the partition in which they are deployed, current mode (active or retired), number of instances, number of faulted instances, and last modification date (deployment time, redeployment time, or any composite configuration change). The green dot to the left of the composite name indicates that this is the default revision of the application.




[image: Description of sca_deployedcomps.gif follows]
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Note:

To always see the latest details about deployed SOA composite applications, click the Refresh icon in the upper right corner or navigate away from this page and return to it. 










	
Click Deploy to deploy a new application. For all other options listed above the Composite section, first select the composite application by clicking the column to the left of the name, then select a specific option to perform.

[image: Description of sca_selectinstance.gif follows]
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The following table describes the available options:


	Action	Description
	
Shut Down

	
Shuts down a running SOA composite application revision. Any request (initiating or a callback) to the composite is rejected if the composite is shut down. New incoming requests cannot be processed. All existing instances are allowed to complete as usual (the same as when a composite is retired).

Note: The behavior differs based on which binding component is used. For example, if it is a web service request, it is rejected back to the caller. A JCA adapter binding component may do something else in this case (for example, put the request in a rejected table).

This option is displayed when the composite application has been started.


	
Start Up

	
Restarts a composite application revision that was shut down. This action enables new requests to be processed (and not be rejected). No recovery of messages occurs.

This option is displayed when the composite application has been stopped.


	
Retire

	
Retires the selected composite revision. If the process lifecycle is retired, you cannot create a new instance. Existing instances are allowed to complete normally.

An initiating request to the composite application is rejected back to the client. The behavior of different binding components during rejection is as described for the shut down option.

A callback to an initiated composite application instance is delivered properly.

This option is displayed when the composite application is active.

Note the following details when you attempt to retire the default composite revision, or have already retired a default composite revision. A warning page is also displayed with these details.

	
When you attempt to retire the default composite revision, if another active revision of the composite is found, it is designated as the new default revision. If there are multiple active revisions, the active composite that was most recently the default revision (based on the time stamp) is designated as the default revision. If you then re-activate the retired revision, it does not automatically become the default revision again. You must explicitly make it the default revision again.


	
If you retire the default composite revision and no active revision of this composite is found, a new default revision is not designated and a warning message is displayed. The retired revision remains the default revision. However, this composite can no longer process any incoming requests. To process new incoming requests for this composite, you must deploy a new revision or re-activate one of the previously retired revisions.





	
Activate

	
Activates the retired composite application revision. Note the following behavior with this option:

	
All composite applications are automatically active when deployed.


	
Other revisions of a newly deployed composite application remain active (that is, they are not automatically retired). If you want, you must explicitly retire them.




This option is displayed when the application is retired.


	
Set As Default

	
Sets the selected composite application revision to be the default. Default revisions are indicated by a green dot in the Composite table. If a new request comes in for a specific composite application revision, that composite application revision is invoked. If a new request comes in without specifying a revision, the default revision is invoked.

The default revision can change when a composite application is retired. The change is based on whether there is another active revision of the composite. For details, see the description for the Retire action in this table. 

The default revision is changed automatically when a default composite application revision is undeployed. 

The default composite revision also changes automatically when you redeploy a composite application. The newly redeployed revision automatically becomes the default revision, unless at the time of redeployment, you specify to keep the previous default revision unchanged. For details, see the description of the Undeploy action in this table. 

Inbound adapters are activated only on the default revision.


	
Deploy

	
Deploys a revision. Deployment activates the composite application in the SOA Infrastructure. Use this selection when you want to deploy:

	
A new SOA composite application for the first time.


	
A new revision (for example, 2.0) of a SOA composite application that has a different revision that is currently deployed (for example, 1.0). This option enables both revisions 1.0 and 2.0 to be deployed at the same time.




If you specify a revision that exists, you receive an error. You must change this revision outside of the Deploy SOA Composite wizard.

For more information, see Section 7.1, "Deploying SOA Composite Applications" and Section 7.8, "Grouping SOA Composite Applications into Partitions."


	
Undeploy

	
Undeploys the selected composite application revision. The consequences of this action are as follows:

	
You can no longer configure and monitor this revision of the composite application.


	
You can no longer process instances of this revision of the composite application.


	
You cannot view previously completed processes.


	
The state of currently running instances is changed to stale and no new messages sent to this composite application are processed.


	
If you undeploy the default revision of the composite application (for example, 2.0), the next available, active revision of the composite application becomes the default (for example, 1.0).

If no active revision is available and the old default revision is undeployed, your composite may be unable to process new incoming requests. It is recommended that you have at least one active revision of this composite deployed before you undeploy the default revision.

If you undeploy the default revision and no active revisions of this composite are found, a retired revision is automatically designated as the new default revision. A warning message is displayed after this wizard closes. Although all currently executing instances complete normally in retired composites, they cannot process any incoming requests. To process new incoming requests for this composite after the current default revision is undeployed, you must deploy a new revision or reactivate a previously retired revision.




Note: Undeploying multiple SOA composite applications at the same time is supported if they are in the same partition.

For more information, see Section 7.3, "Undeploying SOA Composite Applications" and Section 7.8, "Grouping SOA Composite Applications into Partitions."


	
Redeploy

	
Redeploys an existing revision of a SOA composite application. The consequences of this action are as follows:

	
A new version of a revision of a currently deployed SOA composite application is redeployed (for example, old version 1.0 is redeployed as new version 1.0).


	
The older, currently deployed version of this revision is removed (overwritten).


	
If the older, currently deployed version of this revision has running instances, you can select whether to change the state of those instances to stale.




For more information, see Section 7.2, "Redeploying SOA Composite Applications."








For more information, see Section 1.4.3.3, "Introduction to the Lifecycle State of SOA Composite Applications."









7.4.2 Managing the State of an Application from the SOA Composite Application Home Page

You can manage the state of an individual SOA composite application from the application's home page.

To manage the state of an application from the SOA composite application home page:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
Select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











The Dashboard page of the selected SOA composite application is displayed.

[image: Description of sca_helloworld.gif follows]
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Notes:

	
The Total field of the Recent Instances section sometimes does not display the correct number of total instances despite instances having completed successfully. In these cases, click the Refresh icon in the upper right corner to view the actual number of total instances.


	
When the Capture Composite Instance State checkbox is enabled on the SOA Infrastructure Common Properties page, created instances are displayed immediately even if you have defined a constraint that appears to prevent an instance from being displayed immediately (for example, you have defined a flush delay of 10 minutes or specified a batch size of 100 records to write to a database). This is because instance tracking is moved to the immediate mode since the state of the composites must be captured. 


	
After the SOA Infrastructure is started, it may not be completely initialized to administer incoming requests until all deployed composites are loaded. During SOA Infrastructure initialization, a warning message is displayed at the top of the SOA composite application home page. Do not perform operations such as composite deployment, composite undeployment, and others while this message is displayed. For more information, see Section 3.2.1, "Waiting for SOA Infrastructure Startup Initialization to Complete."













	
From the list of options at the top of the page, select a specific action to perform. These options are also displayed at the top of the Instances, Faults and Rejected Messages, Unit Tests, and Policies pages of the SOA composite application.





	Action	Description
	
Shut Down

	
See the table under Step 3 of Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level" for a description of this option.


	
Start Up

	
See the table under Step 3 of Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level" for a description of this option.


	
Retire

	
See the table under Step 3 of Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level" for a description of this option.


	
Activate

	
See the table under Step 3 of Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level" for a description of this option.


	
Test

	
Enables you to initiate a test instance from the Test Web Service page.

Note: This button is disabled when the SOA composite application is stopped or retired. This is because you cannot create an instance for a stopped or retired application. This button is also disabled when there are no web services available for the application. Only composite applications having services with web service bindings can be tested from this page.

For more information, see Section 8.1, "Initiating a SOA Composite Application Test Instance."


	
Settings: Composite Audit Level

	
Sets the level of audit tracking to perform at the SOA composite application level. This setting can override the audit level defined at the SOA Infrastructure level. By default, the value is Inherit, which does not override the SOA Infrastructure level setting.

If you select to set the audit tracking level, the following options are available:

	
Inherit: Logging matches the SOA Infrastructure audit level that you set on the SOA Infrastructure Common Properties page. This is the default setting.


	
Production: Minimal information for SOA composite application instances is collected. For example, the BPEL process and Oracle Mediator service engines do not capture the payload. Therefore, the payload details are not available in the flow audit trails. The BPEL process service engine collects payload details for all activities except assign activities. This level is optimal for most standard operations and testing.


	
Development: Complete information for SOA composite application instances is collected. This option allows both composite instance tracking and payload tracking. This setting may have an impact on performance because the payload is stored at each step in the message flow. This setting is useful for debugging purposes.


	
Off: No logging is performed. Composite instance tracking information and payload tracking information are not collected.




Setting audit level tracking at the SOA composite application level overrides the same tracking set at the SOA Infrastructure level. By default, the settings are the same at the SOA composite application and SOA Infrastructure levels. SOA composite application settings are automatically changed when the global SOA Infrastructure settings are changed. By choosing any other setting at the SOA composite application level, you are overriding the inherited settings.

One form of overriding is when you explicitly select the same local composite value that happens to be the current global value. If the SOA Infrastructure setting is then changed, this specific composite application does not inherit the new value. For example, assume the SOA Infrastructure setting is Off. Therefore, all composite applications have their audit tracking set to Off. Then, you explicitly set composite application XYZ to Off. Then, go to the SOA Infrastructure and change the setting to Production. The tracking levels for all composite applications are now Production; except for XYZ, which is still set to Off.

Note the following impact of instance tracking changes on message flows that span several SOA composite applications (for example, a composite application invoking another composite application through a reference binding component or an event published in one composite application and subscribed to in another composite application).

	
If an intermediate composite application has disabled instance tracking, then a single message flow across multiple composite application instances appears as separate, unconnected flows. For example, assume a message flows through composite applications C1, C2, and C3. C1 and C3 have enabled instance tracking, while C2 has disabled it. Two separate flows for C1 and C3 are displayed in Oracle Enterprise Manager Fusion Middleware Control.


	
Sources or targets of events or messages may not be displayed. For example, assume you have two composite applications: C1 and C2. If C1 has disabled instance tracking, the flow trace does not show the origin of the message flow and makes it appear as if C2 were directly invoked.





	
Settings: Payload Validation

	
Validates the XML schema-based payload at the inbound and outbound points of the composite application revision. If you enable payload validation and there is an invalid payload (that does not follow the schema), a fault is generated for that message.

The exception to this is the response message of a synchronous service. That message is not validated, even with payload validation enabled. The inbound message is still validated; only the outbound message is not.


	
Settings: Enable/Disable Business Monitoring

	
Select an option to invoke a confirmation dialog that displays the current status of the sensors.

	
Disable: Select to disable BPEL sensors for all BPEL components in this SOA composite application.


	
Enable: Select to enable BPEL sensors for all BPEL components in this SOA composite application.




The Enable/Disable Business Monitoring selection is only displayed for composites that have a BPEL service component, regardless of whether that component includes sensors.

When BPEL sensors are disabled at the service engine level, you cannot enable or disable BPEL sensors at the SOA composite application level. You can enable or disable BPEL monitors and sensors at the service engine level in the BPEL Service Engine Properties page.

For more information, see Section 7.9, "Disabling and Enabling BPEL and BPMN Business Monitors" and Section 12.1, "Configuring BPEL Process Service Engine Properties."


	
Show WSDL and endpoint URI (icon)

	
Click to display the end point addresses and WSDLs of all external services for this SOA composite application.

Note: If you are using the Safari Browser to view this information, see Section B.8.1, "Limitation on Using the Safari Browser to View WSDL File Content."


	
Show Composite XML Definition (... icon)

	
Click to show the XML definition of the SOA composite application.








For more information, see the following sections:

	
Section 1.4.3.3, "Introduction to the Lifecycle State of SOA Composite Applications"


	
Section 3.1, "Configuring SOA Infrastructure Properties"









7.4.3 Starting and Stopping a Managed Oracle WebLogic Server on Which the SOA Infrastructure is Deployed in the Middle of BPEL Processing

If you start and stop a managed Oracle WebLogic Server on which the SOA Infrastructure is deployed in the middle of BPEL processing in a SOA composite application, note the following issues: 

	
For synchronous BPEL processes

The whole scenario is synchronous and the instances that are in a running state (after server restart) are pending in the BPEL wait activity. Therefore, the flow thread ends with the server (while sleeping in the wait activity). When the server is restarted, the same instance is not restarted because the flow is synchronous. Therefore, these instances always remain in a running state because no processing can happen on them after server restart.


	
For asynchronous BPEL processes

If server shutdown occurred in the middle of a BPEL invoke activity, the messages received by BPEL are not handled. BPEL does not automatically recover these messages during restart; they must be recovered manually using Facade API calls. For more information about the Facade API, see Chapter 10, "Programmatically Managing SOA Composite Applications."








7.4.4 Setting the Composite Instance Name

You can set the instance name of a SOA composite application during design time for Oracle Mediator and Oracle BPEL Process Manager. For more information, see Section "Setting the Composite Instance Name at Design Time" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.








7.5 Automating the Testing of SOA Composite Applications

You can create, deploy, and run test cases that automate the testing of SOA composite applications. Test cases enable you to simulate the interaction between a SOA composite application and its web service partners before deployment in a production environment. This helps to ensure that a process interacts with web service partners as expected by the time it is ready for deployment to a production environment. You create test cases in Oracle JDeveloper and include them in a SOA composite application that is then deployed and administered from Oracle Enterprise Manager Fusion Middleware Control. You can also create BPEL process service component test cases in the SOA composite application test case.

To automate the testing of SOA composite applications:




	
Note:

Before testing SOA composite applications or BPEL process service components from Oracle Enterprise Manager Fusion Middleware Control, see Chapter "Automating Testing of SOA Composite Applications" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for instructions on creating test cases.









	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.


	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.


	
Click the Unit Tests tab.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.


	
Click the Unit Tests tab.




	
	
Select Unit Test.











The test cases that are displayed were designed in Oracle JDeveloper and included in a deployed SOA composite application.


	
Select the entire test suite or individual tests of a suite to run, and click Execute.

[image: Description of sca_unittest.gif follows]
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You are prompted to create a test.


	
Enter the following values, and click OK.


	Field	Description
	
Test Run Name

	
Enter a name for the test instance. When testing is complete, report details are captured under this name.


	
Timeout

	
Enter a value in seconds in which to complete this test. If the test does not complete within this time limit, then testing is terminated.


	
Number of Concurrent Test Instances

	
Enter the number of test instances to create.








The Test Runs page is automatically displayed for tracking the running tests.

The Test Runs page enables you to track running test cases and view test results. Test suites consist of a logical collection of one or more test cases. Each test case contains a set of commands to perform as the test instance is executed. The execution of a test suite is known as a test run.

[image: Description of sca_unittest2.gif follows]

Description of the illustration sca_unittest2.gif



	
In the Test Run Name column, click a specific test run to display details in the Results of Test Run section. If you want to create more test runs, you can switch back to the Test Cases page at any time.

The Results of Test Run section displays details about the executed test run, such as a test summary and the success rate. Click the Help icon for additional details.


	
View assertion details at the bottom of the page. Assertions enable you to verify variable data or process flow.

[image: Description of sca_unittest3.gif follows]
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Click a composite instance number to view specific test details.

The composite instances created by executing unit test runs are displayed with a yellow square next to the instance ID in the Instances page of a SOA composite application and in the Recent Instances tables of the SOA Infrastructure and SOA composite application. This yellow box distinguishes these instances from test instances created on the Test Web Service page or automatically created by external consumers of the application.




For more information, see the following documentation:

	
Section 1.4.3.4, "Introduction to SOA Composite Application Automated Testing"


	
Chapter "Automating Testing of SOA Composite Applications" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for instructions on creating test cases for SOA composite applications and BPEL process service components in Oracle JDeveloper









7.6 Managing SOA Composite Application Policies

You can attach or detach security policies to and from currently deployed SOA composite applications. Policies apply security to the delivery of messages.




	
Note:

Before attaching policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use in your environment. 









To manage SOA composite application policies:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.


	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.


	
Click the Policies tab.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.


	
Click the Policies tab.




	
	
Select Policies.











The Policies page enables you to attach and detach policies to and from SOA composite applications. The policies table displays the attached policy name, the component to which the policy is attached, the policy reference status (enabled or disabled) that you can toggle, the category (Management, Reliable Messaging, MTOM Attachment, Security, or WS-Addressing), the violations, and the authentication, authorization, confidentiality, and integrity failures since the SOA Infrastructure was last restarted.

[image: Description of sca_policy.gif follows]
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Click Attach/Detach To.

If multiple services or components are available, you are prompted to select the service or component for which to perform the attachment or detachment.


	
Select the component to or from which to attach or detach a policy.

[image: Description of soaapp_policy1.gif follows]
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This invokes a dialog for attaching or detaching policies.

Currently attached policies appear in the Attached Policies section. Additional policies available for attachment appear in the Available Policies section.

[image: Description of soaapp_policy2.gif follows]
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Select policies to attach that are appropriate to your environment.


	
Click Attach.

The attached policy appears in the Attached Policies section.

[image: Description of soaapp_policy3.gif follows]
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Attach additional policies as needed.


	
When you are finished attaching policies, click Validate.


	
If an error message appears, make the necessary corrections until you no longer have any validation errors.


	
Click OK.

The attached policy is displayed in the policies table.

[image: Description of soaapp_policy4.gif follows]
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For more information about policies, see the following documentation:

	
Section 1.4.3.2, "Introduction to Policies"


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use for your environment






7.6.1 WS-RM Sessions

Multiple requests from Oracle SOA Suite in a single WS-RM session are not currently supported. Each request is in an individual WS-RM session.






7.6.2 Policy Attachments and Local Optimization in Composite-to-Composite Invocations

OWSM supports an Oracle SOA Suite local optimization feature for composite-to-composite invocations in which the reference of one composite specifies a web service binding to a second composite. Local optimization enables you to bypass the HTTP stack and SOAP/normalized message conversions during runtime. Local optimization is not used if the composites are in different containers. If a policy is attached to the web service binding, the policy may not be invoked if local optimization is used.

By default, an OWSM security policy includes a local-optimization property that identifies if the policy supports local optimization. You can view the setting for a policy in Oracle Enterprise Manager Fusion Middleware Control.

To view the local optimization setting for policies:

	
In the navigator, expand the WebLogic Domain folder.


	
Right-click WLS_SOAWC, and select Web Services > Policies.


	
Select a policy and click Export to File.


	
Open the file with a text editor and search for local-optimization to identify the value. This property supports the following values:

	
on: Local optimization is used in the attached policy, and the policy is not applied at runtime.


	
off: Local optimization is not used in the attached policy, and the policy is applied at runtime.


	
check-identity: If a JAAS subject exists in the current thread, local optimization is used. Otherwise, local optimization is not used.







For information on the default local optimization settings for security policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.

You can override the local optimization setting for a policy by adding the oracle.webservices.local.optimization property in the binding section of the composite.xml file. The following values are supported:

	
true (default value): Local optimization is used, and the policy is applied if it is applicable to optimized calls (details are defined in the individual policy file).


	
false: Local optimization is not used, regardless of the default setting for the local-optimization property at the OWSM policy level. This setting forces the policy to be applied.




For example, the following setting of false causes oracle/wss_username_token_client_policy to be applied.


 <binding.ws
port="http://xmlns.oracle.com/CalledBPELProcessApp_
jws/CalledBPELProcess/CalledBPELProcess#wsdl.endpoint(calledbpelprocess_client_
ep/CalledBPELProcess_pt)"

location="http://sta00634.us.oracle.com:8001/soa-infra/services/default/CalledBPEL
Process!1.0/calledbpelprocess_client_ep?WSDL">
      <wsp:PolicyReference URI="oracle/wss_username_token_client_policy"
                           orawsp:category="security"
orawsp:status="enabled"/>
      <wsp:PolicyReference URI="oracle/log_policy"
orawsp:category="management"
                           orawsp:status="enabled"/>
                            <property
name="oracle.webservices.local.optimization">false</property>
    </binding.ws> 


For more information about local optimization, see Section 3.7, "Configuring Local Optimization."








7.7 Exporting a Deployed SOA Composite Application

You can export the contents of a deployed SOA composite application to an archive JAR file. The file can include some or all of the following data:

	
The original design-time composite


	
Postdeployment changes in the rules dictionary and domain value maps (DVMs)


	
Postdeployment property changes such as binding component properties, composite properties such as audit level settings and payload validation status, and policy attachments







	
Notes:

	
SOA composite application exporting is currently only allowed at the individual SOA composite level.


	
Shared metadata is not exported as part of the composite export SOA archive (SAR).












To export a running SOA composite application:

	
Go to the home page of the SOA composite application to export.


	
From the SOA Composite menu, select Export.

The Export Composite page appears.
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Select an option.

	
Option 1: Generates an archive file containing the original design-time composite and the postdeployment details described in Option 2 and Option 3.


	
Option 2: Includes the original design-time composite and postdeployment changes in the rules dictionary and DVMs.


	
Option 3: Includes the original design-time composite and postdeployment property changes such as binding component properties, composite properties such as audit level settings and payload validation status, and policy attachments.


	
Option 4: Generates an archive file containing only the original design-time composite. Options 2 and 3 are not included.





	
If you want to append an additional name to the existing file, select Specify Custom Extension Text. For example, entering MyText to a file named sca_OrderBookingComposite_rev1.0.jar names the exported file as sca_OrderBookingComposite_rev1.0-MyText.jar.


	
Click Export.

The Processing: Export Composite dialog displays the progress of archive file generation. When generation completes, you are prompted to save the file.


	
Click Save File.

A dialog appears for either opening or saving the file to a directory on your local host.




	
Note:

It is important that you click the Save File button. Do not simply close this dialog. Although the composite is exported, you cannot retrieve the actual exported file.










	
Specify the local directory in which to save the JAR file.


	
In the upper right of the Processing: Export Composite dialog, click the x icon to close the dialog.


	
On the Export Composite page, note that the Cancel button has changed to Done.


	
Click Done.

The Export Composite is closed and you are returned to the SOA composite application home page.









7.8 Grouping SOA Composite Applications into Partitions

You can deploy SOA composite applications into separate sections of the SOA Infrastructure known as partitions. Deploying to partitions enables you to logically group SOA composites and perform bulk lifecycle management tasks on all SOA composite applications within a specific partition. Partitions are similar to the domain feature that was part of 10.1.x releases of Oracle BPEL Process Manager. However, you cannot perform specific configuration tasks on partitions, such as restricting login access to a specific partition or configuring partitions (such as configuring threading).

At least one partition is required for deploying SOA composite applications. A default partition named default is automatically included with Oracle SOA Suite.

You can manage partitioning from either of two pages:

	
From the Manage Partitions page of the SOA Infrastructure, which lets you create partitions, delete partitions, and perform bulk lifecycle management tasks on all SOA composite applications in a specific partition


	
From the partition home page, which also enables you to perform bulk lifecycle management tasks on all SOA composite applications in a specific partition







	
Note:

If SOA composite applications using the same inbound resource are deployed to different partitions, it cannot be guaranteed which partition picks up the message for processing. 

For example, assume you are using the file adapter and /home/Directory1 is the inbound directory for the composite SOAComposite1. If this composite is deployed to both Partition1 and Partition2, when a file is placed in /home/Directory1, either the composite in Partition1 or Partition2 may pick up the file.

With the socket adapter, however, there is a limitation that does not permit you to deploy any composite that uses the same inbound port. In that case, an exception is thrown indicating that the inbound port is in use.









Table 7-2 provides more specific details on the tasks you can perform from both pages.


Table 7-2 Partition Management Actions

	Action	Perform on the Manage Partitions Page?	Perform on the Partition Home Page?
	
Create a partition

	
Yes

	
No


	
Delete a partition

	
Yes

	
Yes. Select the SOA Partition menu, then select Delete This Partition.

Note: You can also delete a partition by right-clicking it in the navigator and selecting Delete This Partition.


	
Perform bulk lifecycle management tasks on all composites deployed to a specific partition:

	
Start all


	
Shut down all


	
Retire all


	
Activate all


	
Undeploy all




	
Yes

	
Yes











	
Notes:

	
Partitions are not associated with a particular state such as started, stopped, activated, or retired. Only the composites within the partition are associated with a particular state. Therefore, you cannot start, stop, activate, or retire a partition.


	
After the SOA Infrastructure is started, it may not be completely initialized to administer incoming requests until all deployed composites are loaded. During SOA Infrastructure initialization, a warning message is displayed at the top of the Manage Partitions and Partitions home pages. Do not perform operations such as composite deployment, composite undeployment, and others while this message is displayed. For more information, see Section 3.2.1, "Waiting for SOA Infrastructure Startup Initialization to Complete."












See the following section based on the tasks you want to perform:

	
Section 7.8.1, "Creating and Deleting Partitions"


	
Section 7.8.2, "Performing Bulk Lifecycle Management Tasks on Composites in Partitions"




For more information about partitions, see Section 1.4.3.5, "Introduction to Partitioning of the SOA Infrastructure."



7.8.1 Creating and Deleting Partitions

You can create and delete partitions on the Manage Partitions page. A default partition named default is automatically included with Oracle SOA Suite. You can delete the default partition. You cannot rename existing partitions; only creation and deletion of partitions is supported.

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the Home Page of a Specific Partition...
	
	
Select Manage Partitions.




	
	
From the Related Links list of a specific partition, select Manage Partitions.











The Manage Partitions page displays the following details:

	
The name of each partition, the number of active and retired SOA composite application revisions in each partition, the name of the composites contained in each partition (under the View link), and the total number of running and faulted instances in each partition.


	
A utility for searching for a specific partition. Enter a full or partial partition name and click the Search icon or press the Return key. The search is not case-sensitive.




[image: Description of soaadmin_partition4.gif follows]
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To add a partition, click Create.

The Create New SOA Partition dialog is displayed.

[image: Description of soaadmin_createpartition.gif follows]
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In the Name field, enter a partition name, and click Create.




	
Note:

The name must conform to the following conventions:

	
ASCII letters and numbers are permitted.


	
Underscores (_) are permitted.


	
Hyphens (-) are permitted (except as the first character).


	
Non-ASCII letters are permitted.


	
Spaces are not permitted.




Examples of valid names are mypartition, partition2, dept-a, customer_services, and 22. Examples of invalid names are -part2, /partition, and null or empty names.









You cannot rename an existing partition or later transfer the composite applications you deployed to it to a different partition.

The new partition is displayed in both the navigator under soa-infra and the SOA Partition column of the Manage Partitions page. You can now deploy composites to this partition by selecting Deploy to This Partition from the Deployment dropdown list or right-clicking a specific partition in the navigator and clicking Deploy to This Partition.

When a composite is deployed to a partition, it is displayed beneath the partition in the navigator. Once deployed, a composite cannot be transferred to a different partition.

[image: Description of soaadmin_createpartition2.gif follows]
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To delete a partition, select a specific partition and click Delete. You can also right-click a specific partition in the navigator and click Delete This Partition.

The Delete SOA Partition dialog is displayed. Note the following:

	
If you want to re-create some of your composite deployments in another partition, you can export those composites to a JAR file before you delete this partition. 


	
Before deleting the selected partition, all SOA composite application revisions in the partition are undeployed. The states of all undeployed instances of these revisions become stale.







	
Note:

You must have at least one partition. If you delete all partitions, you cannot deploy a SOA composite application.
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Click Delete (Undeploy All Composites).

All composites that were deployed in the partition are undeployed and no longer appear in the navigator. The partition is then deleted from both the navigator under soa-infra and the SOA Partition column of the Manage Partitions page.







For information about performing bulk lifecycle management tasks from the Composites Control and Deployment lists, see Section 7.8.2, "Performing Bulk Lifecycle Management Tasks on Composites in Partitions."

You can also create partitions with the Oracle WebLogic Scripting Tool (WLST) and ant commands. For information, see Oracle Fusion Middleware WebLogic Scripting Tool Command Reference and Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.






7.8.2 Performing Bulk Lifecycle Management Tasks on Composites in Partitions

You can perform bulk lifecycle management tasks on all SOA composite applications in a specific partition on the Manage Partitions page, on the home page of a specific partition, and from the menu that is displayed when you right-click a partition in the navigator.

Bulk lifecycle management tasks impact not one, but many, composites at once. If a composite has running instances and a lifecycle changing operation is performed on the composite, the instances may not complete. For information about how different lifecycle operations impact the composite instances, see Step 3 of Section 7.4.1, "Managing the State of All Applications at the SOA Infrastructure Level."

To perform bulk lifecycle management tasks on all SOA composite applications in a specific partition:

	
Access either page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Manage Partitions.




	
	
Under soa-infra, select a specific partition.














	
Note:

As a shortcut, you can also right-click a specific partition in the navigator to display a menu for selecting the bulk lifecycle management actions described in this section. For more information about this menu, see Step 3 of Section 2.2.3, "Navigating Through the Partition Home Page and Menu."









Two dropdown lists that are displayed on either page enable you to perform bulk lifecycle management actions:

	
Composites Control list


	
Deployment list




On the home page of a specific partition, these lists are displayed at the top of the page.
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On the Manage Partitions page, these lists are displayed above the SOA Partition table:

[image: Description of soaadmin_partition4.gif follows]
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Note:

You can also select to deploy composites to a partition and perform bulk lifecycle management tasks by selecting the SOA Partition menu at the top of the partition home page.










	
To perform one of the following bulk lifecycle management tasks for all SOA composite applications contained in the selected partition, select the Composites Control list:

	
Start all composites.


	
Shut down all composites.


	
Activate all composites.


	
Retire all composites.




[image: Description of soaadmin_comp_control.gif follows]
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Select an operation to perform.

A dialog is displayed that prompts you to confirm your selection. When the operation completes, a confirmation message is displayed at the top of the page.





	
To perform one of the following management tasks, select the Deployment list:

	
Specify a composite to deploy to this partition. This selection invokes the Deploy SOA Composite wizard where you specify a composite revision to deploy.


	
Undeploy all composites in this partition. 

A dialog is displayed that prompts you to confirm your selection. When the operation completes, a confirmation message is displayed at the top of the page.
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7.9 Disabling and Enabling BPEL and BPMN Business Monitors

The term business monitoring comprises different types of sensors that can be defined for some types of SOA components, such as the following:

	
BPEL sensors: Enable you to create sensors in BPEL faults, activities, and variables.


	
BPEL Monitors: Enable you to capture BPEL process metrics that are sent to Oracle BAM Server, and then used for analysis and graphic display.


	
BPMN measurements: Enable you to measure a business indicator at a certain point in the process or in a section of the process.




At the SOA composite application level, you set the same status for all sensors defined for all types of service components comprising the selected composite. You cannot selectively enable or disable sensors defined for a specific type of service component for just one composite. However, you can globally disable service component-type specific sensors for all composites in the respective BPEL Service Engine Properties page or BPMN Service Engine Properties page.

By default, BPEL and BPMN sensors defined in SOA composite applications are enabled. Disabling sensors means that sensor values are not captured during runtime. For example, this results in the values not being displayed in the Sensor Values section of the BPEL audit trail.

To disable sensors at the service engine level:

	
Access the BPEL Service Engine Properties page by following the steps in Section 12.1, "Configuring BPEL Process Service Engine Properties."


	
Select the Disable BPEL Monitors and Sensors checkbox.


	
Click Apply.


	
Access the BPMN Service Engine Properties page by following the steps in Section 37.1, "Configuring BPMN Process Service Engine Properties."




	
Note:

The BPMN Service Engine Properties page is only displayed if Oracle BPM Suite is installed.










	
Select the Disable BPMN Measurements checkbox.


	
Click Apply.




To disable or enable sensors at the SOA composite application level:

	
Go to the home page of the SOA composite application in which you want to disable or enable sensors.


	
From the Settings menu, select Enable/Disable BPEL Business Monitoring. This selection is only displayed for composites that have at least one BPEL or BPMN service component, regardless of whether those components include sensors.

[image: Description of sca_sensordis.gif follows]
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A dialog is invoked that displays the current status of sensors and enables you to change that status. The dialog only displays the options applicable to the component types present in the selected composite. For example, if the composite contains only BPEL components and not BPMN components, you see only the option to set the status of BPEL sensors.

The following steps describe the types of dialogs that can be displayed and the available actions.

	
If sensors are disabled at both service engine levels, the message Disabled Globally is displayed for each. You cannot select Enable All or Disable All in this dialog. Both buttons are disabled.

[image: Description of sca_sensordis3.gif follows]
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In addition, if sensors are disabled at the BPEL service engine level and the BPMN service engine does not appear because Oracle BPM Suite is not installed, you cannot select Enable All or Disable All in this dialog. Both buttons are disabled.
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If sensors are not disabled at the composite level, checkmarks are displayed. If sensors are also not disabled at both the BPEL and BPMN service engine levels, the message Disabled Globally does not display.

Click Disable All to disable all types of sensors defined for service components that comprise the selected composite. (If sensors are disabled at the service engine level, they remain disabled.)
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If sensors are disabled at a specific service engine level, the sensor status you set for those types of sensors at the composite application level only takes effect when the corresponding Disable BPEL Monitors and Sensors or Disable BPMN Measurements checkbox in the service engine Properties page is deselected.

For example, if sensors are disabled at the BPMN service engine level (as shown below), and you select Enable All for all sensors at the selected composite level, that status is only applied to other types of sensors, such as BPEL. BPMN sensors and monitors remain disabled. However, if you later change the BPMN service engine setting, BPMN sensors are automatically enabled in this composite.
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If sensors are disabled at the composite level, no checkmark is displayed. Click Enable All to enable all types of sensors defined for service components that comprise the selected composite. (Sensors disabled at the service engine level remain disabled until you change the service engine level setting.) Because the composite does not include BPMN service components, BPMN is not displayed.
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After you select an action, an inline message is displayed in the page confirming that sensors were enabled or disabled.

For more information about BPEL sensors and monitors, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.

For more information about BPMN measurements, see Oracle Fusion Middleware Modeling and Implementation Guide for Oracle Business Process Management.









14 Managing BPEL Process Service Components and Engines

This chapter describes how to manage BPEL process service components and service engines, including recovering from service component and service engine faults, managing service component policies, performing BPEL process message recovery, and storing instance and callback message data in Oracle Coherence cache.

This chapter includes the following topics:

	
Section 14.1, "Recovering from BPEL Process Service Component Faults"


	
Section 14.2, "Managing BPEL Process Service Component Policies"


	
Section 14.3, "Recovering from BPEL Process Service Engine Faults"


	
Section 14.4, "Performing BPEL Process Service Engine Message Recovery"


	
Section 14.5, "Storing Instance and Callback Message Data in Oracle Coherence Distributed Cache on Oracle Exalogic Platforms"




For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.2.6, "Introduction to Service Engines"






14.1 Recovering from BPEL Process Service Component Faults

You can monitor and perform individual and bulk fault recoveries for BPEL process service components that are identified as recoverable. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault.

To recover from BPEL process service component faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Select the BPEL process service component in the Component Metrics section.


	
Click Faults.

The Faults page displays the following details:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Faults that occurred in the service component, including the fault ID, error message, whether you can recover from the fault, time at which the fault occurred, service component instance ID, activity in which the fault occurred, and a link to a log file describing the fault.




[image: Description of bpel_comp_faults.gif follows]
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BPEL process service component faults identified as recoverable can be recovered.


	
Select faults for recovery using one of the following methods. Fault recovery selection at the BPEL process service component level equals the SOA Infrastructure level, SOA composite application level, and Oracle Mediator service component level.


	For...	Then...
	
Single fault recovery

	
There are three options from which to choose for single-fault recovery:

	
Click the row of the fault that has been identified as recoverable. With the row highlighted, select a specific action from the Recovery Action list, as described in Step 6.


	
In the Recovery column, click the Recover link to access the Faults page of the instance audit trail to perform fault recovery.


	
In the Error Message column, click the message of a fault that has been identified as recoverable. This displays complete fault details, including the fault ID, fault time, fault location, fault type, and error message text. A Recover Now option is displayed for recoverable faults. Click Recover Now to access the Faults page of the instance audit trail to perform fault recovery.





	
Bulk fault recovery

	
There are two options from which to choose for bulk-fault recovery:

	
Use Shift+Click or Control+Click to select specific faults in the rows.

or


	
From the Select menu, choose Select All Recoverable. Then use Shift+Click or Control+Click to deselect the faults to not include in the recovery operation.

Then:


	
Select an action from the Recovery Action list, as described in Step 6.

Note: Only the actions applicable to all selected faults are available.





	
Recovery of all faults

	
	
From the Select menu, choose Select All Recoverable.


	
Select an action from the Recovery Action list, as described in Step 6.

Note: Only the actions applicable to all selected faults are available.














	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.










	
Select an action from the Recovery Action list.


	Action	Description
	
Retry

	
Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.


	
Abort

	
Terminates the entire instance.


	
Replay

	
Replays the entire scope activity again in which the fault occurred.


	
Rethrow

	
Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.


	
Continue

	
Ignores the fault and continues processing (marks the faulted activity as a success).








	
Perform the following additional monitoring tasks from within the faults table:

	
Click the Show only recoverable faults checkbox to display only faults from which you can recover.


	
From the Fault Type list, select to display all faults, system faults, business faults, or Oracle Web Services Manager (OWSM) faults in the faults table. Click the Help icon for a description of these fault types.


	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Rejected messages do not have a component instance ID.


	
In the Logs column, click a link to access the Log Messages page with filtered messages specific to that instance.







For more information, see the following documentation:

	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section 8.4.1, "Examples of Fault Recovery for BPEL Processes"


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite


	
Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files









14.2 Managing BPEL Process Service Component Policies

You can attach and detach policies to and from BPEL process service components in currently deployed SOA composite applications. Policies apply security to the delivery of messages. Oracle Fusion Middleware uses a policy-based model to manage web services.




	
Note:

Before attaching policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use in your environment.









To manage BPEL process service component policies:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Select the BPEL process service component in the Component Metrics section.


	
Click Policies.

The Policies page enables you to attach and detach policies to and from BPEL process service components. The Policies section displays the attached policy name, the policy reference status (enabled or disabled) that you can toggle, the category (Management, Reliable Messaging, MTOM Attachment, Security, or WS-Addressing), the violations, and the authentication, authorization, confidentiality, and integrity failures since the SOA Infrastructure was last restarted.
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Click Attach/Detach.

If multiple components are available, you are prompted to select the service or component for which to perform the attachment or detachment.


	
Select the service or component to which to attach or detach a policy.

This invokes a dialog for attaching or detaching policies.

Policies currently attached appear in the Attached Policies section. Additional policies available for attachment appear in the Available Policies section.


	
Select to attach policies appropriate to your environment.


	
Click Attach.


	
When you are finished attaching policies, click Validate.


	
If an error message appears, make the necessary corrections until you no longer have any validation errors.


	
Click OK.

The attached policy is displayed in the policies table.




For more information, see the following documentation:

	
Section 1.4.3.2, "Introduction to Policies"


	
Section 7.6, "Managing SOA Composite Application Policies" for the dialogs that are displayed during policy attachment


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use for your environment









14.3 Recovering from BPEL Process Service Engine Faults

You can monitor and perform individual and bulk recoveries of faults occurring in BPEL process service engines that are identified as recoverable. All BPEL process service component faults, regardless of the SOA composite application instance of which they are a part, can be viewed in the BPEL process service engine. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault.

To recover from BPEL process service engine faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPEL.




	
	
Right-click soa-infra.


	
Select Service Engines > BPEL.











	
Click Faults.

The Faults page displays the following details:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Faults that occurred in the service engine, including the fault ID, the error message, whether you can recover from the fault, the time at which the fault occurred, the SOA composite application and service component in which the fault occurred, and the service component instance ID.
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BPEL process service engine faults identified as recoverable can be recovered.


	
Select faults for recovery using one of the following options. As with fault recovery at the SOA Infrastructure level, SOA composite application level, and Oracle Mediator service component level, you can perform single fault recovery, bulk fault recovery, and recovery of all faults. See Step 5 of Section 14.1, "Recovering from BPEL Process Service Component Faults" for instructions on selecting faults to perform these types of recovery.




	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.










	
Select an action from the Recovery Action list.


	Action	Description
	
Retry

	
Retries the instance with an option to provide a retry success action. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.


	
Abort

	
Terminates the entire instance.


	
Replay

	
Replays the entire scope activity again in which the fault occurred.


	
Rethrow

	
Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.


	
Continue

	
Ignores the fault and continues processing (marks the faulted activity as a success).








	
Perform the following additional monitoring tasks from within the faults table:

	
Click the Show only recoverable faults checkbox to only display faults from which you can recover.


	
From the Fault Type list, select to display all faults, system faults, business faults, or OWSM faults in the faults table. Click the Help icon for a description of these fault types.


	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Component column, click a specific service component to access its home page.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Rejected messages do not have a component instance ID.







For more information, see the following sections:

	
Section 1.4.3.1, "Introduction to Fault Recovery" for conceptual details about faults


	
Section 8.4.1, "Examples of Fault Recovery for BPEL Processes"









14.4 Performing BPEL Process Service Engine Message Recovery

You can perform a manual recovery of undelivered invoke or callback messages due to a transaction rollback in the process instance. Recovery of invoke messages applies to asynchronous BPEL processes only. Synchronous BPEL processes return an error to the calling client and are not recoverable from the Recovery page. Recoverable activities are activities that failed and can be recovered. For example, if you are using the file adapter to initiate an asynchronous BPEL process and your system fails while the instance is processing, you can manually perform recovery when the server restarts to ensure that all message records are recovered. 

You can also manage messages that have failed automatic recovery attempts by the BPEL process service engine. To ensure that automatic recovery of these messages is not attempted multiple times, these messages are placed in the exhausted state. You can then perform one of the following actions on these messages:

	
Return them to the automatic recovery queue


	
Never attempt a recovery on them again


	
Attempt to recover them immediately




For example, assume you have a BPEL process that writes to a database adapter. If the database is down, these messages are sent to a recovery queue. Automatic recovery of these messages fails while the database is down. Such messages are marked with the exhausted state so that automatic recovery is not attempted on them again. When the database begins running again, you can reset these messages (return them to the automatic recovery queue) so that an automatic recovery is attempted on them again.

To perform BPEL process service engine message recovery:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Service Engines > BPEL.




	
	
Right-click soa-infra.


	
Select Service Engines > BPEL.











	
Click Recovery.

The Recovery page displays the following details:

	
A Refresh Alarm Table button for resynchronizing lost, in-memory, Quartz-scheduled jobs in the database. For example, assume a timer on a wait activity or on an onAlarm branch of a pick activity was initiated, but the transaction was rolled back. You can resynchronize these jobs with the BPEL instances residing in the wait activity/onAlarm branch in the database. 


	
A utility for searching for a specific message failure by specifying criteria and clicking Search. Click the Help icon for details.

You can enter the execution context ID (ECID) value in the ECID field. The ECID value enables you to track a message flow that crosses instances of different composite applications. If there are BPEL process messages requiring recovery and the AuditConfig property in the System MBean Browser is set to All (the default value), the following message is displayed in the Trace table of the Flow Trace page:


BPEL Message Recovery Required


Clicking Show Details or the recovery icon that appears next to this message displays a Warning dialog with information about the number of invoke, callback, and activity recoverable message types and the ECID value. You can copy the ECID value from the Warning dialog, paste it into the ECID field, and select the recoverable message type from the Type list as part of creating your search criteria on the Recovery page.

For more information, see Section 13.1, "Monitoring the Audit Trail and Process Flow of a BPEL Process Service Component."




	
Note:

Oracle recommends that you add an index on the DLV_MESSAGE.ECID column of the DLV_MESSAGE table to improve SQL query performance when searching messages for a specific ECID value. This is because if there are too many entries in the DLV_MESSAGE table, the search query may be slow and may also overload the database. For information on adding an index, see Chapter "Creating Indexes" of the Oracle Database Administrator's Guide.










	
Message failures in the service engine, including the conversation ID, whether you can recover from the message failure, the service component and composite application in which the failure occurred, and the time at which the fault occurred. Depending on the state, you can recover these messages immediately, cancel these messages, or reset these messages for automatic recovery.




[image: Description of bpel_se_recov.gif follows]

Description of the illustration bpel_se_recov.gif






	
Notes:

	
You can recover callback messages in resolved and undelivered states. These messages can be displayed for recovery when you execute search criteria in which you select Callback from the Type list and either Resolved or Undelivered from the Message State list. When a callback message first enters the BPEL process service engine, its state is undelivered. When this message is resolved to the target BPEL process instance either through matching a conversation ID or a correlation, the state is switched to resolved. In both of these states, the messages have not yet been consumed. Messages in these two states can be recovered (redelivered into the BPEL process service engine for consumption). In other situations, the callback messages can become stranded in both of these states. Messages in these states can also be recovered. However, there is no guarantee that stranded callback messages always remain in an undelivered state.


	
If you select Invoke from the Type list and Undelivered from the Message State list, and then click Recover, a recovery is performed. However, the Last Modified Date column remains empty for this instance on the Dashboard page of the Oracle BPEL Process Manager service component or service engine. This is the expected behavior. The last modified date is not displayed because the initial Oracle BPEL Process Manager instance (for example, bpel:70004) is created by the first invocation (that is, it is created, but has not yet been modified). The recovery of the undelivered invocation message always creates a new instance (for example, bpel:70005). The previously created instance (bpel:70004) is not used and remains permanently in the same status (the Last Modified Date column is empty). This information is provided for auditing purposes only.


	
The Message States list is applicable only to callback and invoke message type recovery, and not for activity message type recovery.













	
Select a fault in the table.


	
Select one of the following options:


	Action	Description
	
Recover

	
Retries the message in which the fault occurred.

If you select messages in the exhausted state and click this button, an attempt is made to recover them immediately. Should this recovery attempt also fail, the message is returned to the exhausted state. You must then select the message and click Reset to return the message to the automatic recovery queue.

If an asynchronous BPEL process encounters a transaction rollback scenario because of any underlying exception error, it rolls back to the last dehydration activity. If this is a new instance, and a receive activity was the first dehydration activity, the BPEL process service engine creates a recoverable invoke. When you click Recover to recover the invoke, the service engine creates a new instance. This instance may run to completion with no exception error. However, you continue to see the older instance identified as faulted.


	
Mark Cancelled

	
Marks the message so it is never delivered. If you select messages in the exhausted state and click this button, recovery is never attempted on them.

Note: The Recover and Mark Cancelled buttons are enabled in the following situations:

	
For users with the administrator or operator role. These buttons are disabled for users with the monitor role.


	
In the context of a recoverable message. You must select a recoverable message for these buttons to be enabled.




For more information about roles, see Appendix C, "Roles and Privileges."


	
Reset

	
Select to reset exhausted messages to the undelivered state. This returns the message to the automatic recovery queue. The messages that are displayed in the exhausted state disappear from the messages table. If you select Undelivered from the Message State list and click Search, these messages are displayed. Callback messages in the exhausted state can also be reset to the resolved state and still remain recoverable.








Once a message is submitted for recovery, the BPEL process service engine may take time to complete the action. This typically takes less than several seconds. During this time, the message remains visible in the Recovery page. Duplicate attempts to recover the same message in that period are ignored. Refresh the page every few seconds to receive the latest recovery status.




	
Note:

If you define a fault policy in a BPEL process with an ora-retry action and a fault occurs, the BPEL process attempts to recover from the fault the number of times you specified with the retryCount parameter. After this period, the process continues to be in a running state. The status of an activity in the process that has not completed (such as an invoke or receive) shows as pending a manual recovery. This is the expected behavior.









For information about configuring the maximum number of times to attempt an invoke and callback message recovery, see Section 12.4, "Configuring Automatic Recovery Attempts for Invoke and Callback Messages."









14.5 Storing Instance and Callback Message Data in Oracle Coherence Distributed Cache on Oracle Exalogic Platforms

With BPEL processes, a potential performance issue is the number of database interactions required per instance. This factor is the main reason for synchronous transient flows outperforming asynchronous durable flows. You can design around this issue by utilizing synchronous transient flows in situations where low response times are required. However, you may be unable to design this type of flow for business reasons.

If you are running Oracle SOA Suite 11g Release 1 11.1.1.6 on an Oracle Exalogic platform, you can use the distributed cache feature of Oracle Coherence to store instance and callback message data from BPEL processes. This eliminates database reads, thereby reducing the number of database interactions.

Oracle Coherence is a component of Oracle Fusion Middleware that enables organizations to scale mission-critical applications by providing access to frequently used data. Oracle Coherence includes a distributed cache feature that provides scalability for both read and write access. Data is automatically, dynamically, and transparently partitioned across nodes. The distribution algorithm minimizes network traffic and avoids service pauses by incrementally shifting data.

Oracle Exalogic is an integrated hardware and software system designed to provide a platform for a range of application types and varied workloads. Oracle Exalogic is intended for large-scale, performance-sensitive, mission-critical application deployments.




	
Note:

If your environment is not using Oracle Exalogic, Oracle Coherence distributed cache is not available. 









The potential performance gains of using a distributed cache for BPEL processes are as follows:

	
Eliminates the read required for messages (invoke and callback) from the database after initial delivery


	
Eliminates the read required for cube instances after a dehydration point




For more information about Oracle Coherence, see the Oracle Coherence Getting Started Guide and Oracle Coherence Developer's Guide.

For more information about Oracle Exalogic, see the Oracle Exalogic Machine Owner's Guide.


14.5.1 Introduction to the Oracle Coherence Caching Architecture

During dehydration, instance objects are stored in the database using the Java Persistence API (JPA) in a container-managed Enterprise JavaBeans (EJB) transaction. The BPEL process service engine registers the transaction afterCompletion listener for post-transaction processing. Instance objects modified during a transaction are tracked and made available to the afterCompletion listener, which updates the cache. Figure 14-1 provides details about the dehydration process.


Figure 14-1 Dehydration Process

[image: Description of Figure 14-1 follows]

Description of "Figure 14-1 Dehydration Process"





During rehydration, instance objects are read from cache. JTA implementations do not provide XA guarantees for transaction completion notification, and cache eviction may delete the object from cache. JTA implementations account for these two scenarios and address the issues of cache not returning an object or returning an older version of the object. Figure 14-2 provides details about the rehydration process.


Figure 14-2 Rehydration Process

[image: Description of Figure 14-2 follows]

Description of "Figure 14-2 Rehydration Process"





If the instance object is not found in cache, it is loaded from the database. In this scenario, cache does not provide any benefits. However, if you configure the correct amount of cache for your environment, this is not common. The correct cache size varies based on your environment. Therefore, Oracle Coherence configuration must be available and you should be able to configure it.

To identify object staleness, the CACHE_VERSION column in the database table is queried and compared to the corresponding cacheVersion object attribute. If the comparison fails, instance objects are loaded from the database. In this scenario, cache provides no benefit. However, this is a rare occurrence.

Cache lookup usually provides a valid object. In this scenario, performance gain for dehydration and rehydration using cache over direct writes (the default) equals the following:


(database read time + relational to object mapping) minus (Object serialization +
reading from serialized form + Coherence network overhead + query to
database for reading CACHE_VERSION)


It also reduces activity on the database server.

If Oracle Coherence cache is not available due to a network issue, the BPEL process service engine continues to work. If there are no errors, business process instances continue to progress. The BPEL process service engine checks for the availability of cache, resuming its usage when it is back online. While cache is unavailable, warning messages are logged and you may notice a decrease in performance.





14.5.2 Running with Default SOA Cluster Nodes and Coherence Cache Grid Nodes

BPEL process caches are not created on an Oracle SOA Suite cluster node. You must start the BPEL cache servers, which host the BPEL caches, by following the instructions in Section 14.5.5, "Starting the BPEL Process Cache Servers." Start at least four servers to observe an increase in performance.There is no requirement for ordering of an Oracle SOA Suite cluster and BPEL cache servers. The BPEL process service engine continues to function without BPEL cache servers, even when the qualityOfService property is set to CacheEnabled in Oracle Enterprise Manager Fusion Middleware Control.

For more information about Oracle Coherence, see the Oracle Coherence Getting Started Guide and Oracle Coherence Developer's Guide.






14.5.3 Configuring Oracle Coherence Caching

The System MBean Browser property QualityOfService enables you to configure Oracle Coherence for dehydration. You must configure this property on all nodes in the SOA cluster.

To configure Oracle Coherence for dehydration:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select SOA Administration > BPEL Properties.




	
	
Right-click soa-infra.


	
Select SOA Administration > BPEL Properties.











The BPEL Service Engine Properties page is displayed.


	
Click More BPEL Configuration Properties.


	
In the Attributes tab, click QualityOfService.


	
In the Value field, enter a value appropriate to your environment. This change does not require a SOA Infrastructure restart.


Table 14-1 qualityOfService Values

	Value	Description
	
DirectWrite

	
No cache is used for dehydration and rehydration. Read and write operations are done to the database. This is the default setting.


	
CacheEnabled

	
During dehydration, the instance data is stored in the database using an XA data source connection; the placement of objects into cache is part of post-transaction processing.

During rehydration, data is fetched from the cache. If the data is not found (for example, the BPEL process cache servers are not available) or the version is stale, data is read from the database.








	
Click Apply.









14.5.4 Configuring the Storage of Multiple Audit Trail Messages in One Transaction

For asynchronous flows, performance gains can be achieved by storing multiple audit messages in one transaction. To improve performance, you can store multiple audit trail messages (across instances) in a single transaction by setting the System MBean browser property AsynchAuditBatchSize in Oracle Enterprise Manager Fusion Middleware Control. 

Setting this property to an appropriate value reduces audit trail transaction commits. Instead, a commit is only performed when a specified limit is reached.

To configure the storage of multiple audit messages in one transaction:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select SOA Administration > BPEL Properties.




	
	
Right-click soa-infra.


	
Select SOA Administration > BPEL Properties.











The BPEL Service Engine Properties page is displayed.


	
Click More BPEL Configuration Properties.


	
In the Attributes tab, click AsynchAuditBatchSize.


	
In the Value field, enter a value appropriate to your environment. The default value of -1 indicates that there is no audit trail message batching. Each audit message is persisted in its own transaction.

The recommended value range is 5 to 25. For example, if you set this property to 8, this indicates that when eight audit trail messages have accumulated, a transaction is created with these messages and committed to the dehydration store.

This parameter only impacts Oracle Exalogic environments. For other environments, it is not operational.

This change does not require a SOA Infrastructure restart.


	
Click Apply.









14.5.5 Starting the BPEL Process Cache Servers

You must run the start-bpel-cache.sh. script to start the BPEL process cache servers. This script must be run on UNIX platforms. This script is independent of the SOA cluster. It can be on the same node as the SOA cluster nodes or on a completely different host. The only requirement is network connectivity. The Oracle SOA Suite nodes must be reachable from the host on which the BPEL process cache servers are installed.

This script joins an Oracle SOA Suite cluster with a multicast, default address and port. These values match with the corresponding values in the $FMW_HOME/user_projects/domains/domain_name/bin/setDomainEnv.sh or setDomainEnv.bat file.

If you choose multicast for a cluster, but use a different address and port, you can override it in the bpelCacheEnv.sh file by using an environment variable or setting a shell variable. Use the same values for SOA managed servers (setDomainEnv.sh or setDomainEnv.bat).

The default cache configuration for the Oracle SOA Suite cluster must be unicast, and not multicast. For more information about this recommended cache configuration for Oracle SOA Suite clusters for Oracle Coherence, see the Oracle Fusion Middleware High Availability Guide or Oracle Fusion Middleware Enterprise Deployment Guide for Oracle SOA Suite for details.

To start the BPEL process cache servers:

	
Go to the $FMW_HOME/SOA_ORACLE_HOME/bin directory.


	
Open the start-bpel-cache.sh file.


	
Follow the instructions inside this file to create the bpelCacheEnv.sh file and configure various environment variables.

Environment/shell variable names and value formats are described in the initial notes section of the start-bpel-cache.sh file.


	
Ensure that you first set the QualityOfService property to CacheEnabled in Oracle Enterprise Manager Fusion Middleware Control, as described in Section 14.5.3, "Configuring Oracle Coherence Caching."


	
Go to the $FMW_HOME/SOA_ORACLE_HOME/bin directory.


	
Run the following script:


start-bpel-cache.sh














What's New in This Guide for Release 11.1.1.6.x

For Release 11.1.1.6.x, this guide has been updated in several ways. The following table lists the sections that have been added or changed. If a feature was not available in the first release of 11.1.1.6.x, the last columns denote which documentation release contains the update.

For a list of known issues (release notes), see the "Known Issues for Oracle SOA Products and Oracle AIA Foundation Pack" at http://www.oracle.com/technetwork/middleware/docs/soa-aiafp-knownissuesindex-364630.html.


	Sections	Changes Made	11.1.1.6.0	11.1.1.6.1	11.1.1.6.2	11.1.1.6.3
	
Chapter 1 Configuring the SOA Infrastructure

	
	
	
	
	

	
Section 1.4.3, "Management of Oracle SOA Suite and Oracle BPM Suite"


	
Section revised to briefly describe GridLink support. GridLink data sources and multidata sources protect the SOA Infrastructure against database failures. For more information about Gridlink and Oracle SOA Suite, see Section "Configuring High Availability for Oracle SOA Suite" of Oracle Fusion Middleware High Availability Guide.

	
X

	
	
	

	
Section 1.4.3, "Management of Oracle SOA Suite and Oracle BPM Suite"


	
Section revised to briefly describe the Oracle SOA Suite plug-in introspected by Oracle Virtual Assembly Builder. Oracle Virtual Assembly Builder is a tool for virtualizing installed Oracle components, modifying these components, and deploying them to your environment. For more information about the Oracle SOA Suite plug-in, see Oracle Virtual Assembly Builder User's Guide.

	
X

	
	
	

	
Chapter 3 Configuring the SOA Infrastructure

	
	
	
	
	

	
Section 3.1, "Configuring SOA Infrastructure Properties"


	
Section revised to describe the Restrict display of instances and faults to the last time_period checkbox and dropdown list for specifying a time period during which to retrieve recent instances, faults, and count metrics for display on various Oracle Enterprise Manager Fusion Middleware Control pages. By default, this checkbox is selected and the time period duration is set to 24 hours (one day).

	
X

	
	
	

	
Section 3.7, "Configuring Local Optimization"


	
Section added to describe the condition checking performed to determine if local optimization is possible, how to override or force local optimization, and how to set local optimization logging.

	
X

	
	
	

	
Chapter 4 Monitoring SOA Composite Applications

	
	
	
	
	

	
Section 4.1, "Monitoring SOA Infrastructure Recent Instances and Faults and Deployed Composites"


	
Section revised to describe the BPEL Message Recovery Required message that indicates the retrieval of recent instances and faults that are displayed on a page is restricted to a specified time period. This message is displayed if BPEL process messages require recovery from the Recovery page of the BPEL process service engine.

	
X

	
	
	

	
Chapter 6 Monitoring SOA Composite Applications

	
	
	
	
	

	
Section 6.1, "Monitoring SOA Composite Application Recent Instances and Faults and Rejected Messages"


	
Section revised to describe the BPEL Message Recovery Required message that indicates the retrieval of recent instances and faults that are displayed on a page is restricted to a specified time period. This message is displayed if BPEL process messages require recovery from the Recovery page of the BPEL process service engine.

	
X

	
	
	

	
Chapter 7 Deploying and Managing SOA Composite Applications

	
	
	
	
	

	
Section 7.2, "Redeploying SOA Composite Applications"


	
Section revised to describe how the Redeploy SOA Composite wizard enables you to select whether to change the states of currently running instances to stale after redeployment of the SOA composite application or continue running instances upon redeployment. (This prevents these instance states from being changed to stale.)

	
X

	
	
	

	
Section 7.4, "Managing the State of Deployed SOA Composite Applications"


	
Section revised to describe what occurs when you attempt to retire or undeploy the default composite revision.

	
X

	
	
	

	
Chapter 8 Managing SOA Composite Application Instances

	
	
	
	
	

	
Section 8.2, "Monitoring and Deleting SOA Composite Application Instances from the Application Home Page" and Section 8.3, "Monitoring and Deleting SOA Composite Application Instances at the SOA Infrastructure Level"

	
Sections revised to describe how to filter the display of instances by execution state (running, completed, terminated, or stale), fault state (with or without faults), and whether a recovery action is required.

	
X

	
	
	

	
Chapter 9 Managing Database Growth

	
	
	
	
	

	
Section 9.3.4, "Resequenced Message Purge States for Oracle Mediator"


	
Section added that describes how resequenced messages are purged for Oracle Mediator when the purge scripts are run.

	
X

	
	
	

	
Section 9.3.5, "Purging the Instances of a Specific SOA Composite Application"


	
Section added that describes how to purge the instances of a specific SOA composite application and leave the instances of other composites unpurged.

	
X

	
	
	

	
Section 9.4.3.1, "Partitioning Constraints"


	
Section added that describes how to perform complete table partitioning, no table partitioning, or partial partitioning of specific tables with high growth rates.

	
X

	
	
	

	
Section 9.4.6, "Moving Active, Long Running Instances to a Different Partition"


	
Section added that describes how to move active, long running instances to a different partition. A partition can be dropped only when no instances are active.

	
X

	
	
	

	
Chapter 11 Diagnosing Problems with SOA Composite Applications

	
	
	
	
	

	
Chapter 11, "Diagnosing Problems with SOA Composite Applications"


	
Chapter added that describes how to identify Oracle SOA Suite problems early and take the proper corrective actions with the assistance of the WebLogic Diagnostic Framework (WLDF) and the Oracle Fusion Middleware Diagnostic Framework.

	
X

	
	
	

	
Chapter 14 Managing BPEL Process Service Components and Engines

	
	
	
	
	

	
Chapter 14, "Storing Instance and Callback Message Data in Oracle Coherence Distributed Cache on Oracle Exalogic Platforms"


	
Section added that describes how running Oracle SOA Suite 11g Release 1 11.1.1.6 on an Oracle Exalogic platform enables you to use the distributed cache feature of Oracle Coherence to store instance and callback message data from BPEL processes.

	
X

	
	
	

	
Chapter 23 Configuring Oracle Business Activity Monitoring

	
	
	
	
	

	
Section 23.11, "Oracle BAM Configuration Property Reference" (in Table 23-3)

	
Added information about property EDS_Query_Timeout, a configurable timeout for BAM Report queries.

	
X

	
	
	

	
Appendix B Troubleshooting Oracle SOA Suite

	
	
	
	
	

	
Section B.6.1, "Optimizing the Loading of Pages with Instance and Fault Metrics"


	
Section revised to describe the new methods for optimizing the loading of pages with instance and fault metrics.

	
X
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20 Configuring Human Workflow Service Components and Engines

This chapter describes how to configure human task service components and the human workflow service engine, including how to configure the notification mode for messages and actionable addresses. It also describes how to configure task service properties such as the actionable email account name and an alternative authentication provider such as Oracle Internet Directory, Microsoft Active Directory, or Sun iPlanet.

This chapter includes the following topics:

	
Section 20.1, "Configuring Human Workflow Notification Properties"


	
Section 20.2, "Configuring Human Workflow Task Service Properties"


	
Section 20.3, "Configuring Oracle HTTP Server for Task Form Attachments"


	
Section 20.4, "Configuring the Pluggable Notification Service"


	
Section 20.5, "Globally Disabling the Automatic Release Timers for Oracle BPM Worklist Tasks"


	
Section 20.6, "Configuring the Number of Email Notification Messages"


	
Section 20.7, "Configuring Multiple Send Addresses"


	
Section 20.8, "Configuring Notification Retries"


	
Section 20.9, "Configuring the Identity Service"


	
Section 20.10, "Seeding Users, Groups, and Application Roles using LDAP Tools"


	
Section 20.11, "Enabling Case Agnostic Group Names in Human Tasks"


	
Section 20.12, "Configuring Security Policies for Human Workflow Web Services"






20.1 Configuring Human Workflow Notification Properties

You can configure human workflow notification properties, such as setting the notification mode for messages and setting actionable addresses. These properties are used to notify users of changes to the state of a task. Workflow notifications can use three types of addresses:

	
From address: For sending notifications.


	
Actionable address: For receiving actionable responses.


	
Reply to address: For receiving reply notifications.







	
Note:

In the following procedures, you must configure your channel drivers before configuring your workflow notification properties. Ensure that you know all necessary driver addresses before beginning (for example, the incoming IMAP and outgoing SMTP email servers).









To configure human workflow notification properties:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select SOA Administration > Workflow Config > Mailer tab




	
	
Right-click soa-infra.


	
Select SOA Administration > Workflow Config > Mailer tab











The Workflow Notification Properties page appears.

[image: Description of soaadmin_hwf_notifprops.gif follows]

Description of the illustration soaadmin_hwf_notifprops.gif



You now configure Oracle User Messaging Service to send and receive notifications. During configuration, you provide the addresses that are used by human workflow.


	
Click Go to the Messaging Driver Page.


	
Click Configure Driver in the upper right-hand section of the page. This takes you to a page to configure the messaging service driver, including properties such as the following:

	
Incoming IMAP and outgoing SMTP email servers.


	
Outgoing server user names and passwords.


	
List of sender addresses and the default sender address. (The addresses you specify for these properties must match the addresses you specify in the Email: From Address and Email: Actionable Address fields of the Workflow Notification Properties page.)




For handling incorrect email responses, the email driver should be configured to handle incoming mail. This action enables human workflow participants to receive and forward notifications. Messaging drivers support the various messaging transports. For instructions, see Section 26.4.1, "Configuring a Driver."

[image: Description of hwf_ums.gif follows]

Description of the illustration hwf_ums.gif






	
Notes:

	
The hostname and IP address of the email server with which you configure must also be added to the /etc/hosts file of the server on which Oracle SOA Suite is running. For example, if the hostname is xyz.oracle.com and the IP address is aa.bb.cc.dd, then add this information to the /etc/hosts file.


	
After you configure the inbound (IMAP) email server, the outbound (SMTP) email server, or both, you must restart the managed Oracle WebLogic Server on which the SOA Infrastructure is configured for these setting to take effect. 













	
Return to the Workflow Notification Properties page.


	
Specify the mode of the notification service. The possible values are:

	
ALL: The email, short message service (SMS), instant message (IM), and voice channels are configured and notification is sent through any channel that you use.


	
EMAIL: Only the email channel is configured for sending notification messages.


	
NONE: No channel is configured for sending notification messages. This is the default setting.





	
Specify notification channel values:


	Field	Description	Example
	
Email: From Address

	
Enter the outgoing email address from which end users receive notifications.

The address you specify must match the sender addresses and the default sender address that you specify on the Email Driver Properties page of the Oracle User Messaging Service.

Note: You can only receive error messages when the outgoing email address is also configured to receive incoming messages. This ensures that error messages from incorrect or nonexistent email addresses are captured by the server. Even if you configure a separate incoming account in the Email: Reply To Address field, error messages do not appear in the server logs.

	
workflow.notifications@mycompany.com


	
Email: Actionable Address

	
Enter the incoming email address for performing task actions. The actionable email account is the account in which task action-related emails are received and processed by human workflow.

The address you specify must match the sender addresses and the default sender address that you specify on the Email Driver Properties page of the Oracle User Messaging Service.

	
workflow.actions@mycompany.com


	
Email: Reply To Address

	
Enter the address to display in emails sent out from Oracle SOA Suite. It can be a dummy address such as no.reply@myoracle.com or a valid address. If a valid address is provided, and configured in the Messaging Driver page, then if a user replies to actionable emails, human workflow sends an automated email indicating the correct usage. This is another incoming email account.

	
workflow.no.reply@mycompany.com








	
Click Apply.


	
To configure advanced notification properties in the System MBean Browser, click More Workflow Notification Configuration Properties. Properties that are displayed include, but are not limited to, the following. Descriptions are provided for each property.

	
ASNSDriverIMAddress: The address at which to receive incoming instant messages (IMs).


	
CustomNSDriverPropertyNames: Returns custom notification services property names.


	
FaxCoverPageCount: The return number of configured fax cover pages.


	
RetryNotificationMessageThrottle: The number of email notification messages that can be processed during notification retry cycles. For more information, see Section 20.6, "Configuring the Number of Email Notification Messages."





	
Make changes appropriate to your environment.







	
Note:

If your IM message contains content that appears to be actionable, then acting upon the task from within the message does not cause any action to be taken. For example, acting upon the task in the following IM message does not cause any action to occur. 


Help desk request for wfaulk  Task Help desk request for  wfaulk
requires your attention.  NOTE: You can act on the task by
copy-pasting one of following  lines as your response.

RESOLVED : [[NID]] : 
Pt12uRUu9H+Xem4NYS2o7dKDtqNLs42d4YIs8ySO8Gn0ZVYFsb1SQVenRukRE+ 
IcE7c4XDb+tPazvP v9T2iA0qylDg0bTaVxX13HhsrCYAg= : [[NID]] 
UNRESOLVED : [[NID]] : 
xT9l06rbaGRAey+BtgQyJIXk62mkFtCe7ocKxwNLIsPzyE5/7AnGwXlBodEgQxr6 
jorvsw2F54k/C1 r5mvyAJpAp4I4IekOHi4qhQ3eSbBHdzET1IL4F3qV/KZ/BAUsq : 
[[NID]]









For more information about notifications and the User Messaging Service, see the following documentation:

	
Part X, "Administering Oracle User Messaging Service"


	
Part "Using Oracle User Messaging Service" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite "









20.2 Configuring Human Workflow Task Service Properties

You can assign the actionable email account name, specify workflow session time out and custom class path URL properties values, configure dynamic assignment and task escalation functions of the assignment service, and set additional human workflow properties.

Dynamic assignment functions select a particular user or group from either a group, or from a list of users or groups. The selection is made according to criteria specific to the particular dynamic assignment function. 

To configure human workflow task service properties:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select SOA Administration > Workflow Config > Task tab.




	
	
Right-click soa-infra.


	
Select SOA Administration > Workflow Config > Task tab.











The upper part of the Workflow Task Service Properties page displays the field for the actionable email account and the automatically defined dynamic assignment functions.
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Enter the following details.


	Function	Description
	
Actionable Email Account

	
Enter the incoming, actionable email account to use.

The default account name is Default, which is the account configured in Section 20.1, "Configuring Human Workflow Notification Properties." If a different account name is specified in this field, then create and configure the account as described in Section 20.7, "Configuring Multiple Send Addresses."


	
Workflow Service Session Timeout (in minutes)

	
Enter the length of time that users logged in to the Oracle BPM Worklist can remain inactive before their session expires, and they are required to log in again. This also applies to authenticated sessions created through one of the TaskQueryService authentication methods.


	
Workflow Custom Classpath URL

	
Enter the URL class path. This is the class path used by workflow services to look up classes implementing custom dynamic assignment and task escalation functions, custom callbacks, and customized instances of the system resource bundle, WorkflowLabels.properties.

This can be any valid URL (either a local file path or remote URL). The class path can specify either a directory or a JAR file. If the URL specifies a directory, it must include a trailing slash ('/') character.








	
Go to the Dynamic Assignment and Task Escalation Functions section.

The dynamic assignment functions are defined in the following table. You can also create your own functions and register them with the workflow service.


	Function	Type	Description
	
ROUND_ROBIN

	
Dynamic assignment

	
This function picks each user or group in turn. This function uses the initialization parameter MAX_MAP_SIZE. This parameter specifies the maximum number of sets of users or groups for which the function can maintain ROUND_ROBIN counts. The dynamic assignment function holds a list of users and groups in memory for each group (or list of users and groups) on which it is asked to execute the ROUND_ROBIN function.


	
LEAST_BUSY

	
Dynamic assignment

	
This function picks the user or group with the least number of tasks currently assigned to it.


	
MANAGERS_MANAGER

	
Task escalation

	
This function picks the manager's manager for the task.


	
MOST_PRODUCTIVE

	
Dynamic assignment

	
This function picks the user or group that has completed the most tasks over a certain time period (by default, the last seven days). This function uses the initialization parameter DEFAULT_TIME_PERIOD. This parameter specifies the length of time (in days) over which to calculate the user's productivity. This value can be overridden when calling the MOST_PRODUCTIVE dynamic assignment function. Use an XPath function by specifying an alternative value as the third parameter in the XPath function call.








	
Click a function to display its parameters and values in the Parameters section.


	
Click Add to add a function. You are prompted to specify the following:

	
Function name


	
Class path


	
Function parameter name


	
Function parameter value




You cannot add multiple properties to a function on this page. To do that, use the System MBean Browser, which is available by selecting Administration > System MBean Browser from the SOA Infrastructure menu.


	
Click OK.


	
To update the value of a parameter in a function, select the function in the Dynamic Assignment and Task Escalation Functions table.

The parameter value is displayed for editing.


	
Update the value.


	
Expand the Advanced section.

The Advanced section displays the following properties:
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These properties are defined in the following table. 


	Properties	Description
	
Worklist Application URL

	
In the emails that are sent for tasks, the link to Oracle BPM Worklist is read from this property.

This element identifies the URL. Configuring this is useful if the custom Oracle BPM Worklist is built. The tag PC_HW_TASK_ID_TAG in this URL is replaced with the task ID when constructing the URL for the email.


	
Pushback Assignee

	
A task can be pushed back to the previous approver or previous initial assignees. The original assignees do not need to be the approver because they may have reassigned the task, escalated the task, and so on. The possible values for this element are INITIAL_ASSIGNEES and APPROVER.


	
Portal Realm Mapping

	
This property is used when authenticating a user from an HTTP servlet request through the task query service method createContext (for example, when Oracle BPM Worklist runs in a single sign-on (SSO) environment). The HTTP servlet request does not carry information about the identity service realm to which the remote user belongs; this parameter is used to configure which realm to use to authenticate the user in an HTTP servlet request remote user.


	
Task Auto Release Configuration

	
When a task is assigned to a group, application role, or multiple users, a user must first acquire the task before working on it. Once the task is acquired, other users cannot work on the task. If a user acquires a task, but does not act on it, the task is eventually automatically released, allowing other users to acquire the task. This prevents a user from acquiring tasks, then forgetting to work on them. This prevents others from working on them. Task automatic release enables you to configure the time period that elapses after a user acquires a task and before the system automatically releases the task and makes it available again to other users. The automatic release durations can be configured as a default duration and as a percentage of the expiration duration of a given task. The automatic release durations can also be configured differently for tasks of different priority.

For example, assume the task automatic release duration for priority 2 tasks is set to 50%, with a default duration of 12 hours. If a priority 2 task is set to expire in two days, the task is automatically released after one day (which is 50% of the expiration duration). If no expiration date is set for the task, then the task is automatically released after 12 hours (which is the default automatic release duration).








	
Make changes appropriate to your environment.


	
Click Apply.


	
To configure advanced task service properties in the System MBean Browser, click More Workflow Taskservice Configuration Properties. See Step 9 of Section 20.1, "Configuring Human Workflow Notification Properties" for a list of some advanced properties that are displayed.


	
Make changes appropriate to your environment.




For more information about the task service and assignment service, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.






20.3 Configuring Oracle HTTP Server for Task Form Attachments

When adding an attachment to the task form through Oracle HTTP Server (OHS), the location, /ADFAttachmenthelper, must be included in the OHS configuration. For example, add the following to the mod_wl_ohs.config file of OHS, under instance_home/config/OHS/ohs_instance:


<Location /ADFAttachmentHelper>
       SetHandler weblogic-handler
       PathTrim /weblogic
        ErrorPage  http:/WEBLOGIC_HOME:WEBLOGIC_PORT/
</Location>






20.4 Configuring the Pluggable Notification Service

Custom notification service implementations can be plugged in and used instead of the default notification service providers. You can plug in a custom notification service for all channels or selectively for specific channels. For example, the notification service provides the ability to plug in an existing SMS implementation instead of the default SMS notification service.



20.4.1 Pluggable Notification Service Implementation

To plug in a notification service, perform one of the following tasks:

	
Implement interface oracle.bpel.services.notification.ICustomNotificationService


	
Extend the abstract class oracle.bpel.services.notification.AbstractCustomNotificationServiceImpl.




This interface has methods for the following channels:

	
Email


	
Voice


	
SMS


	
Instant messaging (IM)




The plugged-in notification service can override the default providers for one or more channels. When the custom notification service is overriding the default implementation for a subset of channels, the methods corresponding to the other channels (channels that are not overridden) are not called by the notification service. Those methods can just return a null value. Alternatively, the implementation can extend the following abstract class:


oracle.bpel.services.notification.AbstractCustomNotificationServiceImpl


This class provides empty implementations for each of the channels. In that case, the implementation can just extend the methods for the appropriate channels.

The implementation and its dependent classes must be available in the class path of Oracle WebLogic Server.






20.4.2 Pluggable Notification Service Registration

Once the implementation is available, you register it in the System MBean Browser.

To register the pluggable notification service:

	
Log in to Oracle Enterprise Manager Fusion Middleware Control.


	
In the navigator, expand the SOA folder.


	
Right-click soa-infra, and select Administration > System Mbean Browser.

The System MBean Browser is displayed on the right side of the page.


	
Expand Application Defined MBeans > oracle.as.soainfra.config > Server: server_name > HWFMailerConfig > human-workflow.


	
Click the CustomNSDriverPropertyNames property on the right side of the page.


	
Record the values displayed by CustomNSDriverPropertyNames for the All, Voice, Email, Fax, Pager, SMS, and IM properties.


	
Click Return.


	
Click the Operations tab.


	
Click setCustomNSDriverPropertyValue.
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In the Value field for propertyName, enter one of the values you noted down for the All, Voice, Email, Fax, Pager, SMS, and IM properties on the CustomNSDriverPropertyNames page. Note the following details:

	
If you are overriding the default implementation for only the email channel, use the Email value in the Value field for propertyName and the complete class name of your implementation in the Value field for propertyValue.


	
The override for other channels is configured the same way as the email channel.


	
Using the value of the All property in the Value field for propertyName refers to an implementation for all specified channels.





	
In the Value field for propertyValue, provide the complete class name of your implementation.


	
Click Invoke.


	
Restart Oracle WebLogic Server.











20.5 Globally Disabling the Automatic Release Timers for Oracle BPM Worklist Tasks

If automatic release timers are enabled for all Oracle BPM Worklist tasks and this is creating overhead for the database and JVM, you can globally disable the timers.

To globally disable the automatic release timers for Oracle BPM Worklist tasks:

	
Right-click soa-infra, and select Administration > System Mbean Browser.

The System MBean Browser is displayed on the right side of the page.


	
Expand Application Defined MBeans > oracle.as.soainfra.config > Server: server_name > WorkflowConfig > human-workflow > WorkflowConfig.TaskAutoReleaseConfiguration.


	
Select the task priority to modify. Each task instance has a priority.

	
Priority[1]


	
Priority[2]


	
Priority[3]


	
Priority[4]


	
Priority[5]





	
In the Attributes tab, click DefaultDuration.


	
In the Value field, enter P0D to indicate zero days. The default value is P1D (one day).


	
Click Apply.


	
Perform Steps 3 through 6 for any remaining priorities for which you want to disable automatic release.

When complete, the automatic release timers for newly created task instances with the priority you modified are disabled.









20.6 Configuring the Number of Email Notification Messages

You can control the number of email notification messages that can be processed during notification retry cycles with the System MBean Browser RetryNotificationMessageThrottle property. This property prevents the overloading of messages in the queue and reduces the memory size of the notification message payload.

To configure the number of email notification messages:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select SOA Administration > Workflow Config




	
	
Right-click soa-infra.


	
Select SOA Administration > Workflow Config











	
Click More Workflow Notification Configuration Properties.


	
Click RetryNotificationMessageThrottle.


	
In the Value field, enter a value. The default is 200000 messages.


	
Click Apply.









20.7 Configuring Multiple Send Addresses

It may be necessary in some processes to distinguish email notification based on the from address of the email. For example, a human resources BPEL process sends emails with the from address set as HR@yourcompany.com, while a finance BPEL process sends emails with the from address set as finance@yourcompany.com.

To configure multiple send addresses:

	
Log in to Oracle Enterprise Manager Fusion Middleware Control.


	
In the navigator, expand the SOA folder.


	
Right-click soa-infra, and select Administration > System Mbean Browser.

The System MBean Browser is displayed on the right side of the page.


	
Expand Application Defined MBeans > oracle.as.soainfra.config > Server: server_name > HWFMailerConfig > human-workflow.


	
Under the Attributes tab, record the value of the ASNSDrivers attribute. By default, only the Default value is available.


	
Click Return.


	
Click the Operations tab.


	
Click setASNSDriver.


	
For propertyName, enter a value (for this example, EmailFromAddress).


	
For propertyValue, enter a value (for this example, HR@yourcompany.com).


	
For driverName, enter a value (for this example, HR).


	
Click Invoke.


	
Add as many accounts as the number of from addresses needed:

	
For propertyName, enter a value (for this example, EmailFromAddress).


	
For propertyValue, enter a value (for this example, finance@yourdomain.com).


	
For driverName, enter a value (for this example, Finance).





	
Click Invoke.

The ASNSDriver attribute now shows all the accounts created in the previous steps and the getASNSDriverAddresses operation now shows the addresses being used for each of the drivers.


	
Using Oracle WebLogic Server Administration Console, install multiple Oracle User Messaging Service email drivers, one for each from address. For more information, see Chapter 26, "Configuring Oracle User Messaging Service."


	
Configure the email drivers to use the required from address for sending outgoing emails.


	
In Oracle JDeveloper during design time, use HR as the account name to configure an email activity for an HR BPEL process and Finance as the account name to configure an email activity for the finance BPEL process.









20.8 Configuring Notification Retries

Oracle SOA Suite provides support for reliable notifications. The outbound notification creates a notification message with a unique notification ID and stores the message and unique ID in the dehydration store. It then enqueues this unique ID in the JMS queue and commits the transaction. A message-driven bean (MDB) listening on this queue dequeues the message and sends a notification to the user. If there is any notification failure, the notification retries three times. If the retries all fail, it marks this notification as being in error.






20.9 Configuring the Identity Service

By default, the identity service uses the embedded LDAP server in Oracle WebLogic Server as the default authentication provider. You can, however, configure Oracle WebLogic to use an alternative authentication provider, such as Oracle Internet Directory, Microsoft Active Directory, or Sun iPlanet, along with the default authenticator.




	
Note:

Although you can configure an alternative LDAP authentication provider for Oracle BPM Worklist, Oracle Platform Security Services does not support multiple LDAP authentication providers. The provider you want to use for Human Workflow authentication must be the first one listed in the order of authentication providers for Oracle SOA Suite.









This section describes how to add an authentication provider and create users and groups in the authentication provider using either Oracle WebLogic Administration Console or Oracle Directory Services Manager.

This section describes the following topics:

	
Section 20.9.1, "Adding an Authentication Provider"


	
Section 20.9.2, "Creating Users and Groups in the Authentication Provider"


	
Section 20.9.3, "Configuring the Directory Service"







	
Note:

Oracle Fusion Middleware supports providers that enable the User and Role API to interact with custom identity stores.

For more information, see Chapter "Developing with the User and Role API" of the Oracle Fusion Middleware Application Security Guide.











20.9.1 Adding an Authentication Provider

You can add an authentication provider to a security realm using the Oracle WebLogic Server Administration Console.

To add an authentication provider:

	
Log in to the Oracle WebLogic Server Administration Console.


	
Click Security Realms in the Domain Structure pane, and click the name of a realm in the list (myrealm, for example).


	
Click Providers > Authentication.

The Authentication Providers page appears.
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Click New to add a new authentication provider.

The Create a New Authentication Provider page appears.
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In the Name field, type a name for the provider, choose the authenticator type using the Type drop-down list, and click OK.

For example, you can type OIDAuthenticator as the name and choose OracleInternetDirectoryAuthenticator as the type for a provider that authenticates users using the Oracle Internet Directory.

Similarly, you can type a name and choose ActiveDirectoryAuthenticator, iPlanetAuthenticator, openLDAPAuthenticator, or NovellAuthenticator from the list to specify the corresponding authenticator.




	
Note:

When using Oracle Internet Directory as the authentication provider, you must set the orclsslinteropmode attribute to 0 (zero) using Oracle Directory Services Manager. See Section 20.9.3, "Configuring the Directory Service" for more information.










	
On the Providers > Authentication page, click the authenticator that you just created.

The settings for the authentication provider appears.
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From the Control Flag drop-down list, choose SUFFICIENT, and click Save.

This specifies that if a user is authenticated successfully using this authenticator, WebLogic should accept the authentication and not continue to invoke any additional authenticators. If the authentication fails, Oracle WebLogic Server attempts to authenticate the user using the next authenticator in the list.

If you set the Control Flag to SUFFICIENT, ensure that all subsequent authenticators also have the Control Flag set to SUFFICIENT. Likewise, ensure that the Control Flag of the default authenticator is set to SUFFICIENT as well.


	
Click Provider Specific to enter the details for the authenticator server.


	
Enter the provider-specific information about the authentication provider, check the Use Retrieved User Name as Principal checkbox, and click Save.

You must specify the following information. Use the default setting for the rest of the fields.


	Field	Description
	
Host

	
The hostname or IP address on which the authenticator server is running.


	
Port

	
The port number on which the authenticator server is running.


	
Principal

	
The Distinguished Name (DN) of the authenticator server user that Oracle WebLogic Server should use when connecting to the server.


	
Credential

	
The credential (usually a password) used to connect to the authenticator server.


	
User Base DN

	
The base Distinguished Name (DN) of the tree in the LDAP directory that contains users.


	
Group Base DN

	
The base Distinguished Name (DN) of the tree in the LDAP directory that contains groups.


	
Use Retrieved User Name as Principal

	
Specifies whether to use the user name retrieved from the LDAP server as the principal in the subject.


	
User Name Attribute

	
The attribute of an LDAP user object class that specifies the name of the user (for example, UID, CN, MAIL).








If the user attribute being used is other than the default username attribute in the LDAP server, add the following entries to the identity store instance in the jps-config.xml file:


<property name="username.attr" value="desired_attr"/>
<property name="user.login.attr" value="desired_attr"/>


where desired_attr can be one of CN, UID, or MAIL.


	
Click Security Realms > Providers > Authentication to return to the list of authentication providers.


	
Click Reorder.

The Reorder Authentication Providers page appears.
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Select the new authentication provider, click the Up arrow to move the provider to the top of the list, and click OK.

After reordering, the DefaultAuthenticator should appear at the bottom of the list. This action enables the system to handle logins as weblogic that are not typically in an LDAP directory, but still must be authenticated to start the server.

If multiple authentication providers are configured, authentication falls through the list of authenticators according to the control flags set. But the Java Portlet Specification (JPS) provides authorization against only the first entry in the list of providers.









20.9.2 Creating Users and Groups in the Authentication Provider

You can create users and groups in the authentication provider using either Oracle WebLogic Server Administration Console or Oracle Directory Services Manager.



20.9.2.1 Creating Users and Groups Using WebLogic Console

You can create users and groups for a specific provider, and define user and group membership, using the Oracle WebLogic Server Administration Console.

To create a user using WebLogic Console:

	
Log in to the Oracle WebLogic Console.


	
Click Security Realms in the Domain Structure pane, and click the name of a realm in the list (myrealm, for example).


	
Click Users and Groups > Users.

The Users page appears.
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Click New to add a new user. The Create a New User page appears.


	
Enter the required information about the user, and click OK.

You must specify the following information.


	Field	Description
	
Name

	
(Required) The name of the new user.


	
Description

	
A description of the new user.


	
Provider

	
The provider for the user.


	
Password

	
The password associated with the login name for the new user.


	
Confirm Password

	
Confirmation of the password.








The system creates the new user in the specified provider and shows the Users page. You can configure group membership for the user, as required.


	
To specify group membership for the user, click the newly-created user in the list. The settings for the new user page appear.


	
Click Groups to specify group membership for the user.


	
Select a group in the Available list and click the right arrow to move it to the Chosen list.

You can press Ctrl-Click to select multiple groups to move.


	
Click Save.




To create a group using WebLogic Console:

	
Click Users and Groups > Groups.

The Groups page appears.
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Click New to add a new group. The Create a New Group page appears.


	
Enter the required information about the group, and click OK.

You must specify the following information.


	Field	Description
	
Name

	
(Required) The name of the new group.


	
Description

	
A description of the new group.


	
Provider

	
The provider for the group.








The system creates the new group in the specified provider and shows the Groups page. You can configure group membership for the group, as required.


	
To specify group membership for the group (specify parent groups), click the newly-created group in the list. The settings for the new group page appear.


	
Click Membership to add the group to other groups.


	
Select a parent group in the Available list and click the right arrow to move it to the Chosen list.

You can press Ctrl-Click to select multiple groups to move.


	
Click Save.









20.9.2.2 Creating Users and Groups Using Oracle Internet Directory

You can create users and groups using Oracle Internet Directory through the Oracle Directory Services Manager.

To connect to Oracle Internet Directory from the Oracle Directory Services Manager:

	
Launch the Oracle Directory Services Manager by navigating to the following URL using a web browser:


http://host_name:port/odsm/faces/odsm.jspx


where host_name and port are the hostname and the managed server port number on which Oracle Internet Directory is running.


	
Click the Connect to a directory link and choose Create a New Connection in the drop-down menu. The New Connection dialog appears.


	
Select OID as the directory type, enter values in the required fields, and click Connect.

You can specify the following information.


	Field	Description
	
Name

	
The name of the connection.


	
Server

	
(Required) The hostname or IP address of the system on which Oracle Internet Directory is running.


	
Port

	
(Required) The port number on the system on which Oracle Internet Directory is running.


	
SSL Enabled

	
Select to enable Secure Sockets Layer (SSL) communication.


	
User Name

	
(Required) The user name used to log in to Oracle Internet Directory.


	
Password

	
(Required) The password associated with the user name.


	
Start Page

	
The start page after logging into Oracle Internet Directory.








The Oracle Directory Services Manager Home page appears.


	
Click the Data Browser tab. You can use this page to create and remove entries.




To create a domain:

	
Click the Create a new entry button in the Data Tree pane. The Entry Properties page of the Create New Entry wizard appears.


	
Click the Add button to add the required object class for the domain. The Add Object Class dialog appears.


	
Enter the name of the object class. When the correct object class appears in the Name list, select it, and click OK.


	
Repeat Steps 2 and 3 to add all the required object classes for the domain. Generally, top, domain, and orclContainer are the object classes required for a domain.




	
Note:

LDAP operations from Oracle SOA Suite can take a long time to complete if you do not index the correct LDAP attributes. The recommended searchable attribute list for indexing is cn, sn, givenName, uid, manager, title, mail, and telephoneNumber.










	
Click Browse to choose the parent of the domain. The Select Distinguished Name (DN) Path dialog appears.
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Select the parent of the domain and click Select. You can create a hierarchy of entries by selecting the appropriate parent domains.


	
Click Next in the Create New Entry dialog. The Mandatory Properties page of the Create New Entry wizard appears.


	
Enter and select values for the required fields, and click Next.

You can specify the following information.


	Field	Description
	
dc

	
(Required) The domain component.


	
Relative Distinguished Name

	
(Required) The relative distinguished name of the user.








The Status page of the Create New Entry wizard appears.


	
Verify the status of the new domain, and click Finish to create the new domain.




To create a user:

	
Click the Create a new entry button in the Data Tree pane. The Entry Properties page of the Create New Entry wizard appears.


	
Click the Add button to add the required object class for the user. The Add Object Class dialog appears.


	
Enter the name of the object class. When the correct object class appears in the Name list, select it, and click OK.


	
Repeat Steps 2 and 3 to add all the required object classes for the user. Generally, top, person, inetorgperson, organizationalPerson, and orcluser are the object classes required for a user.


	
Click Browse to choose the parent of the user. The Select Distinguished Name (DN) Path dialog appears.
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Select the parent of the user and click Select.


	
Click Next in the Create New Entry dialog. The Mandatory Properties page of the Create New Entry wizard appears.


	
Enter and select values for the required fields, and click Next.

You can specify the following information.


	Field	Description
	
cn

	
(Required) The common name.


	
sn

	
(Required) The surname (last name).


	
Relative Distinguished Name

	
(Required) The relative distinguished name of the user.








The Status page of the Create New Entry wizard appears.


	
Verify the status of the new user, and click Finish to create the new user.


	
Click the entry for the newly-created user in the Data Tree pane. The Person page for the user appears.
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Enter details about the user, and click Apply.




To create a group:

	
Click the Create a new entry button in the Data Tree pane. The Entry Properties page of the Create New Entry wizard appears.


	
Click the Add button to add the required object class for the group. The Add Object Class dialog appears.


	
Enter the name of the object class. When the correct object class appears in the Name list, select it, and click OK.


	
Repeat Steps 2 and 3 to add all the required object classes for the group. Generally, top, groupOfUniqueNames, and orclGroup are the object classes required for a group.


	
Click Browse to choose the parent of the group. The Select Distinguished Name (DN) Path dialog appears.
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Select the parent of the group and click Select.


	
Click Next in the Create New Entry dialog. The Mandatory Properties page of the Create New Entry wizard appears.


	
Enter and select values for the required fields, and click Next.

You can specify the following information.


	Field	Description
	
cn

	
(Required) The common name.


	
Relative Distinguished Name

	
(Required) The relative distinguished name of the group.








The Status page of the Create New Entry wizard appears.


	
Verify the status of the new group, and click Finish to create the new group.


	
Click the entry for the newly-created group in the Data Tree pane. The Group page for the group appears.
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Specify details about the group, and click Apply.




To delete an entry:

	
Select an entry in the Data Tree pane.


	
Click the Delete this entry button in the Data Tree pane.











20.9.3 Configuring the Directory Service

When using Oracle Internet Directory as the authentication provider, you must set the orclsslinteropmode attribute to 0 (zero) using Oracle Directory Services Manager.




	
Note:

If the GUID attribute in the LDAP server is set to a binary value, which cannot be properly handled in the identity service, you must map it to a unique attribute that exists in both the user and group object classes and cannot have a binary value. For example, if the cn attribute is unique, it can be used because it satisfies both of these requirements.

You map GUID to cn in the jps-config.xml file:


<property value="GUID=cn" name="PROPERTY_ATTRIBUTE_MAPPING"/>


For more information about identity store attribute mapping, see Chapter "Developing with the User and Role API" of the Oracle Fusion Middleware Application Security Guide.









To configure the directory service:

	
Launch Oracle Directory Services Manager and choose an Oracle Internet Directory connection using the drop-down list.


	
Click the Data Browser tab.


	
Expand the cn=subconfigsubentry > cn=osdldapd > cn=oid1 nodes.
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In the Attributes page, set the orclsslinteropmode attribute to 0.


	
Click the Apply button.









20.9.4 Customizing the Identity Provider

To customize the identity provider (for example, to handle user and role information stored in home grown solutions), visit the following URL:


http://www.oracle.com/technetwork/middleware/id-mgmt/overview/index.html








20.10 Seeding Users, Groups, and Application Roles using LDAP Tools

This section provides an overview of the procedures required for seeding users, groups, and application roles with LDAP tools.

When you create a task, you assign humans to participate in and act upon the task. Participants can perform actions upon tasks during runtime from Oracle BPM Worklist, such as approving a vacation request, rejecting a purchase order, providing feedback on a help desk request, or some other action. There are three types of participants:

	
Users


	
Groups


	
Application roles




For more information, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.



20.10.1 Changing the Default Password in the Embedded LDAP Server

The password credential is accessible from the Oracle WebLogic Server Administration Console by selecting Security > Embedded LDAP for your domain.

For instructions on changing the default password credential, see Chapter 9, "Managing the Embedded LDAP Server" of Oracle Fusion Middleware Securing Oracle WebLogic Server.






20.10.2 Seeding Users or Groups through the LDAP Browser

To seed users or groups through the LDAP browser:

	
Start an LDAP browser (for example, openLdap browser, ldapbrowser, jXplorer, and so on). See the documentation for your browser for instructions.


	
Connect to the LDAP server by providing the hostname, port number on which the server is running, and the administration user credentials with which to log in.

	
For Embedded LDAP:

	
The default managed server port number is 7001.


	
The administration credential username is cn=admin.


	
The administration credential password is what you set in Section 20.10.1, "Changing the Default Password in the Embedded LDAP Server."







	
For OIDm:

	
The default port number is 3060.


	
The administration username is cn=orcladmin.


	
The administration password is the password for the LDAP server.








	
Seed a user or group through the browser by performing the following steps:

	
Select a parent under which to add a user or group.


	
Select the Edit menu and choose an appropriate option to add a new entry.


	
Enter all required attribute values for the entry.





	
Seed users or groups through the LDIF file by performing the following steps:

	
Select the domain under which to seed the users or groups.


	
Select the LDIF menu and choose to import an LDIF file.


	
In the Import LDIF File dialog, browse for and select the LDIF file and click Import.

Similarly, the users or groups seeded on the LDAP server can be exported to an LDIF file by selecting the Export option from the LDIF menu.





	
Add attributes to the users or groups by performing the following steps:

	
Select an entry for which to add a new attribute.


	
Right-click and choose the option to add a new attribute.


	
In the Add Attribute dialog, provide the name and value of the attribute.

You can only add attributes that are defined in the LDAP server schema.





	
Delete attributes for users or groups by performing the following steps:

	
Select an entry for which to delete a new attribute.


	
Select an attribute from the list of attributes and delete it.












20.10.3 Seeding Application Roles using WLST Scripts

For instructions on using the WebLogic Scripting Tool (WLST) to seed application roles, see Chapter 4, "Infrastructure Security Custom WLST Commands" of Oracle Fusion Middleware WebLogic Scripting Tool Command Reference.






20.10.4 Managing Application Roles in Oracle Enterprise Manager Fusion Middleware Control

This section describes how to manage application roles in Oracle Enterprise Manager Fusion Middleware Control.




	
Note:

Follow these steps to provide nonadministrators with access to Oracle SOA Composer. This is accomplished by assigning the SOADesigner role to users or groups on the Edit Application Role page. The users must exist in the Oracle WebLogic Server realm.









To manage application roles in Oracle Enterprise Manager Fusion Middleware Control:

	
In the navigator, select the appropriate Oracle WebLogic Server under WebLogic Domain > Farm_Domain_name.


	
Right-click the domain name, and select Security > Application Roles.


	
Create an application role by performing the following steps:

	
Select the Create option in the Application Roles page.

The Create Application Role page appears.


	
In the Application list, select the application name (server_name/soa-infra) under which to create a role.


	
Enter the role name, display name, and description for the application role.


	
Add members by selecting Add Role in the Roles section and Add User in the Users section.


	
Click OK to create the application role.





	
Edit application roles by performing the following steps:

	
In the Select Application Name to Search list of the Search section of the Application Roles page, select an appropriate application (for example, soa_server1/soa-infra).


	
To the right of the Role Name list, click the Search icon.

This action lists all the application roles created for that application.


	
Select the application role to edit (for example, select SOADesigner).


	
Click Edit.

The Edit Application Role page appears.


	
Add application roles and groups in the Roles section and users in the Users section (for example, assign SOADesigner to a user to which to provide access to Oracle SOA Composer). The user must be defined in the Oracle WebLogic Server realm.


	
Click OK.





	
Delete application roles by performing the following steps:

	
In the Select Application Name to Search list of the Search section of the Application Roles page, select an appropriate application.


	
To the right of the Role Name list, click the Search icon.

This action lists all the application roles created for that application.


	
Select the application role to delete.


	
Click the Delete button to delete the application role.


	
Click Yes in the Confirmation dialog.














20.11 Enabling Case Agnostic Group Names in Human Tasks

By default, only user names in human tasks are case agnostic (case insensitive). This behavior is controlled by the value of the caseSensitive property in the System MBeans Browser for users, which is set to false by default. Group names in human tasks must be identical to what is seeded in the user directory. However, if you also want group names in human tasks to be case agnostic, you must set the caseSensitiveGroups property to false.

To enable case agnostic behavior for group names in human tasks:

	
Right-click soa-infra, and select Administration > System Mbean Browser.

The System MBean Browser is displayed on the right side of the page.


	
Expand Application Defined MBeans > oracle.as.soainfra.config > Server: server_name > WorkflowIdentityConfig > human-workflow > WorkflowIdentityConfig.PropertyType > caseSensitiveGroups.


	
Click the Operations tab.


	
Click setValue.


	
In the Value field, enter false.


	
Click Invoke.









20.12 Configuring Security Policies for Human Workflow Web Services

A policy set, which can contain multiple policy references, enables you to attach policies globally to a range of endpoints of the same type. Attaching policies globally using policy sets enables you to ensure that all subjects are secured in situations in which multiple users, such as a developer, assembler, or deployer, did not explicitly specify the policies to attach. Policies that are attached using a policy set are considered externally attached.

For example, if the developer did not specify policies in annotations or include policy references in deployment descriptors, then the deployer must attach them or risk a potential security risk. By attaching policies globally to a set of subjects by type, the administrator can ensure that all subjects are secured by default independent of, and even before, deployment. For example, the administrator can define a policy set that attaches a security policy to all web service endpoints in a domain. In this case, any new services added to the domain automatically inherit the security configuration defined in the policy set.

For more information about attaching policies globally using policy sets, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.









8  Managing SOA Composite Application Instances

This chapter describes how to manage SOA composite application instances, including initiating a test instance of an application, monitoring and deleting instances, recovering from faults, and deleting rejected messages.

This chapter includes the following topics:

	
Section 8.1, "Initiating a SOA Composite Application Test Instance"


	
Section 8.2, "Monitoring and Deleting SOA Composite Application Instances from the Application Home Page"


	
Section 8.3, "Monitoring and Deleting SOA Composite Application Instances at the SOA Infrastructure Level"


	
Section 8.4, "Recovering from SOA Composite Application Faults at the SOA Infrastructure Level"


	
Section 8.5, "Recovering from SOA Composite Application Faults in the Application Home Page"


	
Section 8.6, "Deleting Rejected Messages at the SOA Infrastructure Level"


	
Section 8.7, "Deleting Rejected Messages from the Application Home Page"







	
Note:

The procedures in this guide describe how to access Oracle Enterprise Manager Fusion Middleware Control pages from the SOA Infrastructure menu, soa-infra icon in the navigator, SOA Composite menu, and SOA Partition menu. You can also access many pages from the Farm home page. For more information, see Section 2.2.6, "Navigating to the SOA Infrastructure or SOA Composite Application Home Page from the Farm Home Page."











8.1 Initiating a SOA Composite Application Test Instance

This section describes how to initiate a test instance of a deployed SOA composite application.

To initiate a SOA composite application test instance:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the Composite Menu...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.


	
At the top of the page, click Test.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.


	
At the top of the page, click Test.




	
	
Select Test Service > client.














	
Note:

The Test button is disabled in the following situations:

	
The SOA composite application revision is stopped or retired.


	
There are no web services available for the application. Only composites having services with web service bindings can be tested from this page.













	
If the composite includes multiple services, the Test button has a drop-down list to select the service to test.

The Test Web Service page for initiating an instance appears.

This page provides many options for initiating an instance. At a minimum, you must specify the XML payload data to use in the Input Arguments section.

The WSDL file and endpoint URL are populated automatically based on the service you selected to test. The endpoint URL is derived from the WSDL and can be overridden to invoke that service at a different location. If the service selected has multiple ports, a drop-down list is displayed. Otherwise, the port of the current service is displayed.

[image: Description of sca_test_payload.gif follows]
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Accept the default values for these fields or provide values appropriate to your test environment.


	
If you change the WSDL file, click Parse WSDL to reload the WSDL file.

If the WSDL URL does not contain the revision number, it is processed by the default composite application. For example, if there are two revisions of a composite application named HelloWorld, then the following endpoints are exposed by them:

	
http://host:port/soa-infra/services/default/HelloWorld!1.0/client


	
http://host:port/soa-infra/services/default/HelloWorld!2.0/client




However, if the WSDL specified for web service invocation does not contain the revision details (for example, http://host:port/soa-infra/services/default/HelloWorld/client), it is processed by the composite revision that is set as default.


	
Select the operation that you want to test from the Operation menu. The available operations are determined from the WSDL.

To test a RESTful web service, select the GET or POST service port operation. 


	
If you want to edit the endpoint URL, click Edit Endpoint URL and make appropriate changes.

The lower part of the Test Web Service page consists of the Request tab. This tab enables you to specify security, quality of service, HTTP transport, stress testing options, and XML input arguments:
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The Security section includes the following fields for passing security properties with messages.:


	Field	Description
	
WSS Username Token

	
Inserts a WS-Security SOAP header. The Username field is required, and the Password field is optional.


	
HTTP Basic Auth

	
Inserts the username and password credentials in the HTTP transport header. Both the Username and Password fields are required.


	
Custom Policy

	
Uses a custom policy to authenticate the user (specifies the URI for the custom policy). The Username and Password fields are optional.


	
None

	
Select to not specify security credentials. This is the default selection.








When testing RESTful Web services, because the SOAP protocol is not used, the only security options are HTTP Basic Authentication or None.


	
Accept the default values for these fields or provide values appropriate to your test environment.

The Quality of Service section includes the following fields. Oracle Fusion Middleware uses a policy-based model to manage web services. A policy applies behavior requirements to the delivery of messages. This section is not available when testing RESTful web services. For additional details about using the Test Web Service page, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.


	Field	Description
	
WS-RM

	
Select one of the following options for testing WS-Reliable Messaging (RM) protocol policies. Reliable messaging policies support this protocol, which guarantees the end-to-end delivery of messages.

	
WSDL Default: Executes the default behavior of the WSDL. For example, if the WSDL contains a reference to a WS-RM policy, then the policy is enforced. If the WSDL does not contain a reference to a WS-RM policy, then reliable messaging is not tested.


	
None: No policy for WS-RM is tested even if the WSDL contains a reference to a policy.


	
Custom: Enforces a custom policy. Specify the URI of the custom policy in the Policy URI field. If a WS-RM policy is referenced in the WSDL, it is ignored, and the policy specified in the Policy URI field is used instead.





	
MTOM

	
Select one of the following options for testing Message Transmission Optimization Mechanism (MTOM) policies. MTOM policies ensure that attachments are in MTOM format, a format for efficiently sending binary data to and from web services.

	
WSDL Default: Executes the default behavior of the WSDL. For example, if the WSDL contains a reference to an MTOM policy, then the policy is enforced. If the WSDL does not contain a reference to an MTOM policy, then MTOM is not tested.


	
None: No policy for MTOM is tested, even if the WSDL contains a reference to a policy.


	
Custom: Enforces a custom policy. Specify the URI of the custom policy in the Policy URI field. If an MTOM policy is referenced in the WSDL, it is ignored, and the policy specified in the Policy URI field is used instead.





	
WS-Addressing

	
Select one of the following options for testing WS-Addressing policies. WS-Addressing policies verify that SOAP messages include WS-Addressing headers in conformance with the WS-Addressing specification.

	
WSDL Default: Executes the default behavior of the WSDL. For example, if the WSDL contains a reference to a WS-Addressing policy, then the policy is enforced. If the WSDL does not contain a reference to a WS-Addressing policy, then WS-Addressing is not tested.


	
None: No policy for WS-Addressing is tested even if the WSDL contains a reference to a policy.


	
Custom: Enforces a custom policy. Specify the URI of the custom policy in the Policy URI field. If a WS-Addressing policy is referenced in the WSDL, it is ignored, and the policy specified in the Policy URI field is used instead.











	
Accept the default values for these fields or provide values appropriate to your test environment.

The HTTP Transport Options section includes the following fields:


	Field	Description
	
Enable SOAP Action

	
Specifies whether the WSDL soap:operation has a soapAction attribute. This flag is enabled if a soapAction attribute exists. If you do not want to send a request with the SOAP action HTTP header, then clear the checkbox.


	
SOAP Action

	
Displays the soapAction attribute of the WSDL soap:operation, if one exists. You may specify a different SOAP action in this text box.








This section is not available when testing RESTful web services.


	
Accept the default values for these fields or provide values appropriate to your test environment.

The Additional Test Options section includes the following fields. This section provides a simple stress test that simultaneously invokes multiple instances.




	
Note:

This is not a real stress test tool. Therefore, do not enter huge values for both concurrent threads and the number of times to invoke the operation. Doing so can result in errors. 










	Field	Description
	
Enable Stress Test

	
Click Enable to create a simple stress test. With this enabled, no conversation ID is displayed.


	
Concurrent Threads

	
Enter the number of concurrent threads on which to send the invocations. The default is 5 threads.


	
Loops per Thread

	
Enter the number of times to invoke the operation. The default is 10 times.


	
Delay in Milliseconds

	
Specify the delay of milliseconds to wait between operation invocations. The default is 1000 milliseconds (1 second).








	
Accept the default values for these fields or provide values appropriate to your test environment.

The Input Arguments section includes the following fields for entering XML payload data.


	Field	Description
	
Tree View

	
Displays a graphical interface of text fields in which to enter information. This field automatically generates the required headers and XML structure.


	
XML View

	
Displays the XML file format for inserting values. You can paste the raw XML payload of your message into this field.











	
Note:

If you are using Oracle Enterprise Manager Grid Control, you can save the payload you enter. This feature is not available with Oracle Enterprise Manager Fusion Middleware Control.










	
Click Test Web Service.

The test results appear in the Response tab upon completion.
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Note:

The Response tab does not display payload data if you are performing a stress test or are testing an asynchronous service.










	
Click Launch Message Flow Trace to access the flow trace of the instance.


	
To return to the composite home page, click the name of the composite that appears at the top of the page or select Home from the composite target menu.


	
Return to the Dashboard page of the SOA composite application.

The Recent Instances table lists recent SOA composite application instances. Each created instance has its own unique ID.




For more information, see the following sections:

	
Section 1.2.3, "Introduction to SOA Composite Application Instances" for conceptual details about instances


	
Section 1.4.3.2, "Introduction to Policies" for an overview of policies


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for specific details about policies and testing web services from the Test Web Service page






8.1.1 Specifying RPC/Literal-Style WSDL Files on the Test Web Service Page

If you are specifying an RPC/literal-style WSDL file with a message defined by "element=" in the Test Web Service page in Oracle Enterprise Manager Fusion Middleware Control, use the XML View option of the Input Arguments section to modify the SOAP message. The SOAP body should look as follows:


<soap:Body>
    <ns:initiate>
        <payload>
          <value xmlns="...">3</value>
        </payload>
    </ns:initiate>
</soap:Body> 


where initiate is the operation name, payload is the part name, and value is the element defined in the WSDL message/part.








8.2 Monitoring and Deleting SOA Composite Application Instances from the Application Home Page

Section 7.4, "Managing the State of Deployed SOA Composite Applications" describes how to manage the lifecycle state of SOA composite applications. You can also monitor and delete specific SOA composite application instances from the Instances page of the application home page. 

To monitor and delete SOA composite application instances from the application home page:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select the Deployed Composites tab.


	
Select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Click the Instances tab.

The Instances page displays the following details:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
SOA composite application instance ID, name, conversation ID, most recent known state of each instance since the last data refresh of the page (for example, completed successfully, running, unknown, and so on), instance start time, and a log file describing any faults. A unique instance ID is created whenever a new instance of a SOA composite application is initiated either automatically by an external consumer of the application, or manually by an administrator from the Test Web Service page.

If a ? icon is displayed, the Capture Composite Instance State checkbox was not enabled on the SOA Infrastructure Common Properties dialog. Therefore, the instance state was not evaluated. Determining the composite instance state requires evaluating the states of the underlying component, Therefore, this can be disabled to improve performance.




[image: Description of soaapp_instance.gif follows]
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Note:

It is possible to generate orphaned service component instances. These instances are generated without any associated composite application instances. The orphaned component instances are generated under the following circumstances:

	
The SOA Infrastructure audit level is set to Off or the composite audit level is set to Off. Even in such cases, the BPEL process service engine can generate instance data for the service components that are included in the SOA composite application.


	
The SOA Infrastructure audit level is set to Off. However, the BPEL process or Oracle Mediator service engine audit level is set to a value other than Off.


	
All the audit levels are set to Off, but some faults are generated in one of the service engines. In these cases, the component instance gets generated.




To delete orphaned instances or large numbers of instances, use the purge script described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts." Selecting the Delete All Instance options in the Delete with Options dialog does not delete orphaned component instances.









If composite sensors are included in your SOA composite application, the Instances tab has the following differences:

	
The Add Fields button appears next to Search and Reset in the search utility. This button enables you to add sensor values to your search criteria.


	
A Composite Sensors column appears in the Instances table. Click the sensor icon in that column to display the details about sensor values available in a given instance of the composite.





	
From the Add Fields list, select composite sensors to add to the search criteria. In this example, four have been selected (CustomerDetails, NameSensor, Datesensor, and Yearsensor).


	
Input specific values by which each sensor searches. Only the composite instances in which the sensor values match your specified criteria are returned.
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The Composite Sensors column indicates that this SOA composite application includes composite sensors.

[image: Description of soaapp_instance3.gif follows]
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Click Reset to remove all composite sensor fields from the search criteria or click the Remove icon to the right of the field to remove an individual sensor.


	
Select a specific instance to delete by clicking a row in the Instances table. To select multiple instances, press Ctrl-Click or Shift-Click for the rows you want to select.


	
Select a specific action to perform.


	Action	Description
	
Filter By

	
Specify criteria for displaying composite instance states:

	
Execution State

Filter the display of instances by execution state (running, completed, terminated, or stale).


	
Fault State

Filter the display of instances by fault state (with or without faults). You can further customize the faulted state by selecting to display faults requiring recovery or nonrecoverable faults. It you select Stale from the Execute State list, the Fault State list is disabled.


	
BPEL Recovery

Filter the display of instances by whether a recovery action is required. By default, this filter excludes all messages and instances created in the last five minutes, and displays the rest. You can control the number of minutes with the excludeBpelMaxCreationTime key of the AuditConfig property in the System MBean Browser. This property is available in the More SOA Infra Advanced Configuration Properties section of the SOA Infrastructure Common Properties page. For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."





	
Delete Selected

	
Deletes the selected instance.

After deleting an instance, instance details are no longer available for review.


	
Delete With Options

	
Prompts you to first specify criteria for deleting the selected instance directly from the database. 

Use this option to delete running, rolled back instances. However, this option does not delete the associated invoke messages that are awaiting recovery. As a result, there are orphaned messages pending in BPEL message recovery. To delete these messages, go to the Recovery page of the BPEL process service engine.

	
Common Delete Options: Select a preset range of instances to delete from a list (for example, older than 24 hours).


	
Delete All Instances Of This Composite: Select to delete all instances of the composite. This option deletes the rejected messages associated and all component, service, and reference instances associated with the composite, including those not associated with any composite instance ID.

Note: If this composite has thousands of instances to delete, do not use this option. Instead, use the purge script described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."


	
Delete All Instances That Match These Criteria: Specify criteria for deleting instances, including the start and stop times, and instance state.




Any selections you may have made in the Instances page (such as specifying and executing a search criteria) are ignored for this operation.

To monitor the progress of instance deletion, you must check the log files. For information about log files, see Section 3.4, "Configuring Log Files."


	
Abort

	
Terminates the selected instance. However, instance details are still available for review. 








	
From the View list, select Columns > Partition to display the partition in which the instance of the SOA composite application revision is contained.


	
From the View list, select Columns > ECID to display execution context IDs (ECIDs). An ECID enables you to track a message flow that crosses instances of different composites.


	
In the Instances table, perform the following additional tasks:

	
In the Instance ID column, click a specific instance ID to show the message flow through the various service components and binding components. If an instance ID is listed as unavailable, you can click the Unavailable link for details.


	
In the State column, if an instance state is marked as Unknown, click it to display more details.


	
If the Composite Sensors column is available, click a sensor icon to display details about composite sensors included in the instance, such as name, location, and value.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.







	
Note:

Multiple revisions of a SOA composite application that includes inbound JCA adapters are displayed as running. However, only the most recent revision (the default version) is considered active. All previous revisions are not considered active. This is because for inbound JCA adapters, there can only be one active revision of a SOA composite application at any time. The JCA adapter endpoints in all previous revisions are de-activated.












For more information, see the following sections:

	
Section 1.2.3, "Introduction to SOA Composite Application Instances"


	
Section 1.4.3.3, "Introduction to the Lifecycle State of SOA Composite Applications"


	
Section 8.1, "Initiating a SOA Composite Application Test Instance"


	
Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files






8.2.1 Mismatch Between the Number of SOA Composite Application Instances and Service Component Instances

The number of SOA composite application instances may not always match the number of service component instances displayed in Oracle Enterprise Manager Fusion Middleware Control.

A SOA composite application instance is first created when the composite is invoked. When the service components within the composite receive a subsequent invocation, a corresponding service component instance is created that refers to the composite instance ID previously created.

There can be scenarios under which the composite instance is created, but the underlining service component instance is not created. For example:

	
The composite instance is created, but the invocation has not yet reached the service component due to a system failure.


	
The composite instance is created, but the invocation fails payload validation and is rejected. In this case, invocation does not reach the underlining service components.




You can also have orphaned service component instances for which no SOA composite application instance has been created.






8.2.2 Instance States of Service Components and SOA Composite Applications

Assume you have a SOA composite application with multiple service components (for example, two BPEL process service components). If these service components are marked with the following instance states:

	
Instance state of one BPEL process is marked as completed.


	
Instance state of the other BPEL process is marked as faulted.




This results in the overall composite instance state being marked as faulted. This behavior differs from 11g Release 1 (11.1.1.2), in which the same scenario resulted in the overall composite instance state being marked as completed.

Assume you have a parent SOA composite application that calls a child SOA composite application, and a fault occurs in the child composite (and is handled by the parent composite). This results in the following instance states:

	
The instance state of the child composite is marked as faulted.


	
The instance state of the parent composite is marked as completed.











8.3 Monitoring and Deleting SOA Composite Application Instances at the SOA Infrastructure Level

Section 7.4, "Managing the State of Deployed SOA Composite Applications" described how to manage the lifecycle state of all instances of a specific SOA composite application. You can also monitor and delete any number of instances across all deployed SOA composite applications by using the Instances page of the SOA Infrastructure home page. This page lists all SOA composite application instances deployed to the SOA Infrastructure.

To monitor and delete SOA composite application instances at the SOA infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.




	
	
Click soa-infra.




	
	
Select SOA infrastructure.











	
Click the Instances tab.

The Instances page displays the following details:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
All SOA composite application instances in the SOA Infrastructure, including instance and conversation IDs, composite name and revision, SOA composite application instance state, and instance start time. 
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You can also terminate and delete instances from this page.


	
Select a specific instance by clicking a row in the Instances table. To select multiple instances, press Ctrl-Click or Shift-Click for the rows you want to select.


	
Select a specific action to perform.


	Action	Description
	
Filter By

	
Specify criteria for displaying composite instance states:

	
Execution State

Filter the display of instances by execution state (running, completed, terminated, or stale).


	
Fault State

Filter the display of instances by fault state (with or without faults). You can further customize the faulted states by selecting to display faults requiring recovery or nonrecoverable faults. It you select Stale from the Execute State list, the Fault State list is disabled.


	
BPEL Recovery

Filter the display of instances by whether a recovery action is required. By default, this filter excludes all messages and instances created in the last five minutes, and displays the rest. You can control the number of minutes with the excludeBpelMaxCreationTime key of the AuditConfig property in the System MBean Browser. This property is available in the More SOA Infra Advanced Configuration Properties section of the SOA Infrastructure Common Properties page. For more information, see Section 3.1, "Configuring SOA Infrastructure Properties."





	
Delete Selected

	
Deletes the selected instance. 


	
Delete With Options

	
Prompts you to first specify criteria for deleting the selected instance directly from the database.

Use this option to delete running, rolled back instances. However, this option does not delete the associated invoke messages that are awaiting recovery. As a result, there are orphaned messages pending in BPEL message recovery. To delete these messages, go to the Recovery page of the BPEL process service engine.

	
Common Delete Options: Select a preset range of instances to delete from a list (for example, older than 24 hours).


	
Delete All Instances That Match These Criteria: Specify criteria for deleting instances, including the start and stop times, and instance state.




Any instance state selections you made at the top of the Instances page are ignored for this operation.

To monitor the progress of instance deletion, you must check the log files. For information about log files, see Section 3.4, "Configuring Log Files."

Notes:

	
If this composite has thousands of instances to delete, do not use this option. Instead, use the purge script described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."


	
If you delete an instance with faults, those faults are no longer displayed in the Faults and Rejected Messages page.


	
This option does not purge BPEL process service engine recoverable invoke and callback messages. To completely purge those messages, use the purge scripts described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."





	
Abort

	
Terminates the selected instance. However, instance details are still available for review.

Note: If you delete an instance with faults, those faults are no longer displayed in the Faults and Rejected Messages page. In addition, if a terminated instance (shown as aborted) had a fault, it is not added to the fault count.








	
In the instances table, perform the following tasks:

	
From the View list, select Columns > Partition to display the partition in which the instance of the SOA composite application revision is contained.


	
From the View list, select Columns > ECID to display execution context IDs (ECIDs). An ECID enables you to track a message flow that crosses instances of different composites.


	
In the Instance ID column, click a specific instance ID to show the message flow through the various service components and binding components. If the instance ID is unavailable, the message flow cannot be accessed. However, you can still click the link for details.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Instance State column, click the Recovery icon to access the Faults and Rejected Messages page with faults filtered based on the composite instance ID. There can be multiple faults for a composite instance ID.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.












8.4 Recovering from SOA Composite Application Faults at the SOA Infrastructure Level

You can monitor and perform individual and bulk fault recoveries for BPEL process and Oracle Mediator service components across any number of SOA composite applications. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault. Examples of performing both individual and bulk recovery are provided in this section. Human task service component or human workflow service engine faults are recovered from Oracle BPM Worklist.

You can also perform a manual recovery of undelivered BPEL process invoke or callback messages. For more information, see Section 14.4, "Performing BPEL Process Service Engine Message Recovery."

To recover from SOA composite application faults at the SOA Infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.




	
	
Click soa-infra.




	
	
Select SOA Infrastructure.











	
Click the Faults and Rejected Messages tab.

The Faults and Rejected Messages page displays the following details for all SOA composite application faults:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Options for selecting instance recovery actions (for example, retry, abort, replay, and others), deleting rejected messages, and performing bulk message recovery.


	
Faults and rejected messages, including the error message, whether you can recover from the fault, the time of the fault, if the fault message is classified as a rejected message (if so, a checkmark is displayed), the SOA composite application in which the fault occurred, the fault location, the instance ID, and a link to log files describing the fault.
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Note:

You cannot search for human workflow error messages by entering details in the Error Message Contains field because these faults do not persist in the dehydration store.









Faults identified as recoverable can be recovered.


	
Select faults for recovery using one of the following options. Fault recovery selection at the SOA Infrastructure level matches the SOA composite application level and BPEL process and Oracle Mediator service component levels.


	For...	Then...
	
Single fault recovery

	
There are three options from which to choose for single-fault recovery:

	
Click the row of the fault that has been identified as recoverable. With the row highlighted, select a specific action from the Recovery Action list, as described in Step 4.


	
In the Recovery column, click the Recover link to access the Faults page of the instance audit trail to perform fault recovery.


	
In the Error Message column, click the message of a fault that has been identified as recoverable. This displays complete fault details, including the fault ID, fault time, fault location, fault type, and error message text. A Recover Now option is displayed for recoverable faults. Click Recover Now to access the Faults page of the instance audit trail to perform fault recovery.





	
Bulk fault recovery

	
There are two options from which to choose for bulk-fault recovery:

	
Use Shift+Click or Control+Click to select specific faults in the rows.

or


	
From the Select menu, choose Select All Recoverable. Then use Shift+Click or Control+Click to deselect the faults to not include in the recovery operation.

Then:


	
Select an action from the Recovery Action list, as described in Step 4.

Note: Only the actions applicable to all selected faults are available.





	
Recovery of all faults

	
	
From the Select menu, choose Select All Recoverable.


	
Select an action from the Recovery Action list, as described in Step 4.

Note: Only the actions applicable to all selected faults are available.











	
Select an action from the Recovery Action list.


	Action	Description	Action is Available for...
	
Retry

	
Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.

	
BPEL process and Oracle Mediator


	
Abort

	
Terminates the entire instance.

	
BPEL process and Oracle Mediator


	
Replay

	
Replays the entire scope again in which the fault occurred.

	
BPEL process


	
Rethrow

	
Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.

	
BPEL process


	
Continue

	
Ignores the fault and continues processing (marks the faulted activity as a success).

	
BPEL process











	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.










	
If you want to delete rejected messages for all composites in the SOA Infrastructure, see Section 8.6, "Deleting Rejected Messages at the SOA Infrastructure Level."


	
If you want to perform a bulk recovery of messages, click Recover with Options.

This displays the Recover with Options dialog for specifying criteria for recovering BPEL and Oracle Mediator messages of all composites directly from the database. Human workflow messages can be recovered manually from Oracle BPM Worklist. Business event and business rule messages cannot be recovered.
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Specify criteria. Retry and Abort are the only recovery actions permitted.




	
Note:

For bulk fault recovery at the SOA Infrastructure level, a check of the state of composites cannot be performed. If the state of a composite is set to off, a recovery of its faults cannot be performed. However, no error or warning message is displayed. Upon submission of the bulk fault recovery request, the server checks if the originating composite's state is set to off. That fact is then noted in the log, and the fault is skipped.

You are also not notified when a fault has been skipped during recovery for any other reason (for example, an unsupported service engine, an unrecoverable fault, and so on).










	
Click Recover. Depending upon the number of messages, recovery can take some time.


	
Perform the following additional tasks from within the faults table:

	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Fault Location column, click a specific location to access the faults page for the location of the fault. The location can be a service, service component, or reference.


	
In the Composite Instance ID column, click a specific ID to access the flow trace of the instance.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.





	
See the following sections for examples of single and bulk fault recovery with BPEL processes and Oracle Mediator.

	
Section 8.4.1, "Examples of Fault Recovery for BPEL Processes"


	
Section 8.4.2, "Examples of Fault Recovery for BPMN Processes"


	
Section 8.4.3, "Examples of Fault Recovery for Oracle Mediator"







For more information about concepts and instructions on designing a fault policy, see the following documentation:

	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section "Using the Fault Management Framework" of Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite






8.4.1 Examples of Fault Recovery for BPEL Processes

This section provides examples of how to define a fault policy that enables human intervention on a BPEL process fault and perform single and bulk fault recovery on a BPEL process service component.

	
Section 8.4.1.1, "Example: Single Fault Recovery for BPEL Processes"


	
Section 8.4.1.2, "Example: Bulk Fault Recovery for BPEL Processes"




In this example, you define a fault policy by specifying that a fault can be manually recovered through human intervention. If an invalid social security number is submitted from a loan broker BPEL process to a credit rating service, the credit rating service returns a negative credit fault. This human intervention action is defined with the ora-human-intervention action in the fault-policies.xml file. Without fault policies, BPEL instances do not generate recoverable faults (instead they are nonrecoverable); the ora-human-intervention action makes the fault recoverable.


<faultPolicies xmlns="http://schemas.oracle.com/bpel/faultpolicy">
<faultPolicy version="2.0.1"
           id="CRM_ServiceFaults"
           xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
           xmlns:xs="http://www.w3.org/2001/XMLSchema"
           xmlns="http://schemas.oracle.com/bpel/faultpolicy"
           xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
            <Conditions>
               <faultName xmlns:credit="http://services.otn.com" 
               name="credit:NegativeCredit">
               <!-- get this fault when SSN starts with 0-->
                  <condition>
                     <test>$fault.payload="Bankruptcy Report"</test>
                     <action ref="ora-human-intervention"/>
                  </condition>
               </faultName>
            </Conditions>
</faultPolicy>
</faultPolicies>


The fault-bindings.xml file associates the fault policies defined in the fault-policies.xml file with the CRM_ServiceFaults composite application.


<faultPolicyBindings version="2.0.1"
 xmlns="http://schemas.oracle.com/bpel/faultpolicy"
 xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <composite faultPolicy="CRM_ServiceFaults"/>
</faultPolicyBindings>


Because human intervention is defined as an action, you perform BPEL process fault recovery in Oracle Enterprise Manager Fusion Middleware Control.

For more information about creating and designing fault-policies.xml and fault-bindings.xml files, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.

For information about BPEL process message recovery, see Section 14.4, "Performing BPEL Process Service Engine Message Recovery."



8.4.1.1 Example: Single Fault Recovery for BPEL Processes

This example assumes the following:

	
An instance was initiated on the Test Web Service page shown in Section 8.1, "Initiating a SOA Composite Application Test Instance."


	
An invalid social security number that begins with 0 was entered.




To perform single fault recovery for BPEL processes:

	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.


	
In the faults table, locate the fault that has been identified as recoverable. You can use the search utility to locate the specific fault.


	
In the Recovery column, click Recover. If you first want to see details about the fault, click the error message. Then, click Recover Now.

The Faults page for that BPEL process instance is displayed.


	
In the Recovery column, click Recoverable.

The page refreshes to display the fault recovery section at the bottom of the page.
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From the Recovery Action list, select Retry.


	
Select None from the Chain Action Upon Successful Retry list. This list enables you to select Java callout recovery actions. For more information, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.


	
Select a variable from the Variable list. The content of this variable is displayed in the Value field. For this example, the variable crInput is selected. This variable is used in an invoke activity and contains an incorrect social security number value.


	
Enter the correct value in the Value field. For this example, the social security number is edited to begin with 1:


<ssn xmlns="http://service.otn.com">123456789</ssn>


	
Click Set Value, and click Yes when prompted to continue.


	
Click Recover to recover from the fault, and then click Yes when prompted to continue.

The page refreshes to indicate that no faults occurred.









8.4.1.2 Example: Bulk Fault Recovery for BPEL Processes

For the social security number example, selecting Retry is not an option for performing a bulk recovery, because the value for the social security number is incorrect and requires correction. An example of performing a bulk recovery with the Retry option is if the social security number is correct, but the system providing the credit rating service was temporarily unavailable and caused a composite reference fault. This prevents the messages from being delivered. Once the credit rating service is available again, selecting Retry attempts the invocation to the credit rating service through the composite reference again.

To perform bulk fault recovery for BPEL processes:

	
Perform Step 1 and Step 2 of Section 8.4.1.1, "Example: Single Fault Recovery for BPEL Processes."


	
In the search utility, enter criteria based on known fault parameters (for example, the time range, composite name, component type (BPEL process), and so on).


	
If the search returns too many results, limit it by selecting the Show only recoverable faults checkbox.


	
From the Select list, choose Select All Recoverable.


	
From the Recovery Action list, select Abort.

All selected faults are manually terminated.











8.4.2 Examples of Fault Recovery for BPMN Processes

This section provides examples of how to define a fault policy that enables human intervention on a BPMN process fault and perform single and bulk fault recovery on a BPMN process service component.




	
Note:

When a multi-instance process has met the conditions for its completion, it raises a nonrecoverable system fault (to cancel remaining instances). Although this fault appears in the Oracle Enterprise Manager Fusion Middleware Control, you do not need to take any action. It appears simply to notify you that the multi-instance process was finalized because the condition was completed.









	
Section 8.4.2.1, "Example: Single Fault Recovery for BPMN Processes"


	
Section 8.4.2.2, "Example: Bulk Fault Recovery for BPMN Processes"




In this example, you define a fault policy specifying that a fault be manually recovered through human intervention. If an invalid social security number is submitted from a loan broker BPMN process to a credit rating service, the credit rating service returns a negative credit fault. This human intervention action is defined with the ora-human-intervention action in the fault-policies.xml file. Without fault policies, BPMN instances do not generate recoverable faults (instead they are nonrecoverable); the ora-human-intervention action makes the fault recoverable.


<faultPolicies xmlns="http://schemas.oracle.com/bpmn/faultpolicy">
<faultPolicy version="2.0.1"
           id="CRM_ServiceFaults"
           xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
           xmlns:xs="http://www.w3.org/2001/XMLSchema"
           xmlns="http://schemas.oracle.com/bpmn/faultpolicy"
           xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
            <Conditions>
               <faultName xmlns:credit="http://services.otn.com" 
               name="credit:NegativeCredit">
               <!-- get this fault when SSN starts with 0-->
                  <condition>
                     <test>$fault.payload="Bankruptcy Report"</test>
                     <action ref="ora-human-intervention"/>
                  </condition>
               </faultName>
            </Conditions>
</faultPolicy>
</faultPolicies>


The fault-bindings.xml file associates the fault policies defined in the fault-policies.xml file with the CRM_ServiceFaults composite.


<faultPolicyBindings version="2.0.1"
 xmlns="http://schemas.oracle.com/bpmn/faultpolicy"
 xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <composite faultPolicy="CRM_ServiceFaults"/>
</faultPolicyBindings>


Because human intervention is defined as an action, you perform BPMN process fault recovery in Oracle Enterprise Manager Fusion Middleware Control.

For more information about creating and designing fault-policies.xml and fault-bindings.xml files, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.



8.4.2.1 Example: Single Fault Recovery for BPMN Processes

This example assumes the following:

	
An instance was initiated on the Test Web Service page shown in Section 8.1, "Initiating a SOA Composite Application Test Instance."


	
An invalid social security number that begins with 0 was entered.




To perform single fault recovery for BPMN processes:

	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.


	
In the faults table, locate the fault that has been identified as recoverable. You can use the search utility to locate the specific fault.


	
In the Recovery column, click Recover. If you first want to see details about the fault, click the error message. Then, click Recover Now.

The Faults page for that BPMN process instance is displayed.


	
In the Recovery column, click Recoverable.

The page refreshes to display the fault recovery section at the bottom of the page.
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From the Recovery Action list, select Retry.


	
From the Chain Action Upon Successful Retry list, select None. This list enables you to select Java callout recovery actions. For more information, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.


	
From the Variable list, select a variable. The content of this variable is displayed in the Value field. For this example, the variable crInput is selected. This variable is used in an invoke activity and contains an incorrect social security number value.


	
In the Value field, enter the correct value. For this example, the social security number is edited to begin with 1:


<ssn xmlns="http://service.otn.com">123456789</ssn>


	
Click Set Value, and click Yes when prompted to continue.


	
Click Recover to recover from the fault, then click Yes when prompted to continue.

The page refreshes to indicate that no faults occurred.









8.4.2.2 Example: Bulk Fault Recovery for BPMN Processes

For the social security number example, selecting Retry is not an option for performing a bulk recovery because the value for the social security number is incorrect and requires correction. An example of performing a bulk recovery with the Retry option is if the social security number is correct, but the system providing the credit rating service was temporarily unavailable and caused a composite reference fault. This prevents the messages from being delivered. Once the credit rating service is available again, selecting Retry re-attempts the invocation to the credit rating service through the composite reference.

To perform bulk fault recovery for BPMN processes:

	
Perform Steps 1 through 2 of Section 8.4.2.1, "Example: Single Fault Recovery for BPMN Processes."


	
In the search utility, enter criteria based on known fault parameters (for example, the time range, composite name, component type (BPMN process), and so on).


	
If the search returns too many results, limit it by selecting the Show only recoverable faults checkbox.


	
From the Select list, choose Select All Recoverable.


	
From the Recovery Action list, select Abort.

All selected faults are manually terminated.











8.4.3 Examples of Fault Recovery for Oracle Mediator

This section provides an example of how to perform single and bulk fault recovery on an Oracle Mediator service component.

	
Section 8.4.3.1, "Example: Single Fault Recovery for Oracle Mediator"


	
Section 8.4.3.2, "Example: Bulk Fault Recovery for Oracle Mediator"




In this example, a service binding component for an inbound Siebel adapter submits a payload message to Oracle Mediator for transformation. The processed payload message is then delivered to a reference binding component for an outbound file adapter. However, the outbound directory into which to write the payload message is not configured with write permissions. This causes a fault to occur. The fault policy defined during design time specifies that the fault be manually recovered through human intervention. Three retries are attempted, as defined with the retryCount attribute. The condition and action are defined as follows in the fault-policies.xml file.

Recoverable Oracle Mediator faults do not require a fault policy (though it is one way to make faults recoverable, as described through an ora-human-intervention action). Any parallel routing rule that receives a remote fault from the outbound endpoint also creates a recoverable fault (in this specific example, the fault policy is not required if the Oracle Mediator uses a parallel routing rule to invoke the outbound file adapter).


<faultPolicies xmlns="http://schemas.oracle.com/bpel/faultpolicy">
<faultPolicy version="2.0.1"
           id="ConnectionFaults"
           xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
           xmlns:xs="http://www.w3.org/2001/XMLSchema"
           xmlns="http://schemas.oracle.com/bpel/faultpolicy"
           xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
              <Conditions>
                <faultName xmlns:medns="http://schemas.oracle.com/mediator/faults"
                name="medns:mediatorFault">
                   <condition>
                      <test>contains($fault.mediatorErrorCode, "TYPE_FATAL_
                         MESH")</test>
                      <action ref="ora-retry"/>
                   </condition>
                </faultName>
              </Conditions>
. . .
. . .      <Action id="ora-retry">
        <retry>
          <retryCount>3</retryCount>
          <retryInterval>5</retryInterval>
          <retryFailureAction ref="ora-human-intervention"/>
          <retrySuccessAction ref="ora-terminate"/>
        </retry>
      </Action>
   </Actions>
</faultPolicy>
</faultPolicies>


Processing is set to retry 3 times before terminating.

The fault policies are associated with the ConnectionFaults composite application in the fault-bindings.xml file:


<faultPolicyBindings version="2.0.1" xmlns="http://schemas.oracle.com/bpel/fault
policy" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
        <composite faultPolicy="ConnectionFaults"/>
</faultPolicyBindings>




8.4.3.1 Example: Single Fault Recovery for Oracle Mediator

For this example, the sap output directory is made read-only. An inbound file adapter retrieves the sender.xml file from the siebel directory and the message is routed through Oracle Mediator to an outbound file adapter reference for placing a file in the sap directory.

To perform single fault recovery for Oracle Mediator:

	
Change the directory permissions at the operating system command prompt.


chmod 000 sap
cp sender.xml siebel/


	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.

Three faults appear, based on three retries being attempted. In this case, you see three retries only because the fault policy on the Oracle Mediator interaction with the outbound file adapter defines three retries. Without the fault policy, there is only one fault (no automated retries).


	
Click the specific instance ID in the Composite Instance ID column.

The Flow Trace appears. The faults table at the top of the page displays the fault messages. If you want to see where the faulted Oracle Mediator instance is located in the overall message flow, select the fault in the faults table. This highlights the associated instance in the trace table. You can then click the instance to access its audit trail to see more details about the faulted flow.




	
Note:

Steps 4 through 10 represent one way to recover this single fault. The fault can also be recovered directly from the Oracle Mediator faults page through the Recovery Action list.










	
Locate the Oracle Mediator component instance fault you want to recover in the Faults table and click Recover in the Recovery column.


	
Select Sender from the Payload Part list.

The payload is automatically displayed in the Payload field. If necessary, payload modifications can be performed in this field. For this example, payload modification is not necessary.


	
Change the sap directory to be writable at the operating system command prompt.


chmod 777 sap


	
Return to the Faults tab and click the Refresh icon in the upper right corner of the page.


	
Click Retry.


	
Click Yes when prompted to resubmit the selected fault for recovery.

The page refreshes to indicate that no faults occurred.


	
Click the Audit Trail tab.

The final message indicates that manual recovery was successful and the message payload was written to the sap directory.
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8.4.3.2 Example: Bulk Fault Recovery for Oracle Mediator

Assume the sap directory to which to write the sender.xml payload message is again configured with read-only permissions at the operating system command prompt. Three copies of the sender.xml file are placed in the siebel directory of the service binding component for the inbound Siebel adapter. This creates three instances.


chmod 000 sap
cp sender.xml siebel/
cp sender.xml siebel/
cp sender.xml siebel/


To perform bulk fault recovery for Oracle Mediator:

	
Change the sap directory to be writable.


	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.


	
In the search utility, enter criteria based on known fault parameters (for example, the time range, composite name, and so on).


	
If the search returns too many results, limit it by selecting the Show only recoverable faults checkbox.


	
Change the sap directory to be writable at the operating system command prompt.


chmod 777 sap


	
Select all the faults to be recovered.


	
Select Retry from the Recovery Action list.


	
Select Yes when prompted to perform fault recovery.


	
Click the Audit Trail tab.

The final message indicates that manual recovery was successful and the message payload was successfully written to the sap directory.













8.5 Recovering from SOA Composite Application Faults in the Application Home Page

You can monitor and perform individual and bulk fault recoveries in a SOA composite application. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault. Human workflow faults can also be recovered, but not directly from Oracle Enterprise Manager Fusion Middleware Control. Instead, the audit trail provides a link to the Oracle BPM Worklist, from which the fault can be addressed.

To recover from SOA composite application faults in the application home page:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Click the Faults and Rejected Messages tab.

The Faults and Rejected Messages page displays the following details for the selected SOA composite application:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Options for selecting instance recovery actions (for example, retry, abort, replay, and others), deleting rejected messages, and performing bulk message recovery.


	
Faults and rejected messages in SOA composite application instances, including the error message, whether you can recover from the fault, the time of the fault, if the fault message is classified as a rejected message (if so, a checkmark is displayed), the fault location, the composite instance ID, and links to log files that describe the fault.
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Note:

You cannot search for human workflow error messages by entering details in the Error Message Contains field because these faults do not persist in the dehydration store.









Faults identified as recoverable can be recovered.


	
Select faults for recovery. As with fault recovery at the SOA Infrastructure level and BPEL process and Oracle Mediator service component levels, you can perform single fault recovery, bulk fault recovery, and recovery of all faults. See Step 3 of Section 8.4, "Recovering from SOA Composite Application Faults at the SOA Infrastructure Level" for instructions on selecting faults to perform these types of recovery.


	
Select an action from the Recovery Action list.


	Action	Description	Action is Available for...
	
Retry

	
Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.

	
BPEL process and Oracle Mediator


	
Abort

	
Terminates the entire instance.

	
BPEL process and Oracle Mediator


	
Replay

	
Replays the entire scope again in which the fault occurred.

	
BPEL process


	
Rethrow

	
Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.

	
BPEL process


	
Continue

	
Ignores the fault and continues processing (marks the faulted activity as a success).

	
BPEL process











	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.










	
If you want to delete rejected messages for the current SOA composite application, see Section 8.7, "Deleting Rejected Messages from the Application Home Page."


	
If you want to perform a bulk recovery of messages, click Recover with Options.

This displays the Recover with Options dialog for specifying criteria for recovering BPEL and Oracle Mediator messages of the current composite directly from the database. Human workflow messages can be recovered manually from Oracle BPM Worklist. Business event and business rule messages cannot be recovered.
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Specify criteria. Retry and Abort are the only recovery actions permitted.




	
Note:

For bulk fault recovery at the SOA composite application level, a check of the state of the composite is performed. If the state of the composite is set to off, a message is displayed warning you that a recovery cannot be performed.

You are not notified when a fault has been skipped during recovery for any reason (for example, an unsupported service engine, an unrecoverable fault, and so on).










	
Click Recover. Depending upon the number of messages, recovery can take some time.


	
Perform the following additional monitoring tasks from within the faults table:

	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Fault Location column, click a specific location to access the faults page for the location of the fault. The location can be a service, component, or reference.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Rejected messages do not have a component instance ID.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.







For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section 8.4.1, "Examples of Fault Recovery for BPEL Processes"


	
Section 8.4.3, "Examples of Fault Recovery for Oracle Mediator"









8.6 Deleting Rejected Messages at the SOA Infrastructure Level

You can delete rejected messages for all composites in the SOA Infrastructure directly from the database by specifying a criteria in the Delete: Rejected Messages dialog.

To delete rejected messages for all composites at the SOA Infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	
Select Home.




	
	
Click soa-infra.




	
	
Select SOA Infrastructure.











	
Click the Faults and Rejected Messages tab.

The Faults and Rejected Messages page displays the following details for all SOA composite application faults:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Options for selecting instance recovery actions (for example, retry, abort, replay, and others), deleting rejected messages, and performing bulk message recovery.


	
Faults and rejected messages, including the error message, whether you can recover from the fault, the time of the fault, if the fault message is classified as a rejected message (if so, a checkmark is displayed), the SOA composite application in which the fault occurred, the fault location, the instance ID, and a link to log files describing the fault.




[image: Description of sca_faultandmanage.gif follows]
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Click Delete Rejected Messages.




	
Note:

Oracle recommends that you run the purge scripts to delete composite instances in production environments. The purge scripts have better performance and scalability. Only use the Delete Rejected Messages option to manage exceptions not covered by the purge scripts. For more information about the purge scripts, see Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."









This displays the Delete: Rejected Messages dialog for specifying criteria for deleting rejected messages of all the composites directly from the database.

[image: Description of bp_delrejmess.gif follows]
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Specify criteria and click Delete.




For information about recovering from faults at the SOA Infrastructure level, see Section 8.4, "Recovering from SOA Composite Application Faults at the SOA Infrastructure Level."






8.7 Deleting Rejected Messages from the Application Home Page

You can delete rejected messages for the current SOA composite application directly from the database by specifying a criteria in the Delete: Rejected Messages dialog.

To delete rejected messages for the current SOA composite application:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	
Select Home.


	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.




	
	
Under soa-infra, expand the partition.


	
Select a specific SOA composite application.











	
Click the Faults and Rejected Messages tab.

The Faults and Rejected Messages page displays the following details for all SOA composite application faults:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Options for selecting instance recovery actions (for example, retry, abort, replay, and others), deleting rejected messages, and performing bulk message recovery.


	
Faults and rejected messages, including the error message, whether you can recover from the fault, the time of the fault, if the fault message is classified as a rejected message (if so, a checkmark is displayed), the SOA composite application in which the fault occurred, the fault location, the instance ID, and a link to log files describing the fault.




[image: Description of sca_soaapp_search.gif follows]
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Click Delete Rejected Messages.




	
Note:

Oracle recommends that you run the purge scripts to delete composite instances in production environments. The purge scripts have better performance and scalability. Only use the Delete Rejected Messages option to manage exceptions not covered by the purge scripts. For more information about the purge scripts, see Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."









This displays the Delete: Rejected Messages dialog for specifying criteria for deleting rejected messages of the current composite directly from the database.

[image: Description of bp_delrejmess.gif follows]
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Specify criteria and click Delete.




For information about recovering from faults in the SOA composite application home page, see Section 8.5, "Recovering from SOA Composite Application Faults in the Application Home Page."









24 Monitoring Oracle Business Activity Monitoring

This chapter describes how to use Oracle Enterprise Manager Fusion Middleware Control to view Oracle Business Activity Monitoring (Oracle BAM) performance statistics and logs, and monitor Oracle BAM web services counters, and Oracle BAM server and web components such as Active Data Cache, Event Engine, Report Cache, Enterprise Message Sources, and Report Server.

This chapter includes the following topics:

	
Section 24.1, "Introduction to Monitoring Oracle BAM"


	
Section 24.2, "Monitoring Oracle BAM Server Components"


	
Section 24.3, "Monitoring Oracle BAM Web Applications"


	
Section 24.4, "Monitoring Oracle BAM Web Services"


	
Section 24.5, "Monitoring Oracle BAM Performance"


	
Section 24.6, "Monitoring Oracle BAM Logs"






24.1 Introduction to Monitoring Oracle BAM

You can monitor several aspects of the Oracle BAM components using Oracle Enterprise Manager Fusion Middleware Control.

The OracleBamServer page in Fusion Middleware Control enables you to monitor each of the Oracle BAM Server Components: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. For more information, see Section 24.2, "Monitoring Oracle BAM Server Components".

The OracleBamWeb page in Fusion Middleware Control enables you to monitor Oracle BAM Report Server. For more information, see Section 24.3, "Monitoring Oracle BAM Web Applications".

In addition, the Performance Summary pages for each component allow you to track specific statistics of your choosing. For more information, see Section 24.5, "Monitoring Oracle BAM Performance".

Also, you can configure and monitor Oracle BAM logs using Fusion Middleware Control. For more information, see Section 24.6, "Monitoring Oracle BAM Logs".






24.2 Monitoring Oracle BAM Server Components

Oracle BAM Server components are monitored on the Fusion Middleware Control page for Oracle BAM Server.

To monitor Oracle BAM Server components:

Go to the Oracle BAM Server home page by selecting BAM > OracleBamServer in the navigation tree.

In the OracleBamServer page, you can select each tab (Active Data Cache, Event Engine, Report Cache, Enterprise Message Sources) to monitor the individual Oracle BAM Server components.




	
Note:

Alternatively, on the farm home page, you can also select the Oracle BAM targets from the right side page content area, where it displays details of the farm.











24.2.1 Monitoring Oracle BAM Active Data Cache

Oracle BAM Active Data Cache (Oracle BAM ADC) is designed and optimized to handle large amounts of data in real time. Data coming into Oracle BAM ADC immediately updates all defined calculations and aggregates in real time in an in-memory cache so that this data can be pushed as quickly as possible to Oracle BAM dashboards and reports. Data fed to the Oracle BAM ADC is received from a combination of sources, from Java Message Service (JMS) topics and queues to more traditional data queries and databases. Oracle BAM ADC ensures that no matter the source, when Oracle BAM Server is aware of the incoming data, it is streamed to Oracle BAM alerts and dashboards as incremental changes.

There are two key components to the Oracle BAM ADC, data sets and view sets. Oracle BAM ADC receives transactions (insert, update, upsert, delete) into the data sets. These data sets are constructed based on the design that an Oracle BAM developer defines for data relationships when data objects are defined in Oracle BAM Architect. Data objects can be reflective of flat tables of data, or more complex, star-schema relationships between data objects, which are represented in Oracle BAM as data object look-ups.

After data is updated in the data sets, view sets that are listening on these data sets go into action. The view sets have knowledge of all of the open Oracle BAM dashboards and alerts that users are viewing in the Oracle BAM system. View sets ensure that data updates to these open objects are incrementally updated first, using a push-based mechanism to publish updates to open dashboards and alerts, providing users with the latest information.

Use the Oracle BAM pages in Fusion Middleware Control to monitor statistics for all data objects in Oracle BAM ADC as a group, or select a particular data object from the Data Objects list to monitor.

[image: Description of bam_server_adc_tab.gif follows]
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Note:

When you select a data object from the list, cached data is displayed to preserve performance. You must refresh the page (using the Refresh icon) to display the latest data associated with the selected data object.

[image: Description of bam_em_refresh.gif follows]
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View Sets

Active view sets are those which are typically seen in Oracle BAM reports. Open view sets are the sum of active and static open view sets.

Oracle BAM reports and alerts use active view sets. Oracle BAM Server uses static view sets for internal process. There are also internal parts of the code that use static view sets on system objects (metadata tables). It is possible that if Oracle BAM Server is not closing the static view sets, you observe different values for them.

Static view sets do not support active data generation and are used to fetch data from data objects, therefore, they are kept open for only a very short time when data is fetched. For that reason, in the Open counter, the values appearing most of the time are from active view sets.


View Set Count Variation

You can monitor the view set count for Oracle BAM components Active Data Cache, Report Cache, and Report Server. You may see that view set counts do not match between Active Data Cache, Report Cache, and Report Server metrics.

The Report Server opens view sets through the Report Cache for all of the views contained in the reports opened in browsers. The Active Data Cache opens more view sets than the Report Cache. One such view set opened is in the Active Data Cache through the Event Engine.

Whenever the Event Engine starts, it loads all the defined alerts, and for those alerts that are defined to monitor data changes in the Active Data Cache, corresponding view sets are opened in the Active Data Cache. That is why more view sets are displayed in the Active Data Cache monitoring page than on the Report Cache and Report Server pages.

For most of the views in a report, there is a corresponding view set in the Active Data Cache. View sets opened by the report are shared with the subsequent instances of that report, except for Crosstab views. In reports using the Crosstab view, the view set call is different than the one used by other views. When a report containing a Crosstab view is opened, three view sets are opened in the Active Data Cache. Two of the view sets are closed immediately after fetching the data, while one is kept open to monitor the incoming changes.


Operations Per Second

This statistic includes all of the insert, update, upsert, and delete operations occurring on the selected data object. The accompanying graph displays statistics for the last 5 minutes.


Average Batch Size for Operations

This statistic is the average number of records included in each batch operation on the selected data object. The accompanying graph displays statistics for the last 5 minutes.


Waiting Threads

Certain operations must be synchronized, requiring a data object to be locked. This statistic displays the number of threads that are blocked, waiting for the data object to be unlocked to perform subsequent operations.


Total Transactions

This statistic displays the number of transactions on Oracle BAM data objects. It is the sum of committed and rolled back transactions. The accompanying graph also displays the number of open and completed transactions.

For example, if you add a row in an Oracle BAM data object and save it (commit), it is one transaction. This metric is useful only if the client of Oracle BAM Server is using transactions.

Transactions can also be used by an EMS, when connecting to a JMS topic or queue.

You can configure this metric to track transactions in the Oracle BAM sensor actions in BPEL and in the Oracle Data Integrator knowledge modules.

In regard to Rolled Back Transactions, if an invalid insert operation is attempted on an Oracle BAM data object, Oracle BAM Server rolls back the transaction.






24.2.2 Monitoring the Event Engine Component

The Event Engine is used by Oracle BAM Server to evaluate and execute Oracle BAM alerts. The Event Engine monitors complex data conditions and implements specified rules. Rules can include a series of conditions and actions attached to an event. The Event Engine continuously monitors the information in the Active Data Cache for certain conditions and executes the related actions defined in associated rules.

The Event Engine is responsible for tracking events based on date, time, or data changes. The Event Engine design employs a satellite concept, in which there are four different systems (satellites) within which event clauses can be registered and tracked.

The Date and Time satellites are both based on a scheduler, and they are used for time based alerts, for example, "Email a snapshot of this Oracle BAM dashboard to me every morning at 8 a.m."

The Manual satellite is use to manually send alerts by name (using a web service call).

The Data satellite is used to track alerts that are based on specific changes in the data of a given data object, such as "Call this web service when SUM(Sales) > 10000 in the MediaSales data object," or "Let me know when anything in this dashboard changes."

You can monitor statistics for active Event Engine rules, condition met rates, and processing queues.

[image: Description of bam_server_eetab.gif follows]
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Active Rules

This statistic displays the number of alert rules that are active (not expired or invalid) in Oracle BAM Event Engine. It displays the total number of alert rules in Oracle BAM Event Engine, which is the sum of alerts created for all of the Oracle BAM users.


Rule Fire Rate Per Second

This group of statistics displays the rates of events over the last 5 minutes for Actual, Events Accepted, and Events Rejected rates.

Actual rule fire rate per second is the number of events fired per second in Event Service. It is the number of events fired per second, taking into account number of times alerts fired events in the previous 5 minutes. For example, if when the OracleBamServer page was loaded, only 2 alerts fired in previous 5 minutes, the value shown would be 2/(5 X 60), that is 0.0067. So, if fired twice in 300 seconds, it would fire 0.0067 times in one second.

Events Accepted is the number of events fired per second from the satellite. That it, the number of events fired per second from alerts configured, that were accepted (for further processing), taking into account events that were accepted in the previous 5 minutes. The value shown is calculated in the same way as Actual. Unless the Event Engine's queue thresholds are exceeded, all events fired are accepted and processed further.

Events Rejected is the number of rejecting events per second. That is, the number of events fired per second from alerts configured, that were rejected (for further processing), taking into account events that were rejected in the previous 5 minutes. The value shown is calculated the same way as Actual. Fired events are rejected when the Event Engine's queue thresholds are exceeded. Ideally this value should be zero.


Processing Queues Sizes

This graph displays the size of the event processing queue, that is, the number of events waiting to be processed. These queues are emptied as soon as the events are processed, so there would have to be a large number of events being generated simultaneously to see alerts waiting for processing in the queues.

The Processing Queues Sizes graph displays statistics for the last 5 minutes. The graph displays Rules Fired Queue, Alert Actions Queue, and Alerts History Queue health.

The Rules Fired Queue displays the number of events that were fired that are waiting to be processed. The Event Engine maintains internal in-memory queue for fired events where all the events are placed temporarily, before being pulled out from here for further processing, as soon as the Event Engine resources are available. This metric shows the number of events fired waiting in queue to be picked by the system.

The Alert Actions Queue displays the number of actions waiting to be processed. The Event Engine maintains internal in-memory queue for actions where all the actions are placed temporarily, before being pulled out from here for further processing, as soon as the Event Engine resources are available. This metric shows the number of actions waiting in queue to be picked by the system.

The Alerts History Queue displays the number of alert history items to be saved. The Event Engine maintains internal in-memory queue for all history items, where all the items are temporarily placed, and before picking them up to save to back end. This metric shows the number of history items waiting in queue to be picked by the system.






24.2.3 Monitoring the Report Cache Component

The Report Cache assists the Active Data Cache with maintenance of the view set snapshots in memory. The Report Cache opens view sets in the Active Data Cache for the Report Server (an Oracle BAM web applications component). It then caches the snapshot (in small parts) and the active data before sending it to the Report Server. This allows for random access into the snapshot and recovery from losing the connection to Oracle BAM Server. The Report Cache also, along with the Active Data Cache, supports view set sharing.

[image: Description of bam_server_rc_tab.gif follows]
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Active Data Sessions

This statistic displays the total number of Report Cache sessions with active data.

When a user opens multiple browser windows on a single computer to view Oracle BAM reports, all of the open browser windows share the same active data session. It does not matter whether the user opens the same report or different reports in each browser window, the Active Data Sessions count is always 1.


Active Data Reports

This statistic displays the total number of open reports requesting active data.


Files Count

This statistic displays the total number of files currently managed by FileBasedPersistenceManager when the Oracle BAM Server is configured to use a file-based persistence manager. For more information, see Section 23.3.5, "Configuring the Report Cache Persistence Manager".


Elements Count

This statistic displays the total number of elements currently managed by InMemoryPersistenceManager when the Oracle BAM Server is configured to use a memory-based persistence manager. For more information, see Section 23.3.5, "Configuring the Report Cache Persistence Manager".


View Sets

This group of statistics displays the following counters:

Average Open Time (sec) is the average time taken to open a view set.

Outgoing Message Rate (per sec) is the number of change lists delivered per second by Report Cache to all of its clients.

Message Rate Per Viewset (sec) the number of change lists delivered per second per view set.

Total Open Viewsets is the total number of view sets (that is, the sum of shared, unshared, and inherited view sets) maintained in Report Cache for all of the views contained in the reports opened in browsers.

The Open Viewsets graph displays shared, inherited, and unshared view sets.

Shared Viewsets are the parent view sets (these are the view sets that are opened first).

Inherited Viewsets are the child view sets (these view sets are opened later).

Unshared Viewsets (independent view sets) are neither shared or inherited.

View set sharing occurs whenever possible for performance reasons (the consumers require the exact same view sets, so the view sets can be shared). If the view sets cannot be shared, they are unshared.

When users who do not have any differences in row-level security open the same report at close to the same time, the view sets that are created for them in the Active Data Cache are shared in the Report Cache.




	
Note:

View set counts may not match between Active Data Cache, Report Cache, and Report Server metrics. For more information, see "View Set Count Variation".














24.2.4 Monitoring the Enterprise Message Sources

Enterprise Message Sources (EMS) are used by applications to provide direct Java Message Service (JMS) connectivity to Oracle BAM Server by mapping messages directly to Oracle BAM data objects. Oracle BAM Server can read data directly from any JMS-based message queue or topic. This option offers guaranteed messaging. It is more difficult to configure and not as fast to perform rigorous data transformations in XML Stylesheet Language (XSL) than in an Extract Transform and Load (ETL) tool like Oracle Data Integrator.

The EMS feature does not configure ETL scenarios, but rather maps from a message directly to a data object on Oracle BAM Server; however, you can still use XSL transformations before the data is inserted (updated, upserted, or deleted) into the data object. Each EMS reads from a specific JMS topic or queue, and the information is delivered into a data object in the Active Data Cache. The Oracle BAM Architect web application is used to configure EMS definitions.

For more information about configuring EMS definitions, see the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.
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Note:

Data is displayed in the Enterprise Message Source page only when EMS definitions are created and started in Oracle BAM Architect. Fusion Middleware Control may take some time to fetch the data and display the statistic in the Enterprise Message Source page.

Refreshing the page displays the latest EMS data. You can refresh the page using the Refresh icon.
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Enterprise Message Sources

Select the EMS to monitor from the list. You can choose to display aggregated statistics for all EMS definitions, or select a particular EMS to monitor from the list provided.


Messages

Monitor the number of messages received by the selected EMS. You can find rejection statistics in the Performance Summary metrics page.

The accompanying graph displays the number of Received Messages broken down into Accepted Messages and Rejected Messages, and at the top of the graph the number of Total Received Messages is displayed.


Operations Per Second

Monitor the rate of insert, update, upsert, and delete operations performed by the selected EMS.

The Operations Per Second graph displays statistics for last 5 minutes.

For more granular detail about the rates for each type of operation, go to the Performance Summary page. For more information, see Section 24.5, "Monitoring Oracle BAM Performance".






24.2.5 Monitoring the Client Requests in Progress

The Oracle BAM Client Requests in Progress chart is displayed in the lower right corner of the Oracle BAM Server home page. Client requests include all of the requests made to the Oracle BAM Server Enterprise Java Beans (EJB).

[image: Description of bam_em_server_chart.gif follows]
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There are a lot of internal requests made when opening a single report (for permissions, the report metadata, the views data, and so on); however, the user may or may not see those internal requests displayed in this chart.








24.3 Monitoring Oracle BAM Web Applications

Oracle BAM web applications are monitored in the OracleBAMWeb page of Fusion Middleware Control.

To monitor Oracle BAM Report Server go to the OracleBAMWeb page by selecting BAM > OracleBamWeb in the navigation tree.


Figure 24-1 BAM Web Statistics
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24.3.1 Monitoring Oracle BAM Report Server

Oracle BAM Report Server applies the report definitions to the data sets retrieved from the Oracle BAM ADC for presentation in a browser. It manages information paging for viewing and printing reports. After reports are created, they are stored in the Oracle BAM ADC so that report creation is not repeated each time. Most reporting views are designed to support live, active displays of data changing in real time.

You can monitor statistics for Oracle BAM Report Server connections, view sets, and reports.

[image: Description of bam_web_reportserver.gif follows]
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Connections

This group of statistics displays the following:

Open Connections is the number of connections open on the Report Server. An open connection corresponds to each user per session. It is different from the number of reports opened, because one user could at most have one connection open at a time regardless of how many reports the user has opened.

Message Rate (per sec) is the total number of messages (view set change lists) delivered per second to all users (connections).

Message Rate Per Connection (sec) is the number of messages (view set change lists) delivered per second per user (connection).


View Sets

This group of statistics displays the number of open view sets, and the average amount of time (in seconds) that it takes to open the view sets on the server.

Average Open Time (sec) is a measure of the average length of time the server requires to construct the view set and send it to the web browser. This statistic does not consider the amount of time required to render the HTML and load the Javascript on the client-side web browser.




	
Note:

View set counts may not match between Active Data Cache, Report Cache, and Report Server metrics. For more information, see "View Set Count Variation".










Reports

This statistic displays the total number of open reports. The Open Connections graph displays open connections to Oracle BAM web applications. You can use the zoom axis to zoom in on a particular time in which you are interested to see the open connections statistic.

The total number of reports includes the count of duplicate reports opened by the same user. Even if the same report is opened in multiple browser windows, each instance is considered a separate report, because a new view set is opened in Report Server (through Oracle BAM Report Cache) for each report instance, though the view sets are shared.






24.3.2 Monitoring Open Connections

The Oracle BAM Open Connections chart is displayed in the lower right corner of the Oracle BAM Server home page.
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24.4 Monitoring Oracle BAM Web Services

Oracle BAM web services details are not listed in the Oracle BAM pages in Fusion Middleware Control. Oracle BAM web services counters are available by selecting WebLogic Domain > soa_bam_domain > BAM_Server in the navigation tree, and selecting the JEE Web Services tab in the Most Requested region as shown in Figure 24-2.

Oracle BAM provides DataObjectDefinition, DataObjectOperationsByName, DataObjectOperationsByID, DataObjectOperations10131, ManualRuleFire, and ICommand web services. For more information, see "Using Oracle BAM Web Services" in the Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite

You can see the following statistics in JEE Web Services table: Invocation Count, Response Count, Response Error Count, Average Response Time (ms), Average Execution Time (ms), and Dispatch Time Total.


Figure 24-2 Oracle BAM Web Services Counters
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24.5 Monitoring Oracle BAM Performance

The performance of Oracle BAM applications is reflected in metrics and statistics. There are separate Performance Summary pages with appropriate metrics for Oracle BAM Server and Oracle BAM web applications.

When you select the Monitoring > Performance Summary menu item in each of the Oracle BAM component menus (as shown in Figure 24-3), the Performance Summary page appears as shown in Figure 24-4.


Figure 24-3 Monitoring Shortcut Menu
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Figure 24-4 Performance Summary Page
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Many metrics are available for capture and display (most of which are also displayed in the Oracle BAM component home pages). Descriptions of each metric are available in the metrics help pages.

To get the most valuable, focused information, use the Metric Palette. Click Show Metric Palette to display the Metric Palette, shown in Figure 24-5.

Choose the metrics in which you are most interested. As you select or deselect metrics from the palette, the metrics graph at the left is updated automatically.


Figure 24-5 Metric Palette for Oracle BAM Web Applications
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Right-click the metric label and select Help, as shown in Figure 24-6, to find more information about each of the metrics.


Figure 24-6 Metrics Shortcut Menu
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24.6 Monitoring Oracle BAM Logs

Oracle BAM logs are configured and viewed using Fusion Middleware Control.




	
Note:

Despite having separate log pages for Oracle BAM Server and Oracle BAM web applications, each page displays the logs for all Oracle BAM application components.









For information about using the logger features see the online Help page. For information about configuring the logger, see Section 23.4, "Configuring the Logger."

To view the logs, right-click the OracleBamServer node or OracleBamWeb node in the navigation tree and select Logs > View Log Messages as shown in Figure 24-7.


Figure 24-7 Logs Shortcut Menu
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The log viewer page opens as shown in Figure 24-8. Use this page to query for information about the component. Fields and lists are used to customize the query.


Figure 24-8 Log Messages Page
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After entering your search criteria, click Target Log Files. The Log Files page appears as shown in Figure 24-9. You can view specific log information (shown in Figure 24-10) or download the log.


Figure 24-9 Log Files Page
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Figure 24-10 Log File bam_server1.log
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Part II



Getting Started with Administration

This part describes how to navigate to Oracle SOA Suite and Oracle BPM Suite administration tasks in Oracle Enterprise Manager Fusion Middleware Control.

This part includes the following chapter:

	
Chapter 2, "Getting Started with Administering Oracle SOA Suite and Oracle BPM Suite"
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